## Contents

### Chapter 1. Overview and Initialization of Capital Expense Planning

- About Capital Expense Planning .................................................. 7
- Capital Expense Planning Capabilities ........................................ 7
- Prerequisites ................................................................................. 8
- Business Model ........................................................................... 8
- Creating and Initializing a Capital Expense Planning Application .......... 8
- Using Performance Management Architect Application Administration .... 9
- Using Classic Application Administration ....................................... 13
- Loading Information into Capital Expense Planning .......................... 14
  - Loading Information Using DIM Adapter for Planning ..................... 15
  - Loading Information Using Application Link Adapter for Hyperion Planning 15
- Logging On and Accessing Capital Expense Planning ....................... 16

### Chapter 2. Working with Capital Expense Planning

- Working with Tangible and Intangible Assets .................................. 17
  - Establishing Global Assumptions .............................................. 17
  - Managing Tangible Assets ......................................................... 18
  - Managing Intangible Assets ....................................................... 22
  - Adjusting Costs and In-Service Dates ....................................... 24
  - Reviewing Financial Impact Information ..................................... 25
- Managing Access Permissions ....................................................... 28
- Considerations for Working with Capital Expense Planning ................ 28

### Chapter 3. Customizing Capital Expense Planning

- About Customizing Applications ................................................. 31
- Adding Asset Classes .................................................................... 31
  - With Performance Management Architect Applications .................. 32
  - With Classic Applications ......................................................... 33
- Adding Custom Fields .................................................................... 34
- Changing Cash Flow Staggered Allocations .................................... 36
- Adding Data Forms ........................................................................ 37
- Adding Retirement Options for New Assets .................................... 38
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing Labels</td>
<td>39</td>
</tr>
<tr>
<td>................................. With Performance Management Architect Applications</td>
<td>40</td>
</tr>
<tr>
<td>................................. With Classic Applications</td>
<td>40</td>
</tr>
<tr>
<td>Showing Hidden Fields</td>
<td>41</td>
</tr>
<tr>
<td>Enabling Assumptions at the Entity Level</td>
<td>42</td>
</tr>
<tr>
<td>................................. Updating Data Forms to Use Multiple Entities</td>
<td>42</td>
</tr>
<tr>
<td>................................. Updating Business Rules to Use Multiple Entities</td>
<td>42</td>
</tr>
<tr>
<td>Adding a Project Dimension</td>
<td>44</td>
</tr>
<tr>
<td>................................. Creating the Project Dimension</td>
<td>44</td>
</tr>
<tr>
<td>................................. Updating Data Forms for the Project Dimension</td>
<td>45</td>
</tr>
<tr>
<td>................................. Updating Business Rules for the Project Dimension</td>
<td>45</td>
</tr>
<tr>
<td>Data Forms</td>
<td>47</td>
</tr>
<tr>
<td>Smart Lists and Menus</td>
<td>47</td>
</tr>
<tr>
<td>Member Formulas</td>
<td>47</td>
</tr>
<tr>
<td>Business Rules</td>
<td>48</td>
</tr>
</tbody>
</table>

### Appendix A. Capital Expense Planning Structure

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predefined Data Forms</td>
<td>49</td>
</tr>
<tr>
<td>Predefined Composite Data Forms</td>
<td>53</td>
</tr>
<tr>
<td>Predefined Accounts</td>
<td>53</td>
</tr>
<tr>
<td>Predefined Asset Classes</td>
<td>57</td>
</tr>
<tr>
<td>Predefined Line Items</td>
<td>59</td>
</tr>
<tr>
<td>Predefined Member Formulas</td>
<td>63</td>
</tr>
<tr>
<td>................................. Cal TP-Index</td>
<td>63</td>
</tr>
<tr>
<td>................................. Capital Driver Assumptions</td>
<td>63</td>
</tr>
<tr>
<td>................................. First Date</td>
<td>64</td>
</tr>
<tr>
<td>................................. Fiscal TP-Index</td>
<td>64</td>
</tr>
<tr>
<td>................................. NumPeriods</td>
<td>64</td>
</tr>
<tr>
<td>................................. Spread_445</td>
<td>64</td>
</tr>
<tr>
<td>................................. Spread_454</td>
<td>64</td>
</tr>
<tr>
<td>................................. Spread_544</td>
<td>65</td>
</tr>
<tr>
<td>................................. Spread_Actual_365</td>
<td>65</td>
</tr>
<tr>
<td>................................. Spread_Actual_Actual</td>
<td>65</td>
</tr>
<tr>
<td>................................. Spread_Average</td>
<td>65</td>
</tr>
<tr>
<td>................................. Spread_Balance</td>
<td>65</td>
</tr>
<tr>
<td>................................. Spread_First</td>
<td>66</td>
</tr>
<tr>
<td>................................. Spread_Flow</td>
<td>66</td>
</tr>
<tr>
<td>................................. TP-Date</td>
<td>66</td>
</tr>
<tr>
<td>................................. YR-Index</td>
<td>66</td>
</tr>
</tbody>
</table>
Overview and Initialization of Capital Expense Planning

In This Chapter

About Capital Expense Planning................................................................................................. 7
Creating and Initializing a Capital Expense Planning Application .............................................................. 8
Loading Information into Capital Expense Planning ...........................................................................14
Logging On and Accessing Capital Expense Planning..........................................................................16

About Capital Expense Planning

Oracle's Hyperion® Capital Expense Planning is a Web-based solution that enables you to manage, prioritize, and plan for capital expenses.

With Capital Expense Planning, you create a model of your organization's capital expenses and provide an effective way for decision makers and front-line managers to communicate throughout the request, justification, review, and approval process.

The Capital Expense Planning model is based on a 12–month calendar, and the default calculations of Capital Expense Planning support multiple years. If your application uses custom time periods, you must modify time-related formulas to support custom time periods.

Capital Expense Planning Capabilities

- Assists in the process of creating capital expense plans and submitting them for approval
- Provides for timing and cost adjustment to capital expenses
- Establishes global assumptions for each asset class and sets drivers for calculations
- Provides for communication and notification, to ensure a smooth and efficient request and approval process
- Includes scenario simulation to enable accurate prediction of the impact of capital expense plans on cash flow, profit, and loss
- Includes transfer of assets, to facilitate effective and efficient asset utilization across departments
- Integrates with Oracle’s Hyperion® Planning – System 9 data for reconciliation, forecasting, and reporting
- Enables customization of the planning process, to meet the needs of global enterprises
Integrates with other systems to load information: with flat files for Oracle’s Enterprise Performance Management Architect applications, and typically with Oracle’s Hyperion® Data Integration Management Adapter for Planning or Oracle’s Hyperion® Application Link Adapter for Hyperion Planning for Classic applications

Prerequisites

Before you set up and manage Capital Expense Planning, you should understand:

- Planning (see the *Hyperion Planning – System 9 Administrator’s Guide* or online help)
- Performance Management Architect functionality if you are using Performance Management Architect application administration (see the *Hyperion Enterprise Performance Management Architect Administrator’s Guide* or online help)
- The Capital Expense Planning business model and structure (see “Business Model” on page 8 and Appendix A, “Capital Expense Planning Structure”)

Business Model

All companies create forward-looking plans to prepare for the future, aligning corporate resources—people and dollars—against strategies that leverage competitive market advantage. Through collaborative planning, departments coordinate and allocate the capital expenses required to augment the organization’s capacity.

Capital Expense Planning helps manage and prioritize capital expenses during budgeting and planning. With Capital Expense Planning, you can manage existing assets and plan for capital expenses such as asset purchases. You can also perform driver-based calculations to assess the impact on profit, cash flow, and funding, and request and approve capital expense plans with appropriate justification.

Capital Expense Planning assists with tasks such as planning for transfers, related expenses, improvements, impairments, retirements, replacements, and financial impact. It also helps corporate planners consolidate plans, prepare reports on capital expenses, and iterate plans to respond to changing conditions.

Creating and Initializing a Capital Expense Planning Application

This section describes how to create and initialize a new Capital Expense Planning application, using either Performance Management Architect application administration or Classic application administration.

Initializing Capital Expense Planning loads predefined:

- Dimensions and members
- Data forms
- Smart Lists
- Member formulas
Before you initialize Capital Expense Planning:

- Study Appendix A, “Capital Expense Planning Structure.” Review the predefined elements, identifying which elements you can use and which elements you need to customize. The better you understand the model and plan your application, the easier it will be for planners to use Capital Expense Planning.

- Update dimension outlines to resolve differences between Capital Expense Planning member names and member names of other applications.

- Plan the structure of the Entity dimension if you intend to use both Oracle’s Hyperion® Workforce Planning and Capital Expense Planning because initializing Oracle’s Hyperion® Workforce Planning produces one No Entity member, whereas initializing Capital Expense Planning produces a few Entity members. You can change the Entity members after you initialize the applications.

### Using Performance Management Architect Application Administration

Follow the steps in this section to use Performance Management Architect application administration.

#### First: Create an Import Profile

An import profile in Performance Management Architect includes important information about the dimensions to be imported, such as new dimensions, whether to merge or replace dimensions, and dimension properties.

> To create an import profile:

1. Download the flat file for Capital Expense Planning from the Oracle® E-Delivery site.
2. Log on to Performance Management Architect.
3. Select Navigate > Administer > Dimension Library.
4. In the Dimension Library, select File > Import > Create Profile.
   - This enables you to create and execute an import profile to load dimensions and members from a flat file into the Master View, and drag and drop Capital Expense Planning dimensions and members into the new Capital Expense Planning application.
5. In New Profile, enter a name for the new profile.
6. Select Flat File as the Import Type.
7. Enter the name of the file to import. Or click Upload, browse for the file, and click Upload again.
8. Click OK.
9. Click Next.
In the Map Dimensions section, select the dimensions in the Master View column for which to import dimension information from the flat file. If the dimension in the flat file does not exist in the Dimension Library, select New Dimension, enter a name and description for the dimension, and select the type of dimension.

Alternatively, select Create New Dimension to create all dimensions as new dimensions.

Any dimension left blank in the Master View column is not imported from the flat file.

Optional: For each dimension selected for import, select to merge or replace the dimension. This step is not required if you create dimensions as new.

Merge combines information from the flat file with information in the Dimension Library; replace deletes the dimension from the Dimension Library and replaces it with the dimension from the flat file.

Click Next.

To import dimension properties from the flat file, select the properties to import in the Master View column. Double-click on a cell in the Master View column to list the available properties.

Optional: Select Ignore Nulls for any property to ignore blank values in the flat file.

Click Finish.

Second: Import Dimensions

You import dimensions from the Capital Expense Planning flat file into Performance Management Architect.

To import dimensions:

1. In Performance Management Architect, select Navigate > Administer > Dimension Library.
2. Select File > Import > Import Dimensions to import the dimensions from the flat file.
3. Select an import profile to use.
4. Select Flat File for the type of import file.
5. Enter the name of the file from which to import dimensions. You can also click Upload, browse for the file, and click Upload again.
6. Click Import.

You can now create a Capital Expense Planning application and load data into it.

If the dimension loaded into the Dimension Library is related to an Application View, it is loaded to the Application View.

Third: Create a Capital Expense Planning Application

To add a Capital Expense Planning application to an existing Planning application, skip to the next section.
To create a Capital Expense Planning application:

1. In Performance Management Architect, select Navigate > Administer > Dimension Library.
2. Select File > New > Application View to create an Application View.
3. In New Application View:
   a. Type the application name, CapExplan.
   b. Select the application type, Planning.
   c. Enter a description.
4. Click OK.
5. In the Dimension Library, select the new CapExplan Application View.
6. Drag and drop dimensions and members from the Master View into the Application View to add them to the Capital Expense Planning application.

   You can use the common dimensions that are already available for Entity, Period, Year, Scenario, and Version. The Capital Expense Planning dimensions and members are listed in the flat file with the prefix `planning_CX_`. For example, Asset Class is listed as `planning_CX_AssetClass`. Options from the flat file include: Account, Asset Class, Currency, Entity, Line Item, Period, Scenario, Version, Year, DeprMethod, PhysicalLocation, AssetStatus, DeprConvention, TangibleFlag, CashFlowIncidence, RetireOptions, AmortizationMethod, DelayReasons, EndReasons, AssetPriority, AssetUOM, ImpairmentOptions, PurchReason, and Alias.

7. In the Properties Grid for CapExplan, enter these property values:
   a. From Category, select Planning.
   b. Select Valid for Capex and, optionally, the check boxes next to the other plan types for which the application is valid.
   c. Select or change other values for the new CapExplan Application View:
      - Start Year
      - Start Month
      - Default Currency

   Performance Management Architect adds No Year as a system member, as the first member in the Year dimension in Performance Management Architect, but it is saved as the last member in the Planning repository. The Start Year and Number of Years options should be based on the Year dimension.

8. For each dimension in the application, select the Valid For plan types for which the dimension is valid.

   All updates must comply with the considerations for Planning dimensions described in the Hyperion Enterprise Performance Management Architect Administrator’s Guide.
9. Click Save.
Fourth: Add a Capital Expense Planning Application to an Existing Planning Application

If you have an existing Planning application, follow these steps. Otherwise, skip to the next section.

➤ To add Capital Expense Planning to a Planning application:

1 In Performance Management Architect, select Navigate > Administer > Application Upgrade to access the Application Upgrade Wizard.
   a. In Upgrade Summary, review the list of the applications you can upgrade. Click Next.
   b. In Select application, use the arrow keys to select the Planning application to upgrade. You can select more than one application. Click Next.
   c. In Summary, review the list of applications you selected to upgrade. Click Next.
   d. In Upgrade Status, click Finish to see the upgrade status.

2 In the Application Library, right-click the upgraded application and select Open.

3 In the Dimension Library, drag and drop dimensions and members from the Master View into the Application View to add them to the application.

The Capital Expense Planning dimensions and members in the flat file have the prefix planning_CX_. For example, Asset Class is listed as planning_CX_Asset Class. Options from the flat file include: Account, Asset Class, Currency, Entity, Line Item, Period, Scenario, Version, Year, DeprMethod, PhysicalLocation, AssetStatus, DeprConvention, TangibleFlag, CashFlowIncidence, RetireOptions, AmortizationMethod, DelayReasons, EndReasons, AssetPriority, AssetUOM, ImpairmentOptions, PurchReason, and Alias.

4 For the upgraded application, in Properties of [application name], enter these property values:
   a. From Category, select Planning.
   b. The plan types valid for the application are already selected. By default, Valid for Capex is selected from the Capital Expense Planning flat file you imported.
   c. Select or change other values for the new application:
      ● Start Year
      ● Start Month
      ● Default Currency

   The Start year and Number of Years options should be based on the Year dimension.

5 For each dimension in the application, select the Valid For plan types for which the dimension is valid.

6 Click Save.

Fifth: Deploy Capital Expense Planning to Planning Applications

Before you deploy a Capital Expense Planning Application View to Planning, you must set up a relational database and a data source in the Planning system database. See the Hyperion Planning – System 9 Installation Guide.
Ensure that all properties meet your needs and update any settings before deploying Application Views. If Application Views are not set up correctly, deployment fails and error messages are displayed. Your Capital Expense Planning application is initialized when you successfully deploy an Application View with Valid for Capex selected.

➤ To deploy a Capital Expense Planning Application View to Planning:

1. In Performance Management Architect, select Navigate > Administer > Application Library.
2. In the Application Library, select the CapExplan Application View.
3. Right-click CapExplan and select Deploy.
4. If the Application Validation Errors dialog box is displayed, view the errors and correct them. Then click Deploy again.
5. In the Deploy dialog box, enter or select this information:
   - The instance name for this deployment of the Capital Expense Planning application
   - The Oracle’s Hyperion® Shared Services project name in which to register the new application
   - The data source file name in which the relational tables will be generated
   - Create outline, if this is your first deployment, to create a database outline in Oracle’s Hyperion® Essbase® – System 9
   - Refresh outline, to update an existing Essbase outline with new data
   - Create security filters, to generate security filters for all users of the application
   - Shared members security filters, to apply access permissions to shared and base members
   - Validate security filter limit, to flag security filters that exceed the Essbase limit of 64 KB per row
6. Click Deploy.

After you deploy the Application View from Performance Management Architect to Planning, communicate the URL for logging on, the logon instructions, and information about the planning process.

Tip:
You can put the URL on your company’s intranet.

Using Classic Application Administration

If you are upgrading your Planning application from an earlier release and want to use Classic application administration with Capital Expense Planning, install the new release of Planning, using the instructions in the Hyperion Planning – System 9 Installation Guide.

To create a new Capital Expense Planning application and use Classic application administration, see the Hyperion Planning – System 9 Installation Guide and the Hyperion
When using the Create Application wizard to create a Classic application, select Capex as the plan type.

After upgrading or creating your Capital Expense Planning Classic application, you must initialize it.

To initialize a Classic Capital Expense Planning:

1. Start Oracle's Essbase® Administration Services server.
2. Start and log on to Planning.
   A message confirms when initialization is successful; Initialize Capex no longer displays on the Capital Expense menu.
4. Ensure that the Capital Expense Planning model suits your company's needs.
5. Validate the model if you change your Capital Expense Planning application.
6. Refresh the application.

Loading Information into Capital Expense Planning

If your Capital Expense Planning application is new, you may want to load information, such as the existing account structure and properties, from enterprise systems:

- If you are using Performance Management Architect application administration, load information using a flat file (see the Hyperion Enterprise Performance Management Architect Administrator's Guide).

- If you are using Classic application administration, you can use DIM Adapter for Planning (see also “Loading Information Using DIM Adapter for Planning” on page 15) or Application Link Adapter for Hyperion Planning (see also “Loading Information Using Application Link Adapter for Hyperion Planning” on page 15).

You can also:

- Manually enter information into Capital Expense Planning.

- Load metadata and data that generates data and rules files for loading metadata and data through Administration Services. See the Hyperion Application Link Adapter for Hyperion Planning – System 9 Online Help.

To load information—data and metadata—using DIM Adapter for Planning or Application Link Adapter for Hyperion Planning:

1. Load metadata (for example, entities and accounts) into Capital Expense Planning.
   Load Account and user-defined dimensions from any flat file or ODBC-compliant database. Load members, shared members, and attribute values into dimensions. Hyperion recommends...
that you first load a small sample of accounts. Verify the results, make any needed changes, and load the entire dimension.

See Appendix A, “Capital Expense Planning Structure” for a list of Capital Expense Planning accounts and their properties.

2 Refresh the application to update the Essbase outline.

3 Set up the data load dimension and dimension driver members.

The data load dimension is the dimension to which you are loading data, and corresponds to the target table in the DIM Adapter for Planning and to the method in Application Link Adapter for Hyperion Planning. The driver dimension is the dimension to which you are loading data in an Essbase database. See “Loading Data” in Hyperion Planning – System 9 Administrator’s Guide.

4 Load data and member properties into the Essbase database for the Capital Expense Planning application.

The outlines must match; you can specify only the members and parent member names.

5 Refresh the application to update the data.

Each time you modify the application structure, reload the data.

Note:

Load fixed accounts only into the BegBalance member and load varying accounts into all time periods. You set the effective POV for each record using the POV port.

Loading Information Using DIM Adapter for Planning

After you install and configure DIM Adapter for Planning, you can install and configure adapters that enable you to retrieve and write data for other Hyperion products. After you configure an adapter, you must configure an application connection in Workflow Manager before you can extract data from sources or write data into targets. See the Hyperion Planning – System 9 Administrator’s Guide, “Loading Members and Data” chapter. For specifics on loading capital expense-related information into Planning, see DIM Adapter for Planning online help.

Note:

You can use load information using Oracle’s Hyperion® Data Integration Management Adapter for Planning only into Classic applications.

Loading Information Using Application Link Adapter for Hyperion Planning

Application Link provides a graphical user interface for creating integrations from your source system into Planning. It includes a wizard — Hyperion Translation Manager—that helps you map your source data into Planning equivalents.
Note:
You can load information using Application Link Adapter for Hyperion Planning only into Classic applications.

For more information about Application Link and Oracle's Hyperion® Application Link Adapter for Hyperion Planning, see the *Hyperion Planning – System 9 Administrator’s Guide*, “Loading Members and Data” chapter. For specifics on loading capital expense-related information into Planning, see the *Hyperion Planning – System 9 Administrator’s Guide*.

Logging On and Accessing Capital Expense Planning

You work with Capital Expense Planning in the Oracle's Hyperion® Workspace environment. The default Workspace URL is `http://<web server>:<port>/workspace/`, where `<web server>` is the Web server machine hostname and `<port>` is the Web server listen port. For information on installing and configuring Workspace, see the *Hyperion Reporting and Analysis – System 9 Installation Guide* and *Hyperion Workspace Administrator’s Guide*.

➤ To log on to Workspace and access Performance Management Architect (for Performance Management Architect application administration), Planning, and Capital Expense Planning:

1. Ensure that the Web server is started and the Web application server is running in the Services panel.
2. In your browser, enter the URL for the Workspace Log On page.
3. Enter your system user name.
4. Enter your system password.
5. Click Log On.
6. For Performance Management Architect application administration: To access Performance Management Architect, select an option from the Navigate menu.

   For example, select Navigate > Administer, then select Dimension Library or Application Library.

   See the *Hyperion Enterprise Performance Management Architect Administrator’s Guide* or online help.

7. Select Navigate > Applications > Planning, and select an application.
8. To work with data forms:
   a. To view and work with data forms: Select Data Form, expand Forms, and select Capital.
   b. To manage data forms: Select Administration > Manage Data Forms. From the Data Forms folder, select Capital, select a data form, and click Edit.
In This Chapter

Working with Tangible and Intangible Assets.................................................................................... 17
Managing Access Permissions.................................................................................................... 28
Considerations for Working with Capital Expense Planning ............................................................28

Working with Tangible and Intangible Assets

You can plan for new tangible or intangible expenditures and check the impact on profit and loss, cash flow, and balance sheets. You can also review expenditure and adjust the timing and cost of capital spending. In addition, you can perform actions on existing assets such as transfer, retirements, improvements, and impairments.

Predefined tasks include:

- “Establishing Global Assumptions” on page 17
- “Managing Tangible Assets” on page 18
- “Managing Intangible Assets” on page 22
- “Reviewing Financial Impact Information” on page 25

Establishing Global Assumptions

Capital Expense Planning is a driver-based planning tool. You can set drivers by establishing global assumptions for each asset class (for example, buildings or machinery) or for all tangible or intangible assets.

Assumptions you can set:

- Useful life of assets
- Depreciation methods
- Depreciation conventions
- Amortization methods
- Insurance, repair, and maintenance expenses
- Depreciation rates for declining balance methods
- Cash flow incidence, which determines cash flow impacts and allocations for asset purchases
Funding options for asset requests

To establish global assumptions:
1. Open the data form 01. Global Capital Assumptions (see "Logging On and Accessing Capital Expense Planning" on page 16).
2. Set assumptions for the drivers.
   For permissible values, see "Predefined Smart List Entries" on page 67.

Managing Tangible Assets

Managing tangible assets includes planning for new assets, making timing and cost adjustments, and performing actions on existing assets, such as asset improvements, transfers, and retirements.

Requesting Asset Purchases

Given the financial implications, asset purchases require major management decisions. Each request must be justified based on need, cost, cost benefit, and financial impact (profit and loss and cash flow).

To request asset purchases:
1. Open the data form 02. New Asset Requests (see "Logging On and Accessing Capital Expense Planning" on page 16).
2. Right-click an asset class, and select Add New asset.
   If no assets exist, this message displays: “There are no valid rows of data for this data form.”
   a. Right-click the message.
   b. From the menu, select Add New Asset.
3. Enter details, such as asset class, description, number of requests (to plan for multiple asset requests of the same value), Asset CAR#, priority, justification, asset units, purchase date, in-service date, asset rate, salvage value, and physical location.

Note:

If you leave the in-service date blank, the in-service date is assumed to match the purchase date. The in-service date cannot precede the purchase date.

4. Click OK.
5. View the impact of depreciation at the top of the data form.
6. Optional: You can:
   - Review profit and loss impact
   - Review balance sheet impact
- Review cash flow impact
- Perform timing adjustments
- Perform cost adjustments
- Remove assets

**Managing Existing Specified Assets**

Planners and cost-center managers plan actions such as transfers, retirements, and improvements on tangible assets.

**Adding Existing Assets**

You can add existing assets:

- Manually using Capital Expense Planning
- Manually using Oracle's Hyperion® Smart View for Office (see the *Hyperion Smart View for Office User’s Guide*)
- Using Performance Management Architect with Performance Management Architect applications (see the *Hyperion Enterprise Performance Management Architect Administrator’s Guide*)
- Loading information (see “Loading Information into Capital Expense Planning ” on page 14)

To add existing tangible assets to entities:

1. **Open the data form 03. Manage Existing Specified** (see "Logging On and Accessing Capital Expense Planning" on page 16).
2. **Select the entity Operations.**
3. **Right-click an asset class, and select Add Existing Asset.**
   - If no assets exist, this message displays: “There are no valid rows of data for this data form.”
   - **a.** Right-click the message.
   - **b.** Select Add Existing Asset.
4. **Enter details such as asset class, description, number of requests, in-service date, asset units, asset rate, salvage value, purchase date, and physical location.**

   **Note:**

   If you leave the in-service date blank, the in-service date is assumed to match the purchase date. The in-service date cannot precede the purchase date.

5. **Click OK.**

   The asset is added with the prefix Base SP, indicating that the asset is base-specified and not an improvement.
6 To view calculated details of assets:
   a. Right-click the line item and select Calculated Details.
   b. Run the calculated data business rule to view the aggregated numbers for depreciation, gross asset balances, accumulated depreciation, and asset-related expenses set in global assumptions.

7 Optional: Review cash flow impact.

Transferring Assets
To ensure optimum use of assets, facilities or cost-center managers can transfer fixed asset resources across departments.

➤ To transfer assets:
1 Open the data form 03. Manage Existing Specified (see “Logging On and Accessing Capital Expense Planning” on page 16).
2 Right-click an asset and select Transfer Assets.
3 Enter details, such as asset class, line item, transfer from, transfer to, and transfer date.
4 Click OK.
   The asset is transferred and will impact expenses. To view the impact of asset transfer in the source and destination entry, right-click a line item, and select Calculated details.

Retiring Assets
When assets are retired, asset balances are terminated as of the retirement date, and losses or gains on sales or write-offs are calculated.

➤ To retire assets:
1 Open the data form 03. Manage Existing Specified (see “Logging On and Accessing Capital Expense Planning” on page 16).
2 Right-click the asset, and select Retire Assets.
3 Enter details, such as asset class, line item, retire date, retire option, sale value or write-off, and retire cost.
4 Click OK.
   To view the impact of asset transfer in the source and destination entry, right-click a line item, and select Calculated details.

Removing Assets
When assets are removed, asset balances are terminated as of the removal date, and losses or gains on sales or write-offs are calculated.
To remove assets:

1. Open the data form 03. Manage Existing Specified (see “Logging On and Accessing Capital Expense Planning” on page 16).
2. Right-click the asset, and select Remove Assets.
3. Enter details, such as line item and asset class.
4. Click OK.

Improving Assets
Planners and cost-center managers plan for improving assets (upgrading equipment, adding floor space, and so on). Improvements that increase asset cost become a part of the original asset cost. You can add three line items to each base line item.

To improve assets:

1. Open the data form 03. Manage Existing Specified (see “Logging On and Accessing Capital Expense Planning” on page 16).
2. Right-click an asset (base line item), and select Improve Assets.
3. Enter details, such as description, asset units, asset rate, physical location, salvage value, physical value, purchase date, and in-service date.
4. Click OK.
   
   A line item with the prefix IM is added below the original asset.

To view calculated details and aggregated values for improved assets:

1. Right-click an improved line item, and select Calculated Details.
2. Select the year from which the improvement is planned, and Click GO.
   
   The improvement details from the month of the In Service date are displayed.
3. Select Base Line Item page view, and click GO.
   
   The aggregated value for the base line item and its improvement is displayed.

Managing Unspecified Assets
Unspecified assets are not added at each asset level; the asset information is for reporting purposes only.

To manage unspecified assets:

1. Open the data form 04. Manage Existing Unspecified (see “Logging On and Accessing Capital Expense Planning” on page 16).
2. Select Entity Operations.
3. Select Property, Plant and Equipment Gross, and click GO.
4 In the data form, for each asset class and month, enter the unspecified asset values.

5 Select Accumulated Depreciation, and click GO.
   Click OK to save the data.

6 In the data form, for each asset class and month, enter the accumulated depreciation and depreciation values for three years.

7 In the Business Rule for 04. Manage Existing Unspecified Asset, double-click the RollupAssets business rule.
   a. Select values for department, scenario, and version.
   b. Click Launch.
   The account balances are rolled up.

8 Select Property, Plant and Equipment Gross, and click GO to view the rolled up net balance.

Managing Intangible Assets

Financial managers can perform these actions on intangible assets and evaluate their impact on business performance:

- “Requesting Intangible Asset Purchases” on page 23
- “Adding Intangible Assets” on page 23
- “Impairing Intangible Assets” on page 24
- “Reviewing Financial Impact Information” on page 25
Requesting Intangible Asset Purchases

To request intangible assets:

1 **Open the data form 05. New Intangible Asset Requests** (see “Logging On and Accessing Capital Expense Planning” on page 16).

   A composite data form is displayed for creating intangible asset requests (bottom) and amortization and other related expenses (top).

2 **Right-click an asset class, and select Add New asset.**

   If no assets exist, this message displays: “There are no valid rows of data for this data form.”
   a. Right-click the message.
   b. Select Add New Asset.

3 Enter details such as asset class, description, number of requests (to plan for multiple requests of same value), justification, acquisition cost, additional charge, purchase date, in-service date, and salvage value.

4 Click OK.

5 To view amortization calculations:
   a. Right-click an asset line item, and select Profit and Loss Impact.
   b. In the amortization form, select the year, and click GO.

6 Optional: You can:
   - Review profit and loss impact
   - Review balance sheet impact
   - Review cash flow impact
   - Calculate intangible
   - Remove assets

Adding Intangible Assets

To add intangible assets:

1 **Open the data form 06. Manage Existing Intangibles Specified** (see “Logging On and Accessing Capital Expense Planning” on page 16).

2 Select Operations for the entity.

3 **Right-click an asset class, and select Add Existing Asset.**

   If no assets exist, this message displays: “There are no valid rows of data for this data form.”
   a. Right-click the message.
   b. Select Add Existing Asset.

4 Enter details such as description, asset class, number of requests, acquisition cost, additional charge, in-service date, and salvage value.
5 **Click OK.**

6 **Optional:** To view calculated details of the assets, right-click a line item, such as Base SP1, and select **Calculated details.**

---

**Impairing Intangible Assets**

➤ To impair intangible assets:

1 **Open the data form 06. Manage Existing Intangibles Specified** (see “Logging On and Accessing Capital Expense Planning” on page 16).

2 **Right-click a specific line item, and select Impair Asset.**

3 **Enter details such as asset class, line item, impair date, fair value, impair option, and capitalize%.**

4 **Click OK.**

5 **Optional:** To view the impact of impairment, right-click a specific line item, and select **Calculated details.**

**Note:**

If you select the capitalize option, the impairment value is posted to capital reserve. If you select the partial capitalize option, the impairment value is apportioned to the capital reserve, based on the capitalize%. Also, amortization is reduced from the month of impairment.

---

**Adjusting Costs and In-Service Dates**

After adding assets, you can adjust costs and in-service dates by moving capital expense spending plans to different periods—useful if you change the priority for assets or adjust costs or units based on better estimations. The basic cost and depreciation are recalculated when users right-click the line item and select Calculate Asset.

➤ To adjust costs and in-service dates:

1 **Add an asset** (see “Working with Tangible and Intangible Assets” on page 17).
   a. **Open the 02. New Asset Requests** data form (see “Logging On and Accessing Capital Expense Planning” on page 16).
   b. **Right-click an asset class, such as Machinery and Equipment**, and select **Add New Asset.**
   c. **Enter information for Asset Class, Number of Requests, Description, CAR#, Priority, Justification, Asset Units, Asset Rate, Salvage Value, Purchase Date, and In Service Date.** Then click **OK.**

   This adds the asset request, calculates and updates the basic cost, and calculates depreciation across the useful life of the asset. New asset requests are added as line items in the data form.

2 **In the 02. New Asset Requests** data form, update the number of units, for example, from 3 to 4.
3 Update the In Service Date, for example, from 4/1/07 to 6/1/07.

4 Click Save.

When users right-click the line item and select Calculate Asset, the basic cost is recalculated based on the new value. Depreciation and other balances are moved to the new period as appropriate.

5 Optional: To review changes, open the data form 08. Capital Expenditure Summary. To view details of each asset, right-click an asset class. On the line item, click Profit and Loss Impact to see the depreciation impact. Click Cash Flow Impact to see the cash flow impact.

Reviewing Financial Impact Information

Financial impact reports show the impact of capital expenses and actions related to capital expenses, on profit and loss, balance sheet, and cash flow. You can review reports by department or across departments, for the same asset class, all asset classes, or one asset.

Available report summaries:

- Capital expenditure summary
- Intangible expenditure summary
- Profit and loss impact
- Balance sheet impact
- Cash flow impact
- Depreciation summary
- Amortization summary
- Depreciation what ifs

Viewing Capital Expenditure Summaries

➤ To view capital expenditure summaries:

1 Log on to Workspace as described in “Logging On and Accessing Capital Expense Planning” on page 16.

2 From Select Data Form, expand Forms, and select Capital.

3 Select Current Fiscal Year, and click GO.

4 Click 08. Capital Expenditure Summary.

For each asset class, asset request summaries are displayed.

5 Optional: To view details of each asset, right-click an asset class, and select Asset Details.

A drill-down data form is displayed with details of each asset.

6 Optional: To roll up assets, right-click an asset class, and select Rollup Assets.
**Viewing Intangible Expenditure Summaries**

Intangible expenditure summaries detail the asset requests for each asset class and asset.

➢ To view intangible expenditure summaries:

1. Open the data form 09. Intangible Expenditure Summary.
2. Select Current Fiscal Year, and click GO.
   In this view, only months that have data are displayed.
3. Optional: To view details of each asset, right-click an asset class, and select Intangible Details.
   A drill-down data form is displayed with details of each asset.

**Reviewing Profit and Loss Impact Reports**

For tangible assets, you can review the profit and loss impact that capital expenses are expected to have.

➢ To review profit and loss impact reports:

   A summary of profit and loss statements is displayed.
2. Select the asset class Tangible Asset, the entity Operations, and the line item Total New or Total Existing.
   ● To review existing assets, select the line item Total Existing.
   ● To review new assets select the line item Total New.
3. Select Current Fiscal Year for the year, and click GO.

**Reviewing Balance Sheet Impact Reports**

For tangible assets, you can review the anticipated balance sheets.

➢ To review balance sheet impact reports:

   A summary of balance sheet statements is displayed.
2. Select the asset class Tangible Asset, the entity Operations, and the line item Total New or Total Existing.
   ● To review existing assets, select the line item Total Existing.
   ● To review new assets, select the line item Total New.
   ● To review the consolidated balance sheet of tangible and intangible assets, select the asset class Total Fixed Assets, and line item Total Existing.
3 Select Current Fiscal Year as the year, and click GO.

**Reviewing Cash Flow Impact**

For tangible assets, you can review the anticipated cash flow statements.

➢ To review balance sheet impact reports:

1 Open the data form 12. Cash Flow Impact (see “Logging On and Accessing Capital Expense Planning” on page 16).

A summary of cash flow statements is displayed.

2 Select Tangible Asset for asset class, Operations for entity, and Total New or Total Existing for the line item.

Cash flow impacts are affected only if you sell or improve existing assets.

To review a consolidated balance sheet of tangible and intangible assets, select Total Fixed Assets for asset class, and Total Existing for the line item.

3 Select Current Fiscal Year for year, and click GO.

**Viewing Depreciation Summaries**

Depreciation summaries detail the depreciation of various asset classes.

➢ To review depreciation summaries:

1 Open the data form 13. Depreciation Summary (see “Logging On and Accessing Capital Expense Planning” on page 16).

A depreciation summary of various asset classes is displayed.

2 To view details of each asset, right-click an asset class, and select Depreciation Details.

A drill-down data form with the depreciation details of each asset is displayed. In this view, only the months having data are displayed.

**Viewing Amortization Summaries**

Amortization summaries detail the amortization of various asset classes.

➢ To view amortization summaries:

1 Open the data form 14. Amortization Summary (see “Logging On and Accessing Capital Expense Planning” on page 16).

An amortization summary of various asset classes is displayed.

2 To view details of each asset, right-click an asset class, and select Amortization Details.

A drill-down data form with the amortization details of each asset is displayed. In this view, only the months that have data are displayed.
Working with Depreciation What Ifs

To view depreciation summary data and perform what-if analysis:

1. Open the data form 15. Depreciation What ifs (see “Logging On and Accessing Capital Expense Planning” on page 16).
   
   A data form is displayed with depreciation summary information (top) and global assumptions for depreciation (bottom).

2. Select Total New for asset class and Current Fiscal Year for year.

3. In the bottom data form, change the depreciation method of an asset class, and save the data.
   
   For example, for Computers, change the depreciation method from SYD to SLN.

4. In the depreciation form (top), right-click an asset class, and select Calculate Asset.
   
   For example, right-click Computers.

5. In Calculate Existing Asset, Click OK.

   Similarly, in the global assumptions for depreciation data form (bottom), you can change the values for useful life and depreciation convention and recalculate.

Managing Access Permissions

You can control access to Capital Expense Planning—who can view, add, delete, and change information and access which department:

- To set up users and groups, see the Hyperion Security Administration Guide.
- To assign access permissions, see the Hyperion Planning – System 9 Administrator’s Guide.

If planners can access a member, they can access its data. You can hide asset information by denying users or groups access to members or parents. In this case, you assign the access type None. You can also screen information by withholding access to certain data forms.

Considerations for Working with Capital Expense Planning

When working with Capital Expense Planning, keep these considerations in mind:

- Depreciation calculations for existing assets before the application period range are supported only for the SLN and SYD depreciation methods, not for the DB Year or DB Period depreciation method. For example, if the period range for the Capital Expense Planning application is Jan 2004 to Dec 2015, and the existing asset in-service date is 1/1/2000, depreciation calculations are supported only for the SLN and SYD methods.

- If the salvage value is set as 0 (zero), the DB Year or DB Period depreciation method may not produce the desired results. When using the DB Year depreciation method, Hyperion recommends that the salvage value be set to at least 1% of the basic cost to produce correct depreciation calculations.
• Timing adjustment does not work when it is based on a change of purchase date and staggered cash flow. This is because users can modify the staggered cash flow allocation percentage. Timing adjustment works correctly for other cash flow assumptions. To use timing adjustment, you can calculate allocated cash flow percentages manually.

• Users can make up to three improvements for existing assets. To improve additional assets, the administrator must add the appropriate IM \(<n>\) members.

• The Capital Expense Planning model is based on a 12–month calendar. It is not a weekly model.

• When planning transfers, ensure that users have appropriate access permissions to the source and destination entities.

• For multi-currency applications, depreciation calculations are calculated using the same currency as the input currency.

• Capital Expense Planning does not restrict depreciation calculations for intangible assets or amortization calculations for tangible assets. Business administrators managing global assumptions should define drivers appropriately.
This chapter provides examples to help you understand how to customize Capital Expense Planning applications.

**About Customizing Applications**

Before customizing a Capital Expense Planning application, evaluate the predefined Capital Expense Planning model—described in Appendix A, “Capital Expense Planning Structure”—to identify which elements you can use and which elements you need to customize. Study the logic, formulas, and interrelationships of the predefined members. Whenever you modify the Capital Expense Planning model, validate the model to test modifications and refresh the application.

**Adding Asset Classes**

You may want to add an asset class to:
● Add an asset class that is not predefined (add tangible asset members under the Tangible Assets parent and add intangible assets members under the Intangible Assets parent)

● Change the useful life of an asset set

● Depreciate assets by using a different convention or method

In this example, we add a new member to the Asset Class dimension. Depending on whether you have a Performance Management Architect application or a Classic application, see “With Performance Management Architect Applications” on page 32 or “With Classic Applications” on page 33.

**With Performance Management Architect Applications**

➤ To add asset classes in Performance Management Architect applications:

1  Log on to Oracle’s Hyperion® Workspace as described in “Logging On and Accessing Capital Expense Planning” on page 16.

2  Select Navigate > Administer > Dimension Library.

3  In Dimension List, select Asset Class.

4  Select Total Fixed Assets, and select Tangible Assets.

5  Right-click Tangible Assets, and select Create Member > As Child.

6  Enter the member name, such as Heavy Machinery, in the New Member dialog box. Click OK.

   The member is created as a child of Tangible Assets.

7  To view the member property, in the properties section, select Planning as the Category.

8  Set the Data Type to Currency, and click Save.

9  Select Navigate > Administer > Application Library.
10. Select the Capital Expense Planning application you are running, such as CapExplan, right-click, and select Edit.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA Consolid</td>
<td>European Consolidation Application</td>
</tr>
<tr>
<td>App1</td>
<td></td>
</tr>
<tr>
<td>Nancy8</td>
<td></td>
</tr>
<tr>
<td>WFPAPP</td>
<td></td>
</tr>
<tr>
<td>CapExPlan</td>
<td></td>
</tr>
<tr>
<td>Test_Config</td>
<td></td>
</tr>
<tr>
<td>Test_Config</td>
<td></td>
</tr>
</tbody>
</table>

11. Drag and drop members from the Dimension Library to the Application View, and click Save.

12. From the Application Library, select Deploy.

13. Select Refresh Cube, and click OK.

   The new asset class is created and is available in the Capital Expense Planning application.

**With Classic Applications**

➤ To add asset classes in Classic applications:

1. In Planning, select Administration > Dimensions and select the Asset Class dimension.

2. In the Search box, enter Tangible Assets and click .

3. Click Add Child.

4. On Member Properties, name the new asset class member, set its Data Type to Currency, and click Save.

   After creating members, assign access permissions to them.

5. Select Administration > Manage Database > Database to refresh the database.
Adding Custom Fields

You may want to add custom fields. For example, to add a drop-down list for tracking purchase justifications, you can add a field called Purchase Reason to the New Asset request menu and data form.

In this example, we:

- Modify the Add Asset business rule to include a runtime prompt for the purchase reason.
- Add a member—Purchase Reason Code—to the 02A. New Asset Requests — Addition data form.
- Verify the results.

To add a custom field to the launched Add Asset business rule:

2. Select the Local variable tab, and select Add Task to add the variable.
3. Select Apply task.
4. In Save as, type PurchReason.
5. Select the Runtime prompt tab, and place PurchReason next to the PhyLocation variable.
6. In the Source tab, add this statement after line “UOM” = 1; – "Purchase Reason Code" = [PurchReason],:

   ```
   "Purchase Date" = [PurchaseDate];
   "In Service Date" = [InserviceDate];
   "UOM" = 1; /*Default to Nos */
   "Purchase Reason Code" = [PurchReason];
   
   IF ("In Service Date" < "Purchase Date")
   "In Service Date" = "Purchase Date";
   ENDF
   
   IF
   NDIF
   
   IF
   NDIF
   ```

7. Click Save.

To add the Purchase Reason Code member to the New Assets Requests data form:

1. Start Planning and select Administration > Manage Data Forms and select the 02A. New Asset Requests — Addition data form.
2. Select Row/Column Layout.
3. Select Edit Columns.
4 In **Edit Column Layout**, on **Column Definition 3**, click **Edit**.

5 In the **Members** text box, add **Purchase Reason Code**, and click **Submit**.

6 Click **Save**.

➤ To verify that the Purchase Reason is added:

1 Open the data form **02A. New Asset Requests — Addition**.

2 Right-click an asset class, select **Add New Asset**, and click **OK**.
Notice the new Purchase Reason field is added to the Add New Asset business rule.

3 Click OK.

Notice that the field Purchase Reason is added to the data form and its value, Replace, is displayed in the data form.

### Changing Cash Flow Staggered Allocations

By default, cash flow staggered allocation is set to four months from the period of purchase. In this example, we spread the staggered allocation to six months. To do this, we modify the Add Asset business rule.

➤ To change a cash flow staggered allocation:

1 Log on to Essbase Administration Services Console, expand Business Rules, Repository View, Rules, and select the Add Asset business rule.

2 Change the variable, cashStaggeredPers to 6 from 4, at the following statement “IF (CashFlowIncidence== –1) |cashStaggeredPers = 6;”

3 Save the business rule.

➤ To verify the cash flow staggered allocation changes:

1 Open the data form 02. New Asset Requests.
2 Right-click an asset class that has staggered cash flow incidence, such as Machinery and Equipment, and select Add New Asset.

3 Enter new asset request details with an Asset Rate of 180000 (and other details of your choice), and click OK.

4 Right-click the new asset line item and select Cash Flow Impact.

5 In the Cash Flow Impact data form, select FY07 and click GO.

Verify that the basic cost of 180000 has been allocated across six months instead of four months, and that the cash flow amount in each month is 30000.

Adding Data Forms

This example shows how to add data forms that can be used to request new assets for each asset class. This enables entering multiple requests in a data form for each asset class, and saving and calculating in one step.

To add data forms:

1 In Planning, select Administration > Manage Data Forms.

2 From the Data Forms folder, select Capital, select the data form 02. New Asset Requests, and click Edit.

3 Select Save As, type the name 02D. New Asset Requests - Addition based on Asset Class, and click OK.

4 From Data Form Folders, select Capital, select the data form 02D. New Asset Requests – Addition based on Asset Class, and click Edit.

5 Select Row/Column Layout, and in the Row Dimension(s), change the Asset Class dimension to None, and clear Suppress Missing Data and Suppress Missing Blocks.

6 Change the Line Item member value to Descendants("Total New").

7 In the Page/Point of View layout tab, in Page Dimensions Layout, select Add Dimension.

8 Select the Asset Class dimension, select the members Descendants("Tangible Assets"), and click Submit.

9 Click Save and OK.

10 From the Data Forms folder, select Capital, select the data form 02. New Asset Requests, and click Edit.

11 Select the Row/Column Layout tab, select and add the data form 02D. New Asset Requests—Addition based on Asset Class to the Selected Data Forms column.

12 Remove the data form 02A. New Asset Requests—Addition from the Selected Data Forms column.

13 Click Save.

14 From the left pane, select the data form 02 New Asset Requests.

The bottom data form displays asset details as each line item.
Adding Retirement Options for New Assets

In this example, we add retirement options for new assets. We:

- Add a menu item—RetireNewAsset—to the NewAssetMenu that launches a Retire New Asset business rule.
- Add retirement-related members to the New Asset Requests — Addition data form.
- Verify the results.

➤ To add the new menu item, RetireNewAsset:

1. In Planning, select Administration > Manage Menus.
2. Select New Asset Menu, and click Edit.
3. From NewAssetMenu, select 6.0 CalcDepr, and click Add Sibling.
4. In Add Menu Item, set these values:

   ![Add Menu Item dialog box](image)

5. Click Save and close the dialog box.

➤ To update the New Asset Request — Addition data form to include the new retirement—related accounts:

1. Select the data form 02A. New Asset Request – Addition and click Edit.
2. Select Row/Column Layout and click Edit Column Task.
3. Select Column Definition 3, and click Edit.
4. In Member Selection Account, add these accounts to the selection:
   - Delayed start date
   - Reason delayed
   - Premature end date
   - Reason ended
5 Click **Save** and **OK**.

➤ To verify:

1 In Planning, select **Administration > Manage Data Forms**, expand **Forms**, and select **Capital**.

2 **Select 02. New Asset Requests**.

3 Right-click the line item, such as Honda Car, select **Retire Asset**, and enter details, such as asset class, line item, retire date, retire option, sale value for write-off, and retire costs. Click **OK**.

4 Verify that the data form has the premature end date and the reason for retirement.

5 Right-click the retired line item, and select **Profit and Loss Impact**.

6 **Select FY09** and click **GO**. Verify that the depreciation is terminated in the period April FY09 and the Loss/(Gain) on Sale of Property, Plant, and Equipment is calculated.

### Changing Labels

You may want to change some field labels. In this example, we rename the field Asset CAR # (Capital Acquisition Request number) to Asset AFE No (Approval for Expense number).

➤ To change the runtime prompt:

1 **Log on to Essbase Administration Services Console**.

2 **Expand Business Rules, Repository View and Global Variables**.

3 **Select the global variable AssetCAR**.

4 Change the **Prompt String** value, for example, to **Asset AFE No**. (Approval for Expense).
Depending on whether you have a Performance Management Architect or Classic application, to rename the Cap No. member, see “With Performance Management Architect Applications” on page 32 or “With Classic Applications” on page 33.

**With Performance Management Architect Applications**

➤ To rename the CAR No. member to AFE No. in Performance Management Architect Applications:

1. In Performance Management Architect, select **Navigate > Administer > Dimension Library**.
2. Select Account, select **Find Members** and enter CAR No.
3. Because you cannot rename dimensions or members in Performance Management Architect, delete the member CAR No.: With Car No. selected, right-click and select **Delete Member**.
4. Create a new member named AFE No. in the same place in the Account hierarchy: right-click and select **Create Member > As Sibling**.
5. Enter the new member name, AFE No., and accept its default member properties.
6. Drag and drop members from the **Dimension Library** to the Application View, and click **Save**.
7. From the **Application Library**, select **Deploy**.
8. Select **Refresh Cube**, and click **OK**.
9. The renamed member is now available in the Capital Expense Planning application.
10. Ensure that all business rules and data forms that reference the member name CAR No. are changed to AFE No.
11. **From Select Data Form**, expand **Forms**, and select **Capital**.
12. Select **02. New Asset Requests** and verify the field name is changed to AFE No.

**With Classic Applications**

➤ To rename the CAR No. member to AFE No. in Classic applications:

1. In Planning, select **Administration > Dimensions** and select the **Account** dimension.
2. In the **Search box**, enter CAR No. and click **Search**.
3. Click **Edit**.
4. On **Member Properties**, change the **Name** to AFE No. and click **Save**.
5. Select **Administration > Manage Database**, and select **Database** under **Refresh Database Options**.
6. Ensure that all business rules that reference the name CAR No. are changed to AFE No.
7. Select **Administration > Manage Data Forms**, expand **Forms**, and select **Capital**.
8. Select **02. New Asset Requests** and verify the field name is changed to AFE No.
Showing Hidden Fields

Based on business needs, you can show or hide data form fields. In this example, we show the hidden fields that are defined as part of the Add Asset business rule:

- Installation
- Freight
- Taxes %
- Additional charges
- Retirement obligation

To show fields:

1. Log on to Essbase Administration Services Console.
2. Expand Business Rules, Repository View, and Rules.
3. Select the Add Asset business rule.
4. Select the Variables tab.
5. Select the Run-Time Prompts tab.
6. Clear Hide for these fields:
   - Installation
   - Freight
   - Taxes %
   - Additional charges
   - Retirement obligation
7. Save the business rule.
8 In Planning, select Administration > Manage Data Forms, expand Forms, and select Capital.
9 Select 02. New Asset Requests.
10 Right-click an asset class, such as Machinery and Equipment, in the bottom of the data form, and select Add New Asset.
11 In the Add New Asset dialog box, verify the additional fields are available.

Enabling Assumptions at the Entity Level

When using multiple entities, you must update data forms and business rules to ensure that business rules apply to different departments. See “Updating Data Forms to Use Multiple Entities” on page 42 and “Updating Business Rules to Use Multiple Entities” on page 42.

Updating Data Forms to Use Multiple Entities

To update data forms to use multiple entities:

1 In Planning, edit these data forms to update the Point of View dimensions:
   ● 01. Global Capital Assumptions
   ● 15A. Global Capital Assumptions - Depreciation only
      a. Select Administration > Manage Data Forms.
      b. Select the data form to edit, such as 01. Global Capital Assumptions, then click Edit.
      c. Select Page/Point of View Layout.
      d. In the Page Dimension(s) area, select the Entity dimension, click and select a member using a relationship such as Descendants(Entity).
      e. Click Save.
2 Update business rules as described in “Updating Business Rules to Use Multiple Entities” on page 42.

Updating Business Rules to Use Multiple Entities

When you use multiple entities, update the Capital Expense Planning business rules as described here. To ensure that global assumptions apply to different departments, global assumptions must be stored in multiple members of the Entity dimension.


Note:

When planning for transfers, the calculated details for depreciation and other related expenses are based on assumptions set for the source entity. If assumptions for the destination entity are different, you must calculate assets in the destination entity to see the impact on it.
To update business rules to use multiple entities:

1. Update data forms as described in “Updating Data Forms to Use Multiple Entities” on page 42.

2. Using Administration Services, update the Capital Expense Planning business rules to remove the “No Entity” reference. This enables the business rules to vary by the Entity dimension because they do not fix on “No Entity”.


Example: Updating “No Entity” in the Add Asset Business Rule

Before:

"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";

After:

"Useful Life (in Years)" = "No Scenario"->"No Version"->"Global"->"Useful Life (in Years)";

Example: Updating “No Entity” in the AddExistAsset Business Rule

Before:

depMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Method";
depConvention = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Convention";
insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";
repairsCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Repairs %";

After:

depMethod = "No Year"->"No Scenario"->"No Version"->"Global"->"Depreciation Method";
depConvention = "No Year"->"No Scenario"->"No Version"->"Global"->"Depreciation Convention";
insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"Global"->"Maintenance %";
repairsCost = basicCost * "No Year"->"No Scenario"->"No Version"->"Global"->"Repairs %";
Adding a Project Dimension

You can add a Project dimension with information that fits your business needs. See:

- “Creating the Project Dimension” on page 44
- “Updating Data Forms for the Project Dimension” on page 45
- “Updating Business Rules for the Project Dimension” on page 45

Creating the Project Dimension

Depending on whether you have a Performance Management Architect application or a Classic application, see “With Performance Management Architect Applications” on page 44 or “With Classic Applications” on page 44.

With Performance Management Architect Applications

➤ To create a Project dimension in Performance Management Architect Applications:

1 In the Performance Management Architect Master View, create a generic Project dimension and a Dimension Alias with these properties:
   - Dimension Name: Project
   - Dimension Class: Generic
   - Dimension Alias: Project

2 Under the Project dimension, create a member called No Project to store global assumptions.

3 Add other members to include in the Project dimension.

4 Drag and drop the Project dimension into the Performance Management Architect application you want to deploy.

5 Deploy the Capital Expense Planning Application View to refresh the Planning and Oracle's Hyperion® Essbase® – System 9 outlines (see the Hyperion Enterprise Performance Management Architect Administrator’s Guide).

   You can also load the Project dimension and its members from an external flat file and refresh the Capital Expense Planning application.

6 Update data forms and business rules (see “Updating Data Forms for the Project Dimension” on page 45 and “Updating Business Rules for the Project Dimension” on page 45).

With Classic Applications

➤ To create a Project dimension for Classic applications:

1 In Planning, select Administration > Dimensions.

2 Click Add Dimension.
3 Name the dimension Project, select Apply Security (so you can assign access permissions to this dimension), and accept the other defaults.

4 Click Save.

5 Update data forms and business rules (see “Updating Data Forms for the Project Dimension” on page 45 and “Updating Business Rules for the Project Dimension” on page 45).

#### Updating Data Forms for the Project Dimension

After creating a Project dimension, update data forms.

➤ To update data forms to include the Project dimension:

1 **In Planning, update the Point of View dimensions for these data forms:**
   - 01. Global Capital Assumptions
   - 15A. Global Capital Assumptions - Depreciation only
     a. Select Administration > Manage Data Forms.
     b. Select the data form, and click Edit.
     c. Select Page/Point of View Layout.
     d. In the Point of View Dimension(s) area, select No Project as the Project member.
     e. Click Save.

2 **Edit the other Capital Expense Planning data forms to select Descendant members for the Project dimension:**
   a. Select Administration > Manage Data Forms.
   b. Select the data form, and click Edit.
   c. Select Page/Point of View Layout.
   d. In the Page Dimension(s) area, for the Project member, select members by relationship for Project, such as Descendants(Project).
   e. Click Save.

3 **Update business rules to enable storing global assumptions in multiple entities** (see “Updating Business Rules for the Project Dimension” on page 45).

#### Updating Business Rules for the Project Dimension

After creating the Project dimension and updating data forms, update the Capital Expense Planning business rules.

➤ To update business rules for the Project dimension:

1 **Using Administration Services, create a Global Variable called Project with these properties:**
   - Name: Project
   - Type: Member
- **Dimension**: Project
- **Limits**: \@Descendants("Dimension"), where "Dimension" is the limit you want to set, for example, \@Descendants("Project")
- **Usage Type**: Runtime prompt
- **Prompt String**: Project

2 **Update the Capital Expense Planning business rules to include the Project member:**
   - Add the [Project] member to every place the FIX statement appears in the business rules.
   - Update references to global assumptions in the business rules, by adding No Project to them.

3 **You must update all these business rules:**

Appendix A, “Capital Expense Planning Structure” lists the formulas for the business rules.

### Example: Updating the Add Asset Business Rule

#### Example of Including the Project Dimension

"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"-> "No Project" ->"Global"->"Useful Life (in Years);" "Cash Flow Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->"No Project" ->"Global"->"Cash Flow Incidence;" "Funding Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->"No Project" ->"Global"->"Funding Incidence;" cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"No Project" ->"Global"->"Funding Incidence;" fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"No Project" ->"Global"->"Funding Incidence;" deprMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"No Project" ->"Global"->"Depreciation Method;" deprConvention = "No Year"->"No Scenario"->"No Version"->"No Entity"->"No Project" ->"Global"->"Depreciation Convention;" repairsCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"No Project"->"Global"->"Repairs %;" fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"No Project"->"Global"->"Funding %;" insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"No Project"->"Global"->"Insurance %;" maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"No Project"->"Global"->"Maintenance %;"

#### Example of Adding Project When it is Referenced for Global Assumptions

\[ \text{FIX (@CHILDREN("Total New"), [Hidden Scenario], [Hidden Version], [Project], [Department], [Asset Class], "Local", "HSP_INPUTVALUE")} \]
\[ \text{FIX([Hidden Scenario], [Hidden Version],[Project], [Department], "Local",} \]
Example: Updating the Remove Asset Business Rule

Example of Adding Project when it is Referenced for Global Assumptions

```
SET UPDATECALC OFF;
SET AGMISSG ON;

FIX ([Hidden_Scenario], [Hidden_Version], [Project], [Department], [AllAssetClass])
  CLEARDATA [LocalLineItem];
ENDFIX

FIX ([Hidden_Scenario], [Hidden_Version], [Project], [Department])
  @ANCESTORS([LocalLineItem]);
  @ANCESTORS([AllAssetClass]);
ENDFIX
```

Data Forms

When you modify data forms, ensure that the changes are synchronized with business logic (such as business rules, member formulas, and outline structure). Similarly, when you modify business logic, review your data forms.

Smart Lists and Menus

Calculations based on modified Smart Lists may be incorrect. Therefore, you may need to adjust data in the database to reflect the modified values. You can delete predefined menus without impacting predefined calculations.

For Smart Lists and menus, Capital Expense Planning provides predefined labels that are set as resource strings in the HspCustomMsgs template file. If you add or change Smart Lists and menus to your application, you should add the labels to the HspCustomMsgs file. You can localize the labels in your application by updating the localized versions of the HspCustomMsgs file. Modifying the HspCustomMsgs file replaces the default values installed with Capital Expense Planning. For instructions on modifying labels or preparing files for localization, see the Hyperion Planning – System 9 Administrator’s Guide.

To review the implications of changing Smart Lists, and for a list of predefined Smart Lists and menus, see Appendix A, “Capital Expense Planning Structure.”

Member Formulas

Capital Expense Planning member formulas include formula expressions, such as [Formula Name]. Hyperion recommends that you include formula expressions in formulas. For
Performance Management Architect applications, see the *Hyperion Enterprise Performance Management Architect Administrator’s Guide* and for Classic applications, see the *Hyperion Planning – System 9 Administrator’s Guide*.

**Business Rules**

Planners use business rules to perform calculations on asset data when:

- Adding assets to departments. For example, when assets are purchased, planners use the Create Asset business rule to add the assets to a department.
- Transferring assets in and out of departments. For example, planners use the Transfer business rule to transfer assets between departments.

See Appendix A, “Capital Expense Planning Structure” for a list of business rules and their formulas.

You can use Administration Console in Oracle’s Essbase® Administration Services to create, validate, launch, and manage business rules, including the predefined Capital Expense Planning business rules. (See the *Hyperion Business Rules Administrator’s Guide*.)

In Planning, you associate business rules with menus and data forms and set properties for business rules. (See the *Hyperion Planning – System 9 Administrator’s Guide*.) Planners and other users launch the business rules to set and calculate asset data on data forms. (See the *Hyperion Planning – System 9 User’s Guide*.)
This appendix lists the predefined elements of Capital Expense Planning, and helps you determine how elements affect each other.

**Predefined Data Forms**

Planners use data forms to work with asset information.

<table>
<thead>
<tr>
<th>Data Form Name</th>
<th>Axis Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>01. Global Capital Assumptions</td>
<td>Row: Asset Class</td>
</tr>
<tr>
<td></td>
<td>Column: Account</td>
</tr>
<tr>
<td></td>
<td>Page: N/A</td>
</tr>
<tr>
<td></td>
<td>POV: Entity, Line Item, Period, Scenario, Version, Year, Currency</td>
</tr>
<tr>
<td>02A. New Asset Requests - Addition</td>
<td>Row: Asset Class, Line Item</td>
</tr>
<tr>
<td></td>
<td>Column: Account</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Scenario, Version</td>
</tr>
<tr>
<td></td>
<td>POV: Period, Year, Currency</td>
</tr>
<tr>
<td>Data Form Name</td>
<td>Axis Definitions</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>02B. Total Expense Impact</td>
<td>Row: Line Item</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Scenario, Version, Account, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Asset Class, Currency</td>
</tr>
<tr>
<td>02C. Cash Flow Impact - Line Item Details</td>
<td>Row: Account</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td>03. Manage Existing Specified</td>
<td>Row: Asset Class, Line Item</td>
</tr>
<tr>
<td></td>
<td>Column: Account</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Scenario, Version</td>
</tr>
<tr>
<td></td>
<td>POV: Period, Year, Currency</td>
</tr>
<tr>
<td>03A. Existing Specified Drill Down</td>
<td>Row: Account</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td>03B. Existing Specified Expenses</td>
<td>Row: Account</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td>04. Manage Existing Unspecified</td>
<td>Row: Asset Class</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Scenario, Version, Account, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Line Item, Currency</td>
</tr>
<tr>
<td>05A. New Intangible Requests - Additions</td>
<td>Row: Asset Class, Line Item</td>
</tr>
<tr>
<td></td>
<td>Column: Account</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Scenario, Version</td>
</tr>
<tr>
<td></td>
<td>POV: Period, Year, Currency</td>
</tr>
<tr>
<td>Data Form Name</td>
<td>Axis Definitions</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>06. Manage Existing Intangibles Specified</td>
<td>Row: Asset Class, Line Item</td>
</tr>
<tr>
<td></td>
<td>Column: Account</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Scenario, Version</td>
</tr>
<tr>
<td></td>
<td>POV: Period, Year, Currency</td>
</tr>
<tr>
<td>06A. Existing Intangible Specified Drill Down</td>
<td>Row: Account</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td>06B. Existing Specified Expenses - Intangibles</td>
<td>Row: Account</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td>07. Manage Existing Intangibles Unspecified</td>
<td>Row: Asset Class</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Scenario, Version, Account, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Line Item, Currency</td>
</tr>
<tr>
<td>08. Capital Expenditure Summary</td>
<td>Row: Asset Class</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Account, Currency</td>
</tr>
<tr>
<td>08A. Capital Expenditure Summary - Line Item details</td>
<td>Row: Line Item</td>
</tr>
<tr>
<td></td>
<td>Column: Year, Period, Account</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td>09. Intangible Expenditure Summary</td>
<td>Row: Asset Class</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Account, Currency</td>
</tr>
<tr>
<td>Data Form Name</td>
<td>Axis Definitions</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>09A. Intangible Account Balance</td>
<td>Row: Account, Line Item</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td>09B. Intangible Asset Balances</td>
<td>Row: Line Item</td>
</tr>
<tr>
<td></td>
<td>Column: Year, Period, Account</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td>10. Profit and Loss Impact</td>
<td>Row: Account</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
<tr>
<td>13. Depreciation Summary</td>
<td>Row: Asset Class</td>
</tr>
<tr>
<td></td>
<td>Column: Period</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Scenario, Version, Line Item, Year</td>
</tr>
<tr>
<td></td>
<td>POV: Account, Currency</td>
</tr>
<tr>
<td>13A. Depreciation Summary - Line Item details</td>
<td>Row: Line Item</td>
</tr>
<tr>
<td></td>
<td>Column: Year, Period, Account</td>
</tr>
<tr>
<td></td>
<td>Page: Entity, Asset Class, Scenario, Version</td>
</tr>
<tr>
<td></td>
<td>POV: Currency</td>
</tr>
</tbody>
</table>
### Predefined Composite Data Forms

Planners use composite data forms to see information from multiple views.

#### Table 2  Predefined Composite Data Forms

<table>
<thead>
<tr>
<th>Composite Data Form Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>02. New Asset Requests</td>
<td>● 02B. Total Expense Impact</td>
</tr>
<tr>
<td></td>
<td>● 02A. New Asset Requests - Addition</td>
</tr>
<tr>
<td>05. New Intangible Asset Requests</td>
<td>● 02B. Total Expense Impact</td>
</tr>
<tr>
<td></td>
<td>● 05A. New Intangible Requests - Additions</td>
</tr>
<tr>
<td>15. Depreciation What ifs</td>
<td>● 13. Depreciation Summary</td>
</tr>
<tr>
<td></td>
<td>● 15A. Global Capital Assumptions - Depreciation only</td>
</tr>
</tbody>
</table>

### Predefined Accounts

For Oracle's Enterprise Performance Management Architect applications, you can view the properties and hierarchy for predefined account members by opening an Application View and selecting dimensions and members in the Dimension Library. Properties are displayed in the Property Grid. For Classic applications, in Oracle's Hyperion® Planning – System 9, select Administration > Dimensions and select the Account dimension.
### Table 3  Predefined Accounts

<table>
<thead>
<tr>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts (Capital Expense)</td>
</tr>
<tr>
<td>Assets</td>
</tr>
<tr>
<td>Property, Plant and Equipment Net</td>
</tr>
<tr>
<td>Property, Plant and Equipment Gross</td>
</tr>
<tr>
<td>Accumulated Depreciation</td>
</tr>
<tr>
<td>Intangible Assets, Net</td>
</tr>
<tr>
<td>Intangible Assets - Indefinite</td>
</tr>
<tr>
<td>Intangible Assets Finite, Net</td>
</tr>
<tr>
<td>Intangible Assets Finite, Gross</td>
</tr>
<tr>
<td>Accumulated Amortization</td>
</tr>
<tr>
<td>Liabilities</td>
</tr>
<tr>
<td>Long Term Debt</td>
</tr>
<tr>
<td>Asset Retirement Liability</td>
</tr>
<tr>
<td>Capital Reserve</td>
</tr>
<tr>
<td>Cash Flows</td>
</tr>
<tr>
<td>Net Cash Flows</td>
</tr>
<tr>
<td>Cash Outflow from Capital Additions</td>
</tr>
<tr>
<td>Cash Inflow from Funding</td>
</tr>
<tr>
<td>Proceeds from Sale of Property, Plant and Equipment</td>
</tr>
<tr>
<td>Proceeds from Sale of Intangibles</td>
</tr>
<tr>
<td>Expenses (Capital)</td>
</tr>
<tr>
<td>Fixed Assets Related Expenses</td>
</tr>
<tr>
<td>Insurance</td>
</tr>
<tr>
<td>Maintenance</td>
</tr>
<tr>
<td>Repairs</td>
</tr>
<tr>
<td>Other Operational Costs</td>
</tr>
<tr>
<td>Depreciation</td>
</tr>
<tr>
<td>Amortization</td>
</tr>
<tr>
<td>Account</td>
</tr>
<tr>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Loss/(Gain) on Sale of Property, Plant and Equipment</td>
</tr>
<tr>
<td>Loss/(Gain) on Sale of Intangibles</td>
</tr>
<tr>
<td>Impairment of Assets</td>
</tr>
<tr>
<td>Retirement Expenses</td>
</tr>
<tr>
<td>Capital Assumptions</td>
</tr>
<tr>
<td>Capital Driver Assumptions</td>
</tr>
<tr>
<td>Useful Life (in Years)</td>
</tr>
<tr>
<td>Depreciation Method</td>
</tr>
<tr>
<td>Depreciation Convention</td>
</tr>
<tr>
<td>Cash Flow Incidence</td>
</tr>
<tr>
<td>Funding %</td>
</tr>
<tr>
<td>Funding Incidence</td>
</tr>
<tr>
<td>Insurance %</td>
</tr>
<tr>
<td>Repairs %</td>
</tr>
<tr>
<td>Maintenance %</td>
</tr>
<tr>
<td>Amortization Method</td>
</tr>
<tr>
<td>Depreciation Rate</td>
</tr>
<tr>
<td>Asset Properties</td>
</tr>
<tr>
<td>Asset ID</td>
</tr>
<tr>
<td>Asset Description</td>
</tr>
<tr>
<td>CAR No.</td>
</tr>
<tr>
<td>UOM</td>
</tr>
<tr>
<td>Purchase Reason Code</td>
</tr>
<tr>
<td>Justification</td>
</tr>
<tr>
<td>Priority</td>
</tr>
<tr>
<td>Physical Location</td>
</tr>
<tr>
<td>Asset Control Properties</td>
</tr>
<tr>
<td>Asset Status</td>
</tr>
<tr>
<td>Account</td>
</tr>
<tr>
<td>------------------</td>
</tr>
<tr>
<td>Purchase Date</td>
</tr>
<tr>
<td>Retirement Date</td>
</tr>
<tr>
<td>Delayed Start Date</td>
</tr>
<tr>
<td>In Service Date</td>
</tr>
<tr>
<td>Reason delayed</td>
</tr>
<tr>
<td>Premature End Date</td>
</tr>
<tr>
<td>Reason ended</td>
</tr>
<tr>
<td>Impairment Option</td>
</tr>
<tr>
<td>Impairment Date1</td>
</tr>
<tr>
<td>Impairment Fair Value1</td>
</tr>
<tr>
<td>Impairment Date2</td>
</tr>
<tr>
<td>Impairment Fair Value2</td>
</tr>
<tr>
<td>Freight</td>
</tr>
<tr>
<td>Installation</td>
</tr>
<tr>
<td>Salvage</td>
</tr>
<tr>
<td>Salvage Input</td>
</tr>
<tr>
<td>Sale Value</td>
</tr>
<tr>
<td>Acquisition Costs</td>
</tr>
<tr>
<td>Additional Charges</td>
</tr>
<tr>
<td>Retirement Costs</td>
</tr>
<tr>
<td>Retirement Options</td>
</tr>
<tr>
<td>Retirement Obligation</td>
</tr>
<tr>
<td>Partial Capitalize %</td>
</tr>
<tr>
<td>Taxes %</td>
</tr>
<tr>
<td>Cash Flow Allocator</td>
</tr>
<tr>
<td>Funding Allocator</td>
</tr>
<tr>
<td>Capital Expenditure</td>
</tr>
<tr>
<td>Basic Cost</td>
</tr>
<tr>
<td>Account</td>
</tr>
<tr>
<td>-----------</td>
</tr>
</tbody>
</table>

**Predefined Asset Classes**

**Table 4  Predefined Asset Classes**

<p>| Asset Class     |               |               |               |               |               |             |          |         |           |               |               |             |            |           |           |           |               |               | externally |               |           |           |
|-----------------|---------------|---------------|---------------|---------------|---------------|-------------|----------|---------|-----------|-------------|---------------|---------------|-------------|------------|-----------|----------|-----------|----------------|---------------------|---------------------|----------------|---------------|-----------|
| Asset Class     |               |               |               |               |               |             |          |         |           |               |               |             |            |           |           |           |               |               | externally |               |           |           |
| No Asset        |               |               |               |               |               |             |          |         |           |               |               |             |            |           |           |           |               |               | externally |               |           |           |
| Total Fixed Assets |           |               |               |               |               |             |          |         |           |               |               |             |            |           |           |           |               |               | externally |               |           |           |</p>
<table>
<thead>
<tr>
<th>Line Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
</tr>
<tr>
<td>No Line Item</td>
</tr>
<tr>
<td>Total All</td>
</tr>
<tr>
<td>Total New</td>
</tr>
<tr>
<td>Line Item 1</td>
</tr>
<tr>
<td>Line Item 2</td>
</tr>
<tr>
<td>Line Item 3</td>
</tr>
<tr>
<td>Line Item 4</td>
</tr>
<tr>
<td>Line Item 5</td>
</tr>
<tr>
<td>Line Item 6</td>
</tr>
</tbody>
</table>

Predefined Line Items

Table 5  Predefined Line Items
<table>
<thead>
<tr>
<th><strong>Line Item</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Item 7</td>
</tr>
<tr>
<td>Line Item 8</td>
</tr>
<tr>
<td>Line Item 9</td>
</tr>
<tr>
<td>Line Item 10</td>
</tr>
<tr>
<td>Line Item 11</td>
</tr>
<tr>
<td>Line Item 12</td>
</tr>
<tr>
<td>Line Item 13</td>
</tr>
<tr>
<td>Line Item 14</td>
</tr>
<tr>
<td>Line Item 15</td>
</tr>
<tr>
<td>Line Item 16</td>
</tr>
<tr>
<td>Line Item 17</td>
</tr>
<tr>
<td>Line Item 18</td>
</tr>
<tr>
<td>Line Item 19</td>
</tr>
<tr>
<td>Line Item 20</td>
</tr>
<tr>
<td>Line Item 21</td>
</tr>
<tr>
<td>Line Item 22</td>
</tr>
<tr>
<td>Line Item 23</td>
</tr>
<tr>
<td>Line Item 24</td>
</tr>
<tr>
<td>Line Item 25</td>
</tr>
<tr>
<td>Line Item 26</td>
</tr>
<tr>
<td>Line Item 27</td>
</tr>
<tr>
<td>Line Item 28</td>
</tr>
<tr>
<td>Line Item 29</td>
</tr>
<tr>
<td>Line Item 30</td>
</tr>
<tr>
<td><strong>Total Existing</strong></td>
</tr>
<tr>
<td><strong>Total Specified</strong></td>
</tr>
<tr>
<td><strong>SP1</strong></td>
</tr>
<tr>
<td><strong>Base SP1</strong></td>
</tr>
<tr>
<td>Line Item</td>
</tr>
<tr>
<td>---------------------------</td>
</tr>
<tr>
<td>IM1 SP1</td>
</tr>
<tr>
<td>IM2 SP1</td>
</tr>
<tr>
<td>IM3 SP1</td>
</tr>
<tr>
<td>SP2</td>
</tr>
<tr>
<td>Base SP2</td>
</tr>
<tr>
<td>IM1 SP2</td>
</tr>
<tr>
<td>IM2 SP2</td>
</tr>
<tr>
<td>IM3 SP2</td>
</tr>
<tr>
<td>SP3</td>
</tr>
<tr>
<td>Base SP3</td>
</tr>
<tr>
<td>IM1 SP3</td>
</tr>
<tr>
<td>IM2 SP3</td>
</tr>
<tr>
<td>IM3 SP3</td>
</tr>
<tr>
<td>SP4</td>
</tr>
<tr>
<td>Base SP4</td>
</tr>
<tr>
<td>IM1 SP4</td>
</tr>
<tr>
<td>IM2 SP4</td>
</tr>
<tr>
<td>IM3 SP4</td>
</tr>
<tr>
<td>SP5</td>
</tr>
<tr>
<td>Base SP5</td>
</tr>
<tr>
<td>IM1 SP5</td>
</tr>
<tr>
<td>IM2 SP5</td>
</tr>
<tr>
<td>IM3 SP5</td>
</tr>
<tr>
<td>SP6</td>
</tr>
<tr>
<td>Base SP6</td>
</tr>
<tr>
<td>IM1 SP6</td>
</tr>
<tr>
<td>IM2 SP6</td>
</tr>
<tr>
<td>IM3 SP6</td>
</tr>
<tr>
<td>Line Item</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>SP7</td>
</tr>
<tr>
<td>Base SP7</td>
</tr>
<tr>
<td>IM1 SP7</td>
</tr>
<tr>
<td>IM2 SP7</td>
</tr>
<tr>
<td>IM3 SP7</td>
</tr>
<tr>
<td>SP8</td>
</tr>
<tr>
<td>Base SP8</td>
</tr>
<tr>
<td>IM1 SP8</td>
</tr>
<tr>
<td>IM2 SP8</td>
</tr>
<tr>
<td>IM3 SP8</td>
</tr>
<tr>
<td>SP9</td>
</tr>
<tr>
<td>Base SP9</td>
</tr>
<tr>
<td>IM1 SP9</td>
</tr>
<tr>
<td>IM2 SP9</td>
</tr>
<tr>
<td>IM3 SP9</td>
</tr>
<tr>
<td>SP10</td>
</tr>
<tr>
<td>Base SP10</td>
</tr>
<tr>
<td>IM1 SP10</td>
</tr>
<tr>
<td>IM2 SP10</td>
</tr>
<tr>
<td>IM3 SP10</td>
</tr>
<tr>
<td>Total Unspecified</td>
</tr>
<tr>
<td>Unspecified</td>
</tr>
<tr>
<td>Adj SP1</td>
</tr>
<tr>
<td>Adj SP2</td>
</tr>
<tr>
<td>Adj SP3</td>
</tr>
<tr>
<td>Adj SP4</td>
</tr>
<tr>
<td>Adj SP5</td>
</tr>
<tr>
<td>Adj SP6</td>
</tr>
</tbody>
</table>
Predefined Member Formulas

Member formulas are used for capital expense calculations.

Cal TP-Index

Formula

[OpenInputValueBlock] [CalendarTPIndex] [CloseInputValueBlock]

Description

System member that returns the time period index based on a calendar year. Example: Fiscal year starting in Jul: Jan=1, Feb=2, Mar=3, and so on.

Capital Driver Assumptions

Formula

#MISSING;
Description
Label account to group assumptions.

**First Date**

**Formula**

\[
\text{[OpenInputValueBlock]} \ \text{[FirstDate]} \ \text{[CloseInputValueBlock]}
\]

**Description**

System member that returns a value that represents the first date for the application.

**Fiscal TP-Index**

**Formula**

\[
\text{[OpenInputValueBlock]} \ \text{[FiscalTPIndex]} \ \text{[CloseInputValueBlock]}
\]

**Description**

System member that returns the time period index based on a fiscal year. Example: Fiscal year starting in Jul: Jul=1, Aug=2, Sep=3, and so on.

**NumPeriods**

**Formula**

\[
\text{[OpenInputValueBlock]} \ \text{[NumberOfPeriodsInYear]}; \ \text{[CloseInputValueBlock]}
\]

**Description**

System member that returns the number of periods in a year.

**Spread_445**

**Formula**

\[
\text{[OpenInputValueBlock]} \ \text{[TimeBalanceFormula("Spread_445")]} \ \text{[CloseInputValueBlock]}
\]

**Description**

System member that returns a spread factor following 4 week, 4 week, 5 week quarter.

**Spread_454**

**Formula**

\[
\text{[OpenInputValueBlock]} \ \text{[TimeBalanceFormula("Spread_454")]} \ \text{[CloseInputValueBlock]}
\]
Description
System member that returns a spread factor following 4 week, 5 week, 4 week quarter.

**Spread_544**

Formula

```
[OpenInputValueBlock] [TimeBalanceFormula("Spread_544")]
[CloseInputValueBlock]
```

Description
System member that returns a spread factor following 5 week, 4 week, 4 week quarter.

**Spread_Actual_365**

Formula

```
[OpenInputValueBlock] [TimeBalanceFormula("Spread_Actual_365")]
[CloseInputValueBlock]
```

Description
System member that returns a spread factor following a 365 day calendar year.

**Spread_Actual_Actual**

Formula

```
[OpenInputValueBlock] [TimeBalanceFormula("Spread_Actual_Actual")]
[CloseInputValueBlock]
```

Description
System member that returns a spread factor following the actual days in a calendar year.

**Spread_Average**

Formula

```
[OpenInputValueBlock] [TimeBalanceFormula("Spread_Average")]
[CloseInputValueBlock]
```

Description
System member that returns a spread factor following the time balance average pattern.

**Spread_Balance**

Formula
Description
System member that returns a spread factor following the time balance last pattern.

**Spread_First**

Formula

Description
System member that returns a spread factor following the time balance first pattern.

**Spread_Flow**

Formula

Description
System member that returns a spread factor following the normal flow pattern.

**TP-Date**

Formula

Description
System member that returns a value that represents the date corresponding to the time period.

**YR-Index**

Formula

Description
System member that returns a value that represents the year offset from the first year in the application.
Predefined Smart Lists

Planners use Smart Lists in data forms to work with asset data. Associated account members are listed where applicable.

Table 6  Predefined Smart Lists

<table>
<thead>
<tr>
<th>Smart List</th>
<th>Associated Account Member</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepMethod</td>
<td>Depreciation Method</td>
</tr>
<tr>
<td>PhysicalLocation</td>
<td>Physical Location</td>
</tr>
<tr>
<td>AssetStatus</td>
<td>Asset Status</td>
</tr>
<tr>
<td>DeprConvention</td>
<td>Depreciation Convention</td>
</tr>
<tr>
<td>TangibleFlag</td>
<td>None</td>
</tr>
<tr>
<td>CashFlowIncidence</td>
<td>Cash Flow Incidence, Funding Incidence</td>
</tr>
<tr>
<td>RetireOptions</td>
<td>Retirement Options</td>
</tr>
<tr>
<td>AmortizationMethod</td>
<td>Amortization Method</td>
</tr>
<tr>
<td>DelayReasons</td>
<td>Reason delayed</td>
</tr>
<tr>
<td>EndReasons</td>
<td>Reason ended</td>
</tr>
<tr>
<td>AssetPriority</td>
<td>Priority</td>
</tr>
<tr>
<td>AssetUOM</td>
<td>UOM</td>
</tr>
<tr>
<td>ImpairmentOptions</td>
<td>Impairment Option</td>
</tr>
<tr>
<td>PurchReason</td>
<td>Purchase Reason Code</td>
</tr>
</tbody>
</table>

Predefined Smart List Entries

Review the predefined Smart Lists to determine if you need to change any of them or add new ones. Smart Lists are used in predefined member formulas and drive the calculations of the Oracle's Hyperion® Capital Expense Planning model; before changing or adding Smart Lists, review how Smart List entries affect member formulas.

Hyperion recommends adding new entries to the predefined Smart Lists instead of replacing them. If you change Smart Lists when there is data already in the system, you must update the data to the new values. Consider potential future changes when designing your Smart Lists.

Table 7  Predefined Smart List Entries

<table>
<thead>
<tr>
<th>Smart List</th>
<th>Entries</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepMethod</td>
<td>● NoDepr</td>
</tr>
<tr>
<td>Smart List</td>
<td>Entries</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>● SLN</td>
</tr>
<tr>
<td></td>
<td>● SYD</td>
</tr>
<tr>
<td></td>
<td>● DBYear</td>
</tr>
<tr>
<td></td>
<td>● DBPeriod</td>
</tr>
<tr>
<td>PhysicalLocation</td>
<td>● Location1</td>
</tr>
<tr>
<td></td>
<td>● Location2</td>
</tr>
<tr>
<td></td>
<td>● Location3</td>
</tr>
<tr>
<td>AssetStatus</td>
<td>● Delete</td>
</tr>
<tr>
<td></td>
<td>● New</td>
</tr>
<tr>
<td></td>
<td>● Active</td>
</tr>
<tr>
<td></td>
<td>● Retired</td>
</tr>
<tr>
<td></td>
<td>● Sold</td>
</tr>
<tr>
<td></td>
<td>● Transferred</td>
</tr>
<tr>
<td>DeprConvention</td>
<td>● ProrateBegPer</td>
</tr>
<tr>
<td></td>
<td>● ProrateActDate</td>
</tr>
<tr>
<td></td>
<td>● MidPeriod</td>
</tr>
<tr>
<td></td>
<td>● MidYear</td>
</tr>
<tr>
<td>TangibleFlag</td>
<td>● Tangible</td>
</tr>
<tr>
<td></td>
<td>● Intangible</td>
</tr>
<tr>
<td>CashFlowIncidence</td>
<td>● MonthsPrior2</td>
</tr>
<tr>
<td></td>
<td>● MonthsPrior1</td>
</tr>
<tr>
<td></td>
<td>● Staggered</td>
</tr>
<tr>
<td></td>
<td>● SameMonth</td>
</tr>
<tr>
<td></td>
<td>● MonthsCredit1</td>
</tr>
<tr>
<td></td>
<td>● MonthsCredit2</td>
</tr>
<tr>
<td></td>
<td>● MonthsCredit3</td>
</tr>
<tr>
<td></td>
<td>● MonthsCredit4</td>
</tr>
<tr>
<td>RetireOptions</td>
<td>● Sale</td>
</tr>
<tr>
<td></td>
<td>● WriteOff</td>
</tr>
<tr>
<td>AmortizationMethod</td>
<td>● FiniteLivedEven</td>
</tr>
<tr>
<td></td>
<td>● IndefiniteLived</td>
</tr>
<tr>
<td>DelayReasons</td>
<td>● TransferIn</td>
</tr>
<tr>
<td>EndReasons</td>
<td>● TransferOut</td>
</tr>
<tr>
<td></td>
<td>● Retirement</td>
</tr>
<tr>
<td></td>
<td>● Sold</td>
</tr>
<tr>
<td>AssetPriority</td>
<td>● High</td>
</tr>
</tbody>
</table>
### Predefined Menus

Planners use menus to work with asset data in data forms. The tables in this section describe these predefined menus. The information listed in the Label Value column is displayed when planners click a row member.

**Table 8  Predefined Menus: CapEx**

<table>
<thead>
<tr>
<th>Label Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amortization Summary Menu</td>
<td>Runs the predefined business rule and summarizes the amortized assets</td>
</tr>
<tr>
<td>Capital Expense Summary Menu</td>
<td>Runs the predefined business rule and summarizes the planned capital expenses</td>
</tr>
<tr>
<td>Depreciation Summary Menu</td>
<td>Runs the predefined business rule and summarizes the depreciated assets</td>
</tr>
<tr>
<td>Existing Intangible Menu</td>
<td>Runs the predefined business rule to add existing intangible assets</td>
</tr>
<tr>
<td>Existing Specified Menu</td>
<td>Runs the predefined business rule to add existing tangible assets</td>
</tr>
<tr>
<td>Intangible Expense Summary Menu</td>
<td>Runs the predefined business rule and summarizes the expenses for intangibles</td>
</tr>
<tr>
<td>New Asset Menu</td>
<td>Runs the predefined business rule to create assets</td>
</tr>
<tr>
<td>New Intangible Menu</td>
<td>Runs the predefined business rule to create intangible assets</td>
</tr>
</tbody>
</table>
### Table 9  Predefined Menu: New Intangible Menu

<table>
<thead>
<tr>
<th>Label Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Asset</td>
<td>Business rule</td>
</tr>
<tr>
<td>Profit Loss Impact</td>
<td>Data form</td>
</tr>
<tr>
<td>Balance Sheet Impact</td>
<td>Data form</td>
</tr>
<tr>
<td>Cash Flow Impact</td>
<td>Data form</td>
</tr>
<tr>
<td>Remove Asset</td>
<td>Business rule</td>
</tr>
<tr>
<td>Calculate Amortization</td>
<td>Business rule</td>
</tr>
</tbody>
</table>

### Table 10  Predefined Menu: New Asset Menu

<table>
<thead>
<tr>
<th>Label Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Asset</td>
<td>Business rule</td>
</tr>
<tr>
<td>Profit Loss Impact</td>
<td>Data form</td>
</tr>
<tr>
<td>Balance Sheet Impact</td>
<td>Data form</td>
</tr>
<tr>
<td>Cash Flow Impact</td>
<td>Data form</td>
</tr>
<tr>
<td>Remove Asset</td>
<td>Business rule</td>
</tr>
<tr>
<td>Calc Depreciation</td>
<td>Business rule</td>
</tr>
</tbody>
</table>

### Table 11  Predefined Menu: Existing Specified Menu

<table>
<thead>
<tr>
<th>Label Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer</td>
<td>Business rule</td>
</tr>
<tr>
<td>Retire</td>
<td>Business rule</td>
</tr>
<tr>
<td>Improve</td>
<td>Business rule</td>
</tr>
<tr>
<td>Asset Expenses</td>
<td>Data form</td>
</tr>
<tr>
<td>Add Existing</td>
<td>Business rule</td>
</tr>
<tr>
<td>Remove Existing</td>
<td>Business rule</td>
</tr>
<tr>
<td>Calculate Asset</td>
<td>Business rule</td>
</tr>
<tr>
<td>Calculate Details</td>
<td>(Not applicable)</td>
</tr>
<tr>
<td>Cash Flow Impact</td>
<td>Data form</td>
</tr>
</tbody>
</table>
### Table 12 Predefined Menu: Existing Intangible Menu

<table>
<thead>
<tr>
<th>Label Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Existing Asset</td>
<td>Business rule</td>
</tr>
<tr>
<td>Impair</td>
<td>Business rule</td>
</tr>
<tr>
<td>Transfer</td>
<td>Business rule</td>
</tr>
<tr>
<td>Retire</td>
<td>Business rule</td>
</tr>
<tr>
<td>Enter Expense</td>
<td>Data form</td>
</tr>
<tr>
<td>Remove Existing Asset</td>
<td>Business rule</td>
</tr>
<tr>
<td>Calculate Asset</td>
<td>Business rule</td>
</tr>
<tr>
<td>Line</td>
<td>(Not applicable)</td>
</tr>
<tr>
<td>Calculate Details</td>
<td>Business rule</td>
</tr>
<tr>
<td>Cashflow Impact</td>
<td>Business rule</td>
</tr>
</tbody>
</table>

### Table 13 Predefined Menu: Capital Expense Summary Menu

<table>
<thead>
<tr>
<th>Label Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cap Sum Asset Balances</td>
<td>Data form</td>
</tr>
<tr>
<td>Roll up Asset</td>
<td>Business rule</td>
</tr>
</tbody>
</table>

### Table 14 Predefined Menu: Intangible Expense Summary Menu

<table>
<thead>
<tr>
<th>Label Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intangible LI Details</td>
<td>Data form</td>
</tr>
</tbody>
</table>

### Table 15 Predefined Menu: Depreciation Summary Menu

<table>
<thead>
<tr>
<th>Label Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depreciation Details</td>
<td>Data form</td>
</tr>
<tr>
<td>Roll up Asset</td>
<td>Business rule</td>
</tr>
<tr>
<td>Calculate Depreciation</td>
<td>Business rule</td>
</tr>
<tr>
<td>Calculate Existing Depreciation</td>
<td>Business rule</td>
</tr>
</tbody>
</table>

### Table 16 Predefined Menu: Amortization Summary Menu

<table>
<thead>
<tr>
<th>Label Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amortization Details</td>
<td>Data form</td>
</tr>
<tr>
<td>Roll up Asset</td>
<td>Business rule</td>
</tr>
<tr>
<td>Label Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Calculate Amortization</td>
<td>Business rule</td>
</tr>
<tr>
<td>Calculate Existing Amortization</td>
<td>Business rule</td>
</tr>
</tbody>
</table>

This table lists the predefined data forms that have associated menus. The other data forms do not have associated predefined menus.

### Table 17 Predefined Menus in Data Forms

<table>
<thead>
<tr>
<th>Data Form</th>
<th>Associated Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>02A. New Asset Requests - Addition</td>
<td>NewAssetMenu</td>
</tr>
<tr>
<td>03. Manage Existing Specified</td>
<td>ExistingSpecifiedMenu</td>
</tr>
<tr>
<td>03A. Existing Specified Drill Down</td>
<td>ExistingSpecifiedMenu</td>
</tr>
<tr>
<td>03B. Existing Specified Expenses</td>
<td>ExistingSpecifiedMenu</td>
</tr>
<tr>
<td>05A. New Intangible Requests - Additions</td>
<td>NewIntangibleMenu</td>
</tr>
<tr>
<td>06. Manage Existing Intangibles Specified</td>
<td>ExistingIntangibleMenu</td>
</tr>
<tr>
<td>08. Capital Expenditure Summary</td>
<td>CapitalExpenseSummaryMenu</td>
</tr>
<tr>
<td>08A. Capital Expenditure Summary - Line Item details</td>
<td>CapitalExpenseSummaryMenu</td>
</tr>
<tr>
<td>09. Intangible Expenditure Summary</td>
<td>IntangibleExpSummMenu</td>
</tr>
<tr>
<td>13. Depreciation Summary</td>
<td>DeprSummaryMenu</td>
</tr>
<tr>
<td>13A. Depreciation Summary - Line Item details</td>
<td>CapitalExpenseSummaryMenu</td>
</tr>
<tr>
<td>14. Amortization Summary</td>
<td>AmortSummaryMenu</td>
</tr>
<tr>
<td>14A. Amortization Summary - Line Item details</td>
<td>CapitalExpenseSummaryMenu</td>
</tr>
</tbody>
</table>

### Predefined Business Rules

Planners use predefined business rules to calculate capital expense data.

**Add Asset**

**Description**

Adds a new asset.

**Formula**

```
SET CREATENONMISSINGBLK ON;
VAR periodOffset = 0;
```
VAR deprMethod = 0;
VAR deprRate = 0;
VAR deprConvention = 0;
VAR numDeprPeriods = 0;
VAR totDeprPeriods = 0;
VAR persIn1stYear = 12;
VAR priorAccumDepr = 0;
VAR periodicPriorAccumDepr = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR deprAmt = 0;
VAR persInSection = 0;
VAR life = 0;
VAR lifeIndex = 0;
VAR isAnnual = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR retirementCosts = 0;
VAR retirementObs = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR repairsCost = 0;
VAR cashOutflowDate = 0;
VAR fundingDate = 0;
VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR setCashImpact = 0;
VAR setFundingImpact = 0;
VAR paramsSet = 0;
VAR netValue;
VAR saleValue;
VAR yearVal;
VAR monthVal;
VAR dayVal;
VAR delayStart;
VAR split1stAmt;
VAR numAsset = [NumAsset];
VAR preExistingPers = 0;
VAR setStartDepr = 0;

FIX(@CHILDREN("Total New"), [Hidden_Scenario], [Hidden_Version], [Department],
[AssetClass])

/* Setup properties for new Asset */
FIX("No Year", "BegBalance")
"Asset Description" {
IF (numAsset > 0 AND @MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING )
numAsset = numAsset - 1;
"Asset Status" = 0;  /* Indicate that we have a new asset */
"Asset Description" = [AssetDesc];
"CAR No." = [AssetCAR];
"Justification" = [Justification];
"Priority" = [Priority];
"Asset Units" = [AssetUnits];
"Asset Rate" = [AssetRate];
"Installation" = [Installation];
"Freight" = [Freight];
"Salvage Input" = [SalvageValue];
"Salvage" = [SalvageValue] * "Asset Units";
"Taxes %" = [TaxesPct];
"Additional Charges" = [AdditionalCharges];
"Retirement Obligation" = [RetirementObs];
"Physical Location" = [PhyLocation];
"Basic Cost" = "Asset Units" * "Asset Rate" + ("Asset Units" * "Asset Rate" * "Taxes %") + "Freight" + "Additional Charges" + "Retirement Obligation" + "Installation";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Cash Flow Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";
"Funding Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";
"Purchase Date" = [PurchaseDate];
"In Service Date" = [InserviceDate];
"UOM" = 1; /* Default to Nos */
IF ("In Service Date" < "Purchase Date")
**In Service Date" = "Purchase Date"**
ENDIF
ENDFIX

/* Calculate depreciation section */
FIX (@LEVMBRS("Period", 0), @LEVMBRS("Year", 0))
"Depreciation"

/* Only process newly added asset line items */
IF ("No Year"->"BegBalance"->"Asset Status" == 0)
IF (@ISMBR("BegBalance") AND paramsSet == 0)
paramsSet = 1;

/* Initialized all the variables required to calculate depreciation */
/* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
cashOutflowDate = purchaseDate;
fundingDate = purchaseDate;
cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";
IF (cashFlowIncidence == -1)
cashStaggeredPers = 4;
ELSE

/* Extract year and month from date to adjust based in incidence values in global assumptions */

    yearVal = @INT(cashOutflowDate / 10000) * 10000;
    monthVal = cashOutflowDate - yearVal;
    monthVal = monthVal + cashFlowIncidence;

    IF (monthVal <= 0)
        yearVal = yearVal - 10000;
        monthVal = 1200 + monthVal;
    ELSEIF (monthVal > 1200)
        yearVal = yearVal + 10000;
        monthVal = monthVal - 1200;
    ENDIF

    cashOutflowDate = yearVal + monthVal;
    cashStaggeredPers = 1;
ENDIF

fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";

    IF (fundingIncidence == -1)
        fundingStaggeredPers = 4;
    ELSE
        yearVal = @INT(fundingDate / 10000) * 10000;
        monthVal = fundingDate - yearVal;
        monthVal = monthVal + fundingIncidence;

        IF (monthVal <= 0)
            yearVal = yearVal - 10000;
            monthVal = 1200 + monthVal;
        ELSEIF (monthVal > 1200)
            yearVal = yearVal + 10000;
            monthVal = monthVal - 1200;
        ENDIF

        fundingDate = yearVal + monthVal;
        fundingStaggeredPers = 1;
    ENDIF

/* Initialize for depreciation calc in next section */

    basicCost = "No Year"->"Basic Cost";
    salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
    saleValue = "No Year"->"Sale Value";
    retirementCosts = "No Year"->"Retirement Costs";
    retirementObs = "No Year"->"Retirement Obligation";

    deprMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Method";
    deprConvention = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Convention";
    insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
    maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";
    repairsCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Repairs %";
fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding %";

    /* check if we have a pre-existing asset */
    IF (inServiceDate < "First Date")
        IF (yearVal > 0)
            yearVal = yearVal - 1;
        ENDIF
        monthVal = 1200 + monthVal;
    ENDIF
    preExistingPers = yearVal * 12 + monthVal / 100;
    setStartDepr = 1;
    ELSE
        preExistingPers = 0;
        setStartDepr = 0;
    ENDIF

    /* setup for depreciation */
    numDeprPeriods = 0;
    periodOffset = 0;

    IF (deprMethod > 0)
        priorAccumDepr = 0;
        periodicPriorAccumDepr = 0;
        deprAmt = 0;

        /* Add a periodic vs annual property instead of additional deprMethods */
        /* Annual Methods SumYearDigits = 2, DecliningBalance Year = 3*/
        IF (deprMethod == 2 OR deprMethod == 3)
            isAnnual = 1;
            life = "No Year"->"Useful Life (in Years)";
            persInSection = "NumPeriods";
        ELSE /* Periodic Methods */
            isAnnual = 0;
            life = "No Year"->"Useful Life (in Years)" * "NumPeriods";
            persInSection = 1;
        ENDIF
    ENDIF

    setCashImpact = 0;
    setFundingImpact = 0;
    yearVal = @INT(inServiceDate / 10000) * 10000;

    /* DecliningBalance methods */
    IF (deprMethod == 3 OR deprMethod == 4)
        deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life); /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
    ENDIF

    /* Reset depr method to SLN convention to prorate 1st period for preExisting...
assets */
    IF (preExistingPers > 0)
        deprMethod = 1;
        deprConvention = 1;
    ENDIF
ENDIF

/* Set Asset Status to active when we hit the end */
IF (@ISMBR("No Year") AND @ISMBR("BegBalance"))
    paramsSet = 0;
    IF ("Asset Status" == 0)
        "Asset Status" = 1;
    ENDIF
ENDIF

/* Start depreciation calculations */
IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
    /* clear out any previously calculated values */
    "Depreciation" = #MISSING;
    "Accumulated Depreciation" = #MISSING;
    "Property, Plant and Equipment Gross" = #MISSING;
    "Loss/(Gain) on Sale of Property, Plant and Equipment" = #MISSING;
    "Proceeds from Sale of Property, Plant and Equipment" = #MISSING;
    "Cash Flow Allocator" = #MISSING;
    "Funding Allocator" = #MISSING;
    "Cash Outflow from Capital Additions" = #MISSING;
    "Cash Inflow from Funding" = #MISSING;
    "Long Term Debt" = #MISSING;
    "Insurance" = #MISSING;
    "Maintenance" = #MISSING;
    "Repairs" = #MISSING;
    "Retirement Expenses" = #MISSING;
    "Capital Expenditure" = #MISSING;
    IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
        "Capital Expenditure" = basicCost - retirementObs;
    ENDIF
    /* Check if we should start setting cash flow impact values */
    IF ("TP-Date" == cashOutflowDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
        setCashImpact = cashStaggeredPers;
        cashAllocPct = 1 / cashStaggeredPers;
    ENDIF
    /* Check if we should start setting funding values */
    IF ("TP-Date" == fundingDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
        setFundingImpact = fundingStaggeredPers;
        fundingAllocPct = 1 / fundingStaggeredPers;
    ENDIF
    IF (setCashImpact > 0)
"Cash Flow Allocator" = cashAllocPct;
setCashImpact = setCashImpact - 1;
ENDIF
"Cash Outflow from Capital Additions" = basicCost * "Cash Flow Allocator";

IF (setFundingImpact > 0)
   "Funding Allocator" = fundingAllocPct;
   setFundingImpact = setFundingImpact - 1;
ENDIF
"Cash Inflow from Funding" = fundingAmt * "Funding Allocator";
"Long Term Debt" = fundingAmt * "Funding Allocator";

/* Check if we should start depreciation */
IF ((numDeprPeriods == 0) AND ("TP-Date" == inServiceDate) OR (setStartDepr == 1)) OR
   (deprConvention == 4 AND "Fiscal TP-Index" == @INT("NumPeriods" / 2)+1) AND "TP-Date" > yearVal)
setStartDepr = 0;
periodOffset = 0;
pers1stYear = "NumPeriods"; /* not adjusted - "Cal TP-Index" + 1; */
numDeprPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in Years)";
totDeprPeriods = numDeprPeriods;

dayVal = "No Year"->"BegBalance"->"In Service Date" - inServiceDate;
monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000) * 10000;
delayStart = 0;
IF (deprConvention == 2) /* Prorate Actual Date */
   IF (dayVal == 1) /* Treat same as Begin Period */
      split1stAmt = 0;
   ELSE
      numDeprPeriods = numDeprPeriods + 1;
      split1stAmt = 1;
   ENDIF
ELSEIF (deprConvention == 3) /* Mid Period */
   numDeprPeriods = numDeprPeriods + 1;
   split1stAmt = 1;
ELSEIF (deprConvention == 4) /* MidYear */
   split1stAmt = 0;
   delayStart = @INT("NumPeriods" / 2) - "Fiscal TP-Index" +1;
ELSE /* Prorate Begin Period */
   split1stAmt = 0;
ENDIF

/* Declining balance methods */
IF (deprMethod == 3 OR deprMethod == 4)
   /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
   deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF
insuranceCost = insuranceCost / "NumPeriods";
maintenanceCost = maintenanceCost / "NumPeriods";
repairsCost = repairsCost / "NumPeriods";

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
numDeprPeriods = numDeprPeriods - preExistingPers;
IF (numDeprPeriods > 0)
    deprAmt = (basicCost - salvageVal) / totDeprPeriods;
    periodicPriorAccumDepr = deprAmt * preExistingPers;
ENDIF
ENDIF

IF (numDeprPeriods > 0)
    deprAmt = (basicCost - salvageVal) / totDeprPeriods;
    periodicPriorAccumDepr = deprAmt * preExistingPers;
    deprAmt = (basicCost - salvageVal) / totDeprPeriods;
    periodicPriorAccumDepr = deprAmt * preExistingPers;
ENDIF
ENDIF

/* Calculate Depreciation amounts */
IF (deprMethod > 0 AND periodOffset < numDeprPeriods AND delayStart < 1)
    lifeIndex = @INT(periodOffset / persInSection);
    IF (deprMethod == 1) /* Straight Line */
        deprAmt = (basicCost - salvageVal) / totDeprPeriods;
    ELSEIF (deprMethod == 3 or deprMethod == 4) /* Declining Balance */
        IF (lifeIndex == 0)
            /* cost * rate * month / 12; for 1st period */
            deprAmt = basicCost * deprRate * persIn1stYear / "NumPeriods" / persInSection;
        ELSE /* (cost - total depreciation from prior periods) * rate; for all middle periods */
            deprAmt = (basicCost - priorAccumDepr) * deprRate / persInSection;
        ENDIF
    ELSEIF (deprMethod == 2) /* Sum of Years Digits */
        deprRate = (life - lifeIndex) * 2 / (life * (life +1));
        deprAmt = (basicCost - salvageVal) * deprRate / persInSection;
    ENDIF
    IF (split1stAmt == 1)
        IF (deprConvention == 2)
            /* assume that there are 30 days in each month */
            deprAmt = deprAmt * @MAX(30 - dayVal, 1) / 30;
        ELSEIF (deprConvention == 4)
            ;
        ELSE
            deprAmt = deprAmt - deprAmt / 2;
        ENDIF
        split1stAmt = 0;
    ENDIF
    IF (periodOffset + 1 == numDeprPeriods)
        deprAmt = (basicCost - salvageVal) - periodicPriorAccumDepr;
    ENDIF
    periodicPriorAccumDepr = periodicPriorAccumDepr + deprAmt;
ENDIF

/* Use accumulated depr as first value for Mid-Year conversion */
IF (deprConvention == 4 AND "TP-Date" == inServiceDate AND monthVal > 600)
    deprAmt = periodicPriorAccumDepr;
ENDIF

IF (isAnnual == 1)
    IF (@INT((periodOffset + 1) / persInSection) == (lifeIndex + 1))
        priorAccumDepr = periodicPriorAccumDepr;
    ENDIF
ENDIF
ENDIF
ELSE
    priorAccumDepr = periodicPriorAccumDepr;
ENDIF

/* Only assign values to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
    "Property, Plant and Equipment Gross" = basicCost;
    "Depreciation" = deprAmt;
    "Accumulated Depreciation" = periodicPriorAccumDepr;
    "Insurance" = insuranceCost;
    "Maintenance" = maintenanceCost;
    "Repairs" = repairsCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
    IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR "No Year"->"BegBalance"->"Reason Ended" == 3)
        netValue = basicCost - priorAccumDepr + retirementCosts;
        IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
            "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue - saleValue + deprAmt;
        ELSE
            "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue + deprAmt;
        ENDIF
        "Retirement Expenses" = retirementCosts - retirementObs;
        "Proceeds from Sale of Property, Plant and Equipment" = saleValue - retirementCosts;
    ENDIF
    periodOffset = periodOffset +1;
ENDIF
    delayStart = delayStart -1;
ENDIF

ENDIF
);
ENDFIX
ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [Department])
    CALC DIM ("Period");
    @IANCESTORS("Line Item 1");
    @ANCESTORS([AssetClass]);
ENDFIX

AddExistAsset

Description

Adds an existing asset.
**Formula**

```
SET CREATENONMISSINGBLK ON;

VAR periodOffset = 0;
VAR deprMethod = 0;
VAR deprRate = 0;
VAR deprConvention = 0;
VAR numDeprPeriods = 0;
VAR totDeprPeriods = 0;
VAR persIn1stYear = 12;
VAR priorAccumDepr = 0;
VAR periodicPriorAccumDepr = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR deprAmt = 0;
VAR persInSection = 0;
VAR life = 0;
VAR lifeIndex = 0;
VAR isAnnual = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR retirementCosts = 0;
VAR retirementObs = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR repairsCost = 0;
VAR cashOutflowDate = 0;
VAR fundingDate = 0;
VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR fundingAmt = 0;
VAR setCashImpact = 0;
VAR setFundingImpact = 0;
VAR paramsSet = 0;
VAR netValue;
VAR saleValue;
VAR yearVal;
VAR monthVal;
VAR dayVal;
VAR delayStart;
VAR split1stAmt;
VAR numAsset = [NumAsset];
VAR preExistingPers = 0;
VAR setStartDepr = 0;
```

FIX(@CHILDREN("Base SPs"), [Hidden_Scenario], [Hidden_Version], [Department], [AssetClass])

/* Setup properties for new Asset */
FIX("No Year", "BegBalance")
"Asset Description" ( 

IF (numAsset > 0 AND @MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING )
  numAsset = numAsset - 1;
  /* Indicate that we have a new asset */
  "Asset Description" = [AssetDesc];
  "Asset Units" = [AssetUnits];
  "Asset Rate" = [AssetRate];
  "Installation" = [Installation];
  "Freight" = [Freight];
  "Salvage Input" = [SalvageValue];
  "Salvage" = [SalvageValue] * "Asset Units";
  "Taxes %" = [TaxesPct];
  "Additional Charges" = [AdditionalCharges];
  "Retirement Obligation" = [RetirementObs];
  "Physical Location" = [PhyLocation];
  "Basic Cost" = "Asset Units" * "Asset Rate" + ("Asset Units" * "Asset Rate" * "Taxes %") + "Freight" + "Additional Charges" + "Retirement Obligation" + "Installation";
  "Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
  "Purchase Date" = [PurchaseDate];
  "In Service Date" = [InserviceDate];

  IF ("In Service Date" < "Purchase Date")
    "In Service Date" = "Purchase Date";

ENDIF
); 
ENDFIX

/* Calculate depreciation section */
FIX (@LEVMBRS("Period", 0), @LEVMBRS("Year", 0))
"Depreciation"(

/* Only process newly added asset line items */
IF ("No Year"->"BegBalance"->"Asset Status" == 0)

IF (@ISMBR("BegBalance") AND paramsSet == 0)
  paramsSet = 1;

  /* Initialized all the variables required to calculate depreciation */
  /* eliminate days from date */
  delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
  prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
  purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
  inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;

  /* Initialize for depreciation calc in next section */
  basicCost = "No Year"->"Basic Cost";
  salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
  saleValue = "No Year"->"Sale Value";
  retirementCosts = "No Year"->"Retirement Costs";
  retirementObs = "No Year"->"Retirement Obligation";

  deprMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Method";
  deprConvention = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Convention";

ENDFIX

82 Capital Expense Planning Structure
"Depreciation Convention";
insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";
repairsCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Repairs %";
fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding %";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
  yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
  monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
  IF (monthVal < 0)
    IF (yearVal > 0)
      yearVal = yearVal - 1;
    ENDIF
    monthVal = 1200 + monthVal;
  ENDIF
  preExistingPers = yearVal * 12 + monthVal / 100;
  setStartDepr = 1;
ELSE
  preExistingPers = 0;
  setStartDepr = 0;
ENDIF

/* setup for depreciation */
umDeprPeriods = 0;
periodOffset = 0;

IF (deprMethod > 0)
priorAccumDepr = 0;
periodicPriorAccumDepr = 0;
deprAmt = 0;

/* Add a periodic vs annual property instead of additional deprMethods */
/* Annual Methods SumYearDigits = 2, DecliningBalance Year = 3*/
IF (deprMethod == 2 OR deprMethod == 3)
isAnnual = 1;
  life = "No Year"->"Useful Life (in Years)";
  persInSection = "NumPeriods";
ELSE /* Periodic Methods */
  isAnnual = 0;
  life = "No Year"->"Useful Life (in Years)" * "NumPeriods";
  persInSection = 1;
ENDIF

yearVal = @INT(inServiceDate / 10000) * 10000;

/* DecliningBalance methods */
IF (deprMethod == 3 OR deprMethod == 4)
  /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
  deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
/* Reset depr method to SLN convention to prorate 1st period for preExisting assets */
IF (preExistingPers > 0)
  deprMethod = 1;
deprConvention = 1;
ENDIF

/*/ Set Asset Status to active when we hit the end */
IF (@ISMBR("No Year") AND @ISMBR("BegBalance"))
  paramsSet = 0;
  IF ("Asset Status" == 0)
    "Asset Status" = 1;
  ENDIF
ENDIF

/*/ Start depreciation calculations */
IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
  /* clear out any previously calculated values */
  "Depreciation" = #MISSING;
  "Accumulated Depreciation" = #MISSING;
  "Property, Plant and Equipment Gross" = #MISSING;
  "Loss/(Gain) on Sale of Property, Plant and Equipment" = #MISSING;
  "Proceeds from Sale of Property, Plant and Equipment" = #MISSING;
  "Cash Flow Allocator" = #MISSING;
  "Funding Allocator" = #MISSING;
  "Cash Outflow from Capital Additions" = #MISSING;
  "Cash Inflow from Funding" = #MISSING;
  "Long Term Debt" = #MISSING;
  "Insurance" = #MISSING;
  "Maintenance" = #MISSING;
  "Repairs" = #MISSING;
  "Retirement Expenses" = #MISSING;
  "Capital Expenditure" = #MISSING;

  /* Commented out for now need to verify */
  IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    "Capital Expenditure" = basicCost - retirementObs;
  ENDIF
  /* Check if we should start depreciation */
  IF ((numDeprPeriods == 0) AND (("TP-Date" == inServiceDate) OR (setStartDepr == 1)) OR (deprConvention == 4 AND "Fiscal TP-Index" == @INT("NumPeriods" / 2)+1) AND "TP-Date" > yearVal))
    setStartDepr = 0;
    periodOffset = 0;
    persIn1stYear = "NumPeriods"; /* not adjusted - "Cal TP-Index" + 1 */
numDeprPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in Years)";
totDeprPeriods = numDeprPeriods;

dayVal = "No Year"->"BegBalance"->"In Service Date" - inServiceDate;
monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);

delayStart = 0;
IF (deprConvention == 2) /* Prorate Actual Date */
   IF (dayVal == 1) /* Treat same as Begin Period */
      split1stAmt = 0;
   ELSE
      numDeprPeriods = numDeprPeriods + 1;
      split1stAmt = 1;
   ENDIF
ELSEIF (deprConvention == 3) /* Mid Period */
   numDeprPeriods = numDeprPeriods + 1;
   split1stAmt = 1;
ELSEIF (deprConvention == 4) /* MidYear */
   split1stAmt = 0;
   delayStart = @INT("NumPeriods" / 2) - "Fiscal TP-Index" +1;
ELSE /* Prorate Begin Period */
   split1stAmt = 0;
ENDIF

/* Declining balance methods */
IF (deprMethod == 3 OR deprMethod == 4)
   /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
   deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

insuranceCost = insuranceCost / "NumPeriods";
maintenanceCost = maintenanceCost / "NumPeriods";
repairsCost = repairsCost / "NumPeriods";

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
   numDeprPeriods = numDeprPeriods - preExistingPers;
   IF (numDeprPeriods > 0)
      deprAmt = (basicCost - salvageVal) / totDeprPeriods;
      periodicPriorAccumDepr = deprAmt * preExistingPers;
   ENDIF
ENDIF

/* Calculate Depreciation amounts */
IF (deprMethod > 0 AND periodOffset < numDeprPeriods AND delayStart < 1)
   lifeIndex = @INT(periodOffset / persInSection);
   IF (deprMethod == 1) /* Straight Line */
      deprAmt = (basicCost - salvageVal) / totDeprPeriods;
   ELSEIF (deprMethod == 3 or deprMethod == 4) /* Declining Balance */
      IF (lifeIndex == 0)
         /* cost * rate * month / 12; for 1st period */
         deprAmt = basicCost * deprRate * persIn1stYear /
"NumPeriods" / persInSection;
ELSE /* (cost - total depreciation from prior periods) * rate; for all middle periods */
    deprAmt = (basicCost - priorAccumDepr) * deprRate / persInSection;
ENDIF
ELSEIF (deprMethod == 2) /* Sum of Years Digits */
    deprRate = (life - lifeIndex) * 2 / (life * (life +1));
    deprAmt = (basicCost - salvageVal) * deprRate / persInSection;
ENDIF

IF (split1stAmt == 1)
    IF (deprConvention == 2)
        /* assume that there are 30 days in each month */
        deprAmt = deprAmt * @MAX(30 - dayVal, 1) / 30;
    ELSEIF (deprConvention == 4);
    ELSE
        deprAmt = deprAmt - deprAmt / 2;
    ENDIF
    split1stAmt = 0;
ENDIF

/* Adjust for rounding errors */
IF (periodOffset + 1 == numDeprPeriods)
    deprAmt = (basicCost - salvageVal) - periodicPriorAccumDepr;
ENDIF

periodicPriorAccumDepr = periodicPriorAccumDepr + deprAmt;

/* Use accumulated depr as first value for Mid-Year conversion */
IF (deprConvention == 4 AND "TP-Date" == inServiceDate AND monthVal > 600)
    deprAmt = periodicPriorAccumDepr;
ENDIF

IF (isAnnual == 1)
    IF (@INT((periodOffset + 1) / persInSection) == (lifeIndex + 1))
        priorAccumDepr = periodicPriorAccumDepr;
    ENDIF
ELSE
    priorAccumDepr = periodicPriorAccumDepr;
ENDIF

/* Only assign values to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
    "Property, Plant and Equipment Gross" = basicCost;
    "Depreciation" = deprAmt;
    "Accumulated Depreciation" = periodicPriorAccumDepr;
    "Insurance" = insuranceCost;
    "Maintenance" = maintenanceCost;
    "Repairs" = repairsCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
    IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR
"No Year"->"BegBalance"->"Reason Ended" == 3) 
netValue = basicCost - priorAccumDepr + retirementCosts; 
IF ("No Year"->"BegBalance"->"Reason Ended" == 3) 
   "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue - 
   saleValue + deprAmt; 
ELSE 
   "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue + 
   deprAmt; 
ENDIF 
"Retirement Expenses" = retirementCosts - retirementObs; 
"Proceeds from Sale of Property, Plant and Equipment" = saleValue - 
retirementCosts; 
ENDIF 
ENDIF 
periodOffset = periodOffset +1; 
ENDIF 
delayStart = delayStart -1; 
ENDIF 
ENDIF 
ENDIF 
);
ENDFIX 
ENDFIX 
ENDFIX 

FIX([Hidden_Scenario], [Hidden_Version], [Department]) 
   CALC DIM ("Period"); 
   @IANCESTORS("Line Item 1"); 
   @ANCESTORS([AssetClass]);
ENDFIX 

AddExistIntangible 
Description 
Adds an existing intangible asset. 
Formula 

SET CREATEONMISSINGBLK ON;

VAR numAsset = [NumAsset]; 
VAR periodOffset = 0; 
VAR amortMethod = 0; 
VAR amortRate = 0; 
VAR numAmortPeriods = 0; 
VAR priorAccumAmort = 0; 
VAR basicCost = 0; 
VAR salvageVal = 0; 
VAR amortAmt = 0; 
VAR retirementCosts = 0; 
VAR retirementObs = 0; 
VAR impairmentDate1 = 0; 
VAR impairmentDate2 = 0; 
VAR impairmentFairVal1 = 0; 
VAR impairmentFairVal2 = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR purchaseDate = 0;
VAR capitalizePct = 0;
VAR impairmentOpt = 1;
VAR numRemainingPers;
VAR intangibleNet;
VAR netValue;
VAR saleValue;
VAR yearVal;
VAR monthVal;
VAR paramsSet = 0;
VAR preExistingPers = 0;
VAR setStartAmort = 0;

FIX(@CHILDREN("Base SPs"), [Hidden_Scenario], [Hidden_Version], [Department], [AssetClassInt])

/* Find a new asset line item */
FIX("No Year", "BegBalance")
"Asset Description" (  
IF (numAsset > 0 AND @MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING )  
numAsset = numAsset - 1;  
"Asset Status" = 0;  /* Indicate that we have a new asset */  
"Asset Description" = [AssetDesc];  
"Acquisition Costs" = [AcquisitionCost];  
"Additional Charges" = [AdditionalCharges];  
"Asset Units" = 1;  
"Salvage Input" = [SalvageValue];  
"Salvage" = [SalvageValue] * "Asset Units";  
"Asset Rate" = "Acquisition Costs" + "Additional Charges";  
"Basic Cost" = "Acquisition Costs" + "Additional Charges";  
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";  
"Purchase Date" = [PurchaseDate];  
"In Service Date" = [InserviceDate];
  
IF ("In Service Date" < "Purchase Date")  
"In Service Date" = "Purchase Date";
ENDIF
ENDFIX

/* Amortization section */
FIX (@LEVMBRS("Period", 0) @LEVMBRS("Year", 0))
"Amortization" (  
/* Only calc valid asset line items */
IF ("No Year"->"BegBalance"->"Asset Status" >= 0)
IF (@ISMBR("BegBalance") AND paramsSet == 0)
/* Initialized all the variables required to calculate depreciation */
paramsSet = 1;
/* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;

/* Initialize for amortization calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
impairmentOpt = "No Year"->"Impairment Option";
capitalizePct = "No Year"->"Partial Capitalize %";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

amortMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Amortization Method";

insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";

IF ("No Year"->"Impairment Date1" <> #MISSING)
    impairmentDate1 = @INT("No Year"->"Impairment Date1" / 100) * 100;
ELSE
    impairmentDate1 = #MISSING;
ENDIF
IF ("No Year"->"Impairment Date2" <> #MISSING)
    impairmentDate2 = @INT("No Year"->"Impairment Date2" / 100) * 100;
ELSE
    impairmentDate2 = #MISSING;
ENDIF

impairmentFairVal1 = "No Year"->"Impairment Fair Value1";
impairmentFairVal2 = "No Year"->"Impairment Fair Value2";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
    yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
    monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
    IF (monthVal < 0)
        IF (yearVal > 0)
            yearVal = yearVal - 1;
        ENDIF
        monthVal = 1200 + monthVal;
   ENDIF
    preExistingPers = @ROUND(yearVal * 12 + monthVal / 100, 0);
    setStartAmort = 1;
ELSE
    preExistingPers = 0;
    setStartAmort = 0;
ENDIF
numAmortPeriods = 0;
periodOffset = 0;

IF (amortMethod == 1)
    priorAccumAmort = 0;
    amortAmt = 0;
    yearVal = @INT(inServiceDate / 10000) * 10000;
    monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);
ENDIF
ENDIF

IF (@ISMBR("No Year") AND @ISMBR("BegBalance"))
    paramsSet = 0;
    IF ("Asset Status" == 0)
        "Asset Status" = 1;
   ENDIF
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
    /* clear out any previously calculated values */
    "Amortization" = #MISSING;
    "Accumulated Amortization" = #MISSING;
    "Intangible Assets Finite, Gross" = #MISSING;
    "Loss/(Gain) on Sale of Intangibles" = #MISSING;
    "Proceeds from Sale of Intangibles" = #MISSING;
    "Cash Flow Allocator" = #MISSING;
    "Funding Allocator" = #MISSING;
    "Cash Outflow from Capital Additions" = #MISSING;
    "Cash Inflow from Funding" = #MISSING;
    "Long Term Debt" = #MISSING;
    "Insurance" = #MISSING;
    "Maintenance" = #MISSING;
    "Impairment of Assets" = #MISSING;
    "Retirement Expenses" = #MISSING;
    "Capital Reserve" = #MISSING;
    "Capital Expenditure" = #MISSING;

    /* Commented out for now need to verify
    IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate
    > #MISSING AND "TP-Date" > delayedStartDate)))
        "Capital Expenditure" = basicCost - retirementObs;
    ENDIF
    */
    /* Check if we should start amortization */
    IF ("TP-Date" == inServiceDate OR (setStartAmort == 1))
        setStartAmort = 0;
        periodOffset = 0;
        numAmortPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in
Years)";
        insuranceCost = insuranceCost / "NumPeriods";
        maintenanceCost = maintenanceCost / "NumPeriods";
        intangibleNet = basicCost;
amortAmt = (basicCost - salvageVal) / numAmortPeriods;

/* Adjust for pre-existing assets */
IF (preExistingPers > 0)
    numAmortPeriods = numAmortPeriods - preExistingPers;
    IF (numAmortPeriods > 0)
        priorAccumAmort = amortAmt * preExistingPers;
    ENDIF
ENDIF

numRemainingPers = numAmortPeriods;
ENDIF

/* Amortization calculation section */
IF (amortMethod == 1 AND periodOffset < numAmortPeriods)

/* If capitalized book in Capital Reserve instead of Impairment */
IF ("TP-Date" == impairmentDate1)
    IF (impairmentOpt == 1)
        "Impairment of Assets" = intangibleNet - impairmentFairVal1;
    ELSEIF (impairmentOpt == 2)
        "Capital Reserve" = intangibleNet - impairmentFairVal1;
    ELSEIF (impairmentOpt == 3)
        "Capital Reserve" = (intangibleNet - impairmentFairVal1) * capitalizePct;
    ELSEIF ("TP-Date" == impairmentDate2)
        IF (impairmentOpt == 1)
            "Impairment of Assets" = intangibleNet - impairmentFairVal2;
        ELSEIF (impairmentOpt == 2)
            "Capital Reserve" = intangibleNet - impairmentFairVal2;
        ELSEIF (impairmentOpt == 3)
            "Capital Reserve" = (intangibleNet - impairmentFairVal2) * capitalizePct;
    ENDIF
    basicCost = basicCost - (intangibleNet - impairmentFairVal1);
    amortAmt = impairmentFairVal1 / numRemainingPers;
ELSEIF ("TP-Date" == impairmentDate2)
    IF (impairmentOpt == 1)
        "Impairment of Assets" = intangibleNet - impairmentFairVal2;
    ELSEIF (impairmentOpt == 2)
        "Capital Reserve" = intangibleNet - impairmentFairVal2;
    ELSEIF (impairmentOpt == 3)
        "Capital Reserve" = (intangibleNet - impairmentFairVal2) * capitalizePct;
    ELSEIF ("TP-Date" == impairmentDate2)
        IF (impairmentOpt == 1)
            "Impairment of Assets" = intangibleNet - impairmentFairVal2;
        ELSEIF (impairmentOpt == 2)
            "Capital Reserve" = intangibleNet - impairmentFairVal2;
        ELSEIF (impairmentOpt == 3)
            "Capital Reserve" = (intangibleNet - impairmentFairVal2) * capitalizePct;
    ENDIF
    basicCost = basicCost - (intangibleNet - impairmentFairVal2);
    amortAmt = impairmentFairVal2 / numRemainingPers;
ENDIF

IF (periodOffset + 1 == numAmortPeriods)
    amortAmt = (basicCost - salvageVal) - priorAccumAmort;
ENDIF

priorAccumAmort = priorAccumAmort + amortAmt;
intangibleNet = basicCost - priorAccumAmort;

/* Only assign values to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
    "Intangible Assets Finite, Gross" = basicCost;
"Amortization" = amortAmt;
"Accumulated Amortization" = priorAccumAmort;
"Insurance" = insuranceCost;
"Maintenance" = maintenanceCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
  IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR
      "No Year"->"BegBalance"->"Reason Ended" == 3)
    netValue = basicCost - priorAccumAmort + retirementCosts;
    IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
      "Loss/(Gain) on Sale of Intangibles" = netValue - saleValue +
        amortAmt;
    ELSE
      "Loss/(Gain) on Sale of Intangibles" = netValue - amortAmt;
    ENDIF
    "Retirement Expenses" = retirementCosts - retirementObs;
    "Proceeds from Sale of Intangibles" = saleValue - retirementCosts;
  ENDIF
ENDIF
periodOffset = periodOffset +1;
numRemainingPers = numRemainingPers -1;
ENDIF
ENDIF
ENDIF

FIX([Hidden_Scenario], [Hidden_Version], [Department])
  @IANCESTORS("Line Item 1");
  @ANCESTORS([AssetClassInt]);
ENDIF

Add Intangible

Description
Adds a new intangible asset.

Formula

SET CREATENONMISSINGBLK ON;

VAR numAsset = [NumAsset];
VAR periodOffset = 0;
VAR amortMethod = 0;
VAR amortRate = 0;
VAR numAmortPeriods = 0;
VAR priorAccumAmort = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR amortAmt = 0;
VAR retirementCosts = 0;
VAR retirementObs = 0;
VAR impairmentDate1 = 0;
VAR impairmentDate2 = 0;
VAR impairmentFairVal1 = 0;
VAR impairmentFairVal2 = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR cashOutflowDate = 0;
VAR fundingDate = 0;
VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR cashFlowChange = 0;
VAR cashflowChanged = 0;
VAR fundingChange = 0;
VAR setStartAmort = 0;
VAR paramsSet = 0;
VAR cashflowChanged = 0;
VAR fundingChanged = 0;
VAR preExistingPers = 0;
VAR setStartAmort = 0;

FIX(@CHILDREN("Total New"), [Hidden_Scenario], [Hidden_Version], [Department], [AssetClassInt])

/* Find a new asset line item */
FIX("No Year", "BegBalance")
"Asset Description" {
IF (numAsset > 0 AND @MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING )
    numAsset = numAsset - 1;
"Asset Status" = 0;  /* Indicate that we have a new asset */
"Asset Description" = [AssetDesc];
"CAR No." = [AssetCAR];
"Justification" = [Justification];
"Acquisition Costs" = [AcquisitionCost];
"Additional Charges" = [AdditionalCharges];
"Asset Units" = 1;
"Salvage Input" = [SalvageValue];
"Salvage" = [SalvageValue] * "Asset Units";
"Asset Rate" = "Acquisition Costs" + "Additional Charges";
"Basic Cost" = "Acquisition Costs" + "Additional Charges";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->
"Useful Life (in Years)";
"Cash Flow Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->
"Global"->"Cash Flow Incidence";
"Funding Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->
"Global"->"Funding Incidence";
"Purchase Date" = [PurchaseDate];
"In Service Date" = [InserviceDate];

IF ("In Service Date" < "Purchase Date")
  "In Service Date" = "Purchase Date";
ENDIF

ENDFIX

/* Amortization section */
FIX (@LEVMBRS("Period", 0) @LEVMBRS("Year", 0))
"Amortization"(
/* Only calc valid asset line items */
IF ("No Year"->"BegBalance"->"Asset Status" >= 0)

IF (@ISMBR("BegBalance") AND paramsSet == 0)
  /* Initialized all the variables required to calculate depreciation */
  paramsSet = 1;
/* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
cashOutflowDate = purchaseDate;
fundingDate = purchaseDate;
cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->
"Global"->
"Cash Flow Incidence";

IF (cashFlowIncidence == -1)
cashStaggeredPers = 4;
ELSE
  /* Extract year and month from date to adjust based in incidence values in
global assumptions */
  yearVal = @INT(cashOutflowDate / 10000) * 10000;
  monthVal = cashOutflowDate - yearVal;
  monthVal = monthVal + cashFlowIncidence;
  IF (monthVal <= 0)
    yearVal = yearVal - 10000;
    monthVal = 1200 + monthVal;
  ELSEIF (monthVal > 1200)
    yearVal = yearVal + 10000;
    monthVal = monthVal - 1200;
  ENDIF

ENDFIX
cashOutflowDate = yearVal + monthVal;
cashStaggeredPers = 1;
ENDIF

fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";

IF (fundingIncidence == -1)
    fundingStaggeredPers = 4;
ELSE
    yearVal = @INT(fundingDate / 10000) * 10000;
    monthVal = fundingDate - yearVal;
    monthVal = monthVal + fundingIncidence;
    IF (monthVal <= 0)
        yearVal = yearVal - 10000;
        monthVal = 1200 + monthVal;
    ELSEIF (monthVal > 1200)
        yearVal = yearVal + 10000;
        monthVal = monthVal - 1200;
    ENDIF
    fundingDate = yearVal + monthVal;
    fundingStaggeredPers = 1;
ENDIF

/* Initialize for amortization calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
impairmentOpt = "No Year"->"Impairment Option";
capitalizePct = "No Year"->"Partial Capitalize %";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

amortMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Amortization Method";

insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";

fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding %";

IF ("No Year"->"Impairment Date1" <> #MISSING)
    impairmentDate1 = @INT("No Year"->"Impairment Date1" / 100) * 100;
ELSE
    impairmentDate1 = #MISSING;
ENDIF

IF ("No Year"->"Impairment Date2" <> #MISSING)
    impairmentDate2 = @INT("No Year"->"Impairment Date2" / 100) * 100;
ELSE
    impairmentDate2 = #MISSING;
ENDIF
imperiaimentFairVal1 = "No Year"->"Impairment Fair Value1";
imperiaimentFairVal2 = "No Year"->"Impairment Fair Value2";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
  yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
  monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
  IF (monthVal < 0)
    IF (yearVal > 0)
      yearVal = yearVal - 1;
    ENDIF
    monthVal = 1200 + monthVal;
  ENDF
  preExistingPers = @ROUND(yearVal * 12 + monthVal / 100, 0);
ELSE
  preExistingPers = 0;
ENDIF

numAmortPeriods = 0;
periodOffset = 0;

IF (amortMethod == 1)
  priorAccumAmort = 0;
  amortAmt = 0;
  setCashImpact = 0;
  setFundingImpact = 0;
  yearVal = @INT(inServiceDate / 10000) * 10000;
  monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);
ENDIF
ENDIF

IF (@ISMBR("No Year") AND @ISMBR("BegBalance"))
  paramsSet = 0;
  IF ("Asset Status" == 0)
    "Asset Status" = 1;
  ENDF
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
  /* clear out any previously calculated values */
  "Amortization" = #MISSING;
  "Accumulated Amortization" = #MISSING;
  "Intangible Assets Finite, Gross" = #MISSING;
  "Loss/(Gain) on Sale of Intangibles" = #MISSING;
  "Proceeds from Sale of Intangibles" = #MISSING;
  "Cash Flow Allocator" = #MISSING;
  "Funding Allocator" = #MISSING;
  "Cash Outflow from Capital Additions" = #MISSING;
  "Cash Inflow from Funding" = #MISSING;
  "Long Term Debt" = #MISSING;
"Insurance" = #MISSING;
"Maintenance" = #MISSING;
"Impairment of Assets" = #MISSING;
"Retirement Expenses" = #MISSING;
"Capital Reserve" = #MISSING;
"Capital Expenditure" = #MISSING;

IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    "Capital Expenditure" = basicCost - retirementObs;
ENDIF

IF ("TP-Date" == cashOutflowDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    setCashImpact = cashStaggeredPers;
    cashAllocPct = 1 / cashStaggeredPers;
ENDIF

IF ("TP-Date" == fundingDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    setFundingImpact = fundingStaggeredPers;
    fundingAllocPct = 1 / fundingStaggeredPers;
ENDIF

IF (setCashImpact > 0)
    "Cash Flow Allocator" = cashAllocPct;
    "Cash Outflow from Capital Additions" = basicCost * cashAllocPct;
    setCashImpact = setCashImpact - 1;
ENDIF

IF (setFundingImpact > 0)
    "Funding Allocator" = fundingAllocPct;
    "Cash Inflow from Funding" = fundingAmt * fundingAllocPct;
    "Long Term Debt" = fundingAmt * fundingAllocPct;
    setFundingImpact = setFundingImpact - 1;
ENDIF

/* Check if we should start amortization */
IF ("TP-Date" == inServiceDate OR (setStartAmort == 1))
    setStartAmort = 0;
    periodOffset = 0;
    numAmortPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in Years)";
    insuranceCost = insuranceCost / "NumPeriods";
    maintenanceCost = maintenanceCost / "NumPeriods";
    intangibleNet = basicCost;
    amortAmt = (basicCost - salvageVal) / numAmortPeriods;

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
    numAmortPeriods = numAmortPeriods - preExistingPers;
    IF (numAmortPeriods > 0)
        priorAccumAmort = amortAmt * preExistingPers;
    ENDIF
ENDIF

numRemainingPers = numAmortPeriods;
ENDIF

/* Amortization calculation section */
 IF (amortMethod == 1 AND periodOffset < numAmortPeriods) 

 /* If capitalized book in Capital Reserve instead of Impairment */
 IF ("TP-Date" == impairmentDate1)
     IF (impairmentOpt == 1)
         "Impairment of Assets" = intangibleNet - impairmentFairVal1;
     ELSEIF (impairmentOpt == 2)
         "Capital Reserve" = intangibleNet - impairmentFairVal1;
     ELSEIF (impairmentOpt == 3)
         "Capital Reserve" = (intangibleNet - impairmentFairVal1) * capitalizePct;
     "Impairment of Assets" = intangibleNet - impairmentFairVal1 - "Capital Reserve";
 ENDIF
 basicCost = basicCost - (intangibleNet - impairmentFairVal1);
 amortAmt = impairmentFairVal1 / numRemainingPers;
 ELSEIF ("TP-Date" == impairmentDate2)
     IF (impairmentOpt == 1)
         "Impairment of Assets" = intangibleNet - impairmentFairVal2;
     ELSEIF (impairmentOpt == 2)
         "Capital Reserve" = intangibleNet - impairmentFairVal2;
     ELSEIF (impairmentOpt == 3)
         "Capital Reserve" = (intangibleNet - impairmentFairVal2) * capitalizePct;
     "Impairment of Assets" = intangibleNet - impairmentFairVal2 - "Capital Reserve";
 ENDIF
 basicCost = basicCost - (intangibleNet - impairmentFairVal2);
 amortAmt = impairmentFairVal2 / numRemainingPers;
 ENDIF

 IF (periodOffset + 1 == numAmortPeriods)
     amortAmt = (basicCost - salvageVal) - priorAccumAmort;
 ENDIF
 priorAccumAmort = priorAccumAmort + amortAmt;
 intangibleNet = basicCost - priorAccumAmort;

 /* Only assign values to member if we are in range */
 IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
     "Intangible Assets Finite, Gross" = basicCost;
     "Amortization" = amortAmt;
     "Accumulated Amortization" = priorAccumAmort;
     "Insurance" = insuranceCost;
     "Maintenance" = maintenanceCost;
 ENDIF

 /* Set the loss/gain if we had a sale or writeoff */
 IF ("TP-Date" == prematureEndDate)
    IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR "No Year"->"BegBalance"->"Reason Ended" == 3)
       netValue = basicCost - priorAccumAmort + retirementCosts;
 ENDIF
IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
    "Loss/(Gain) on Sale of Intangibles" = netValue - saleValue + amortAmt;
ELSE
    "Loss/(Gain) on Sale of Intangibles" = netValue + amortAmt;
ENDIF
"Retirement Expenses" = retirementCosts - retirementObs;
"Proceeds from Sale of Intangibles" = saleValue - retirementCosts;
ENDIF
ENDIF

periodOffset = periodOffset + 1;
numRemainingPers = numRemainingPers -1;
ENDIF
ENDIF
ENDIF
);
ENDFIX
ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [Department])
    @IANCESTORS("Line Item 1");
    @ANCESTORS([AssetClassInt]);
ENDFIX

**CalcAmort**

**Description**

Calculates amortization.

**Formula**

```
SET CREATENONMISSINGBLK ON;

VAR periodOffset = 0;
VAR amortMethod = 0;
VAR numAmortPeriods = 0;
VAR priorAccumAmort = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR amortAmt = 0;
VAR retirementCosts = 0;
VAR retirementObs = 0;
VAR impairmentDate1 = 0;
VAR impairmentDate2 = 0;
VAR impairmentFairVal1 = 0;
VAR impairmentFairVal2 = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR cashOutflowDate = 0;
VAR fundingDate = 0;
```
VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR fundingAmt = 0;
VAR setCashImpact = 0;
VAR setFundingImpact = 0;
VAR capitalizePct = 0;
VAR impairmentOpt = 1;
VAR numRemainingPers;
VAR intangibleNet;
VAR netValue;
VAR saleValue;
VAR yearVal;
VAR monthVal;
VAR paramsSet = 0;
VAR cashflowChanged = 0;
VAR fundingChanged = 0;
VAR preExistingPers = 0;
VAR setStartAmort = 0;

FIX([Hidden_Scenario], [Hidden_Version], [Department], [AssetClassInt])

FIX ("BegBalance", "No Year")
"Basic Cost" (  
IF ("Asset Status" > 0)  
IF ("In Service Date" < "Purchase Date")  
"In Service Date" = "Purchase Date";  
ENDIF  
"Basic Cost" = "Acquisition Costs" + "Additional Charges";  
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";  
"Salvage" = "Salvage Input" * "Asset Units";  
ENDIF
)
ENDFIX

FIX (@LEVMBRS("Period", 0) @LEVMBRS("Year", 0))
"Amortization"(
/* Only calc valid asset line items */
IF ("No Year"->"BegBalance"->"Asset Status" >= 0)
  IF (@ISMBR("BegBalance") AND paramsSet == 0)  
    /* Initialized all the variables required to calculate depreciation */
    paramsSet = 1;
    /* eliminate days from date */
    delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
    prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
    purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
    inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
  
  /* Calc amort. for valid item */
  IF (@ISMBR("BegBalance") AND paramsSet != 0)  
    IF (@ISMBR("BegBalance") AND paramsSet == 0)  
      /* Initialized all the variables required to calculate depreciation */
      paramsSet = 1;
      /* eliminate days from date */
      delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
      prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
      purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
      inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
      
      /* Calc amort. for valid item */
  ENDIF
  
ENDFX
cashOutflowDate = purchaseDate;
fundingDate = purchaseDate;

cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";

IF (cashFlowIncidence <> "No Year"->"Cash Flow Incidence")
cashflowChanged = 1;
ELSE
  cashflowChanged = 0;
ENDIF

IF (cashFlowIncidence == -1 AND cashflowChanged == 1)
cashStaggeredPers = 4;
ELSE /* Extract year and month from date to adjust based in incidence values in global assumptions */
  yearVal = @INT(cashOutflowDate / 10000) * 10000;
  monthVal = cashOutflowDate - yearVal;
  monthVal = monthVal + cashFlowIncidence;

  IF (monthVal <= 0)
    yearVal = yearVal - 10000;
    monthVal = 1200 + monthVal;
  ELSEIF (monthVal > 1200)
    yearVal = yearVal + 10000;
    monthVal = monthVal - 1200;
  ENDIF

cashOutflowDate = yearVal + monthVal;
cashStaggeredPers = 1;
ENDIF

fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";

IF (fundingIncidence <> "No Year"->"Funding Incidence")
fundingChanged = 1;
ELSE
  fundingChanged = 0;
ENDIF

IF (fundingIncidence == -1 AND fundingChanged == 1)
fundingStaggeredPers = 4;
ELSE
  yearVal = @INT(fundingDate / 10000) * 10000;
  monthVal = fundingDate - yearVal;
  monthVal = monthVal + fundingIncidence;

  IF (monthVal <= 0)
    yearVal = yearVal - 10000;
    monthVal = 1200 + monthVal;
  ELSEIF (monthVal > 1200)
    yearVal = yearVal + 10000;
    monthVal = monthVal - 1200;
  ENDIF

ENDIF
fundingDate = yearVal + monthVal;
fundingStaggeredPers = 1;

ENDIF

/* Initialize for amortization calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
impairmentOpt = "No Year"->"Impairment Option";
capitalizePct = "No Year"->"Partial Capitalize %";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

amortMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Amortization Method";

insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";

fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding %";

IF ("No Year"->"Impairment Date1" <> #MISSING)
    impairmentDate1 = @INT("No Year"->"Impairment Date1" / 100) * 100;
ELSE
    impairmentDate1 = #MISSING;
ENDIF

IF ("No Year"->"Impairment Date2" <> #MISSING)
    impairmentDate2 = @INT("No Year"->"Impairment Date2" / 100) * 100;
ELSE
    impairmentDate2 = #MISSING;
ENDIF

impairmentFairVal1 = "No Year"->"Impairment Fair Value1";
impairmentFairVal2 = "No Year"->"Impairment Fair Value2";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
    yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
    monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
    IF (monthVal < 0)
        IF (yearVal > 0)
            yearVal = yearVal - 1;
        ENDIF
        monthVal = 1200 + monthVal;
    ENDIF
    preExistingPers = @ROUND(yearVal * 12 + monthVal / 100, 0);
    setStartAmort = 1;
ELSE
    preExistingPers = 0;
    setStartAmort = 0;
ENDIF
numAmortPeriods = 0;
periodOffset = 0;

IF (amortMethod == 1)
    priorAccumAmort = 0;
    amortAmt = 0;
    setCashImpact = 0;
    setFundingImpact = 0;
    yearVal = @INT(inServiceDate / 10000) * 10000;
    monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);
ENDIF

IF (@ISMBR("No Year"))
    paramsSet = 0;
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
/* clear out any previously calculated values */
"Amortization" = #MISSING;
"Accumulated Amortization" = #MISSING;
"Intangible Assets Finite, Gross" = #MISSING;
"Loss/(Gain) on Sale of Intangibles" = #MISSING;
"Proceeds from Sale of Intangibles" = #MISSING;

IF (cashFlowIncidence <> -1 OR cashflowChanged == 1)
    "Cash Flow Allocator" = #MISSING;
ENDIF

IF (fundingIncidence <> -1 OR fundingChanged == 1)
    "Funding Allocator" = #MISSING;
ENDIF

"Cash Outflow from Capital Additions" = #MISSING;
"Cash Inflow from Funding" = #MISSING;
"Long Term Debt" = #MISSING;
"Insurance" = #MISSING;
"Maintenance" = #MISSING;
"Impairment of Assets" = #MISSING;
"Retirement Expenses" = #MISSING;
"Capital Reserve" = #MISSING;
"Capital Expenditure" = #MISSING;
"Retirement Expenses" = #MISSING;

IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    "Capital Expenditure" = basicCost - retirementObs;
ENDIF

IF ("TP-Date" == cashOutflowDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    setCashImpact = cashStaggeredPers;
    cashAllocPct = 1 / cashStaggeredPers;
ENDIF

IF ("TP-Date" == fundingDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))

```
setFundingImpact = fundingStaggeredPers;
fundingAllocPct = 1 / fundingStaggeredPers;
ENDIF

IF (setCashImpact > 0)
  "Cash Flow Allocator" = cashAllocPct;
  setCashImpact = setCashImpact - 1;
ENDIF
"Cash Outflow from Capital Additions" = basicCost * "Cash Flow Allocator";

IF (setFundingImpact > 0)
  "Funding Allocator" = fundingAllocPct;
  setFundingImpact = setFundingImpact - 1;
ENDIF
"Cash Inflow from Funding" = fundingAmt * "Funding Allocator";
"Long Term Debt" = fundingAmt * "Funding Allocator";

/* Check if we should start amortization */
IF ("TP-Date" == inServiceDate) OR (setStartAmort == 1))
  setStartAmort = 0;
  periodOffset = 0;
  numAmortPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in Years)";
  insuranceCost = insuranceCost / "NumPeriods";
  maintenanceCost = maintenanceCost / "NumPeriods";
  intangibleNet = basicCost;
  amortAmnt = (basicCost - salvageVal) / numAmortPeriods;

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
  numAmortPeriods = numAmortPeriods - preExistingPers;
  IF (numAmortPeriods > 0)
    priorAccumAmort = amortAmnt * preExistingPers;
  ENDIF
ENDIF

numRemainingPers = numAmortPeriods;
ENDIF

/* Amortization calculation section */
IF (amortMethod == 1 AND periodOffset < numAmortPeriods)
  /* If capitalized book in Capital Reserve instead of Impairment */
  IF ("TP-Date" == impairmentDate1)
    IF (impairmentOpt == 1)
      "Impairment of Assets" = intangibleNet - impairmentFairVal1;
    ELSEIF (impairmentOpt == 2)
      "Capital Reserve" = intangibleNet - impairmentFairVal1;
    ELSEIF (impairmentOpt == 3)
      "Capital Reserve" = (intangibleNet - impairmentFairVal1) * capitalizePct;
      "Impairment of Assets" = intangibleNet - impairmentFairVal1 - "Capital Reserve";
  ENDIF
  basicCost = basicCost - (intangibleNet - impairmentFairVal1);
  amortAmnt = impairmentFairVal1 / numRemainingPers;
ELSEIF ("TP-Date" == impairmentDate2)
```

104  Capital Expense Planning Structure
IF (impairmentOpt == 1)
    "Impairment of Assets" = intangibleNet - impairmentFairVal2;
ELSEIF (impairmentOpt == 2)
    "Capital Reserve" = intangibleNet - impairmentFairVal2;
ELSEIF (impairmentOpt == 3)
    "Capital Reserve" = (intangibleNet - impairmentFairVal2) * capitalizePct;
    "Impairment of Assets" = intangibleNet - impairmentFairVal2 - "Capital Reserve";
ENDIF

basicCost = basicCost - (intangibleNet - impairmentFairVal2);
amortAmt = impairmentFairVal2 / numRemainingPers;
ENDIF

IF (periodOffset + 1 == numAmortPeriods)
    amortAmt = (basicCost - salvageVal) - priorAccumAmort;
ENDIF

priorAccumAmort = priorAccumAmort + amortAmt;
intangibleNet = basicCost - priorAccumAmort;

/* Only assign values to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
    "Intangible Assets Finite, Gross" = basicCost;
    "Amortization" = amortAmt;
    "Accumulated Amortization" = priorAccumAmort;
    "Insurance" = insuranceCost;
    "Maintenance" = maintenanceCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
    IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR "No Year"->"BegBalance"->"Reason Ended" == 3)
        netValue = basicCost - priorAccumAmort + retirementCosts;
        IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
            "Loss/(Gain) on Sale of Intangibles" = netValue - saleValue + amortAmt;
        ELSE
            "Loss/(Gain) on Sale of Intangibles" = netValue + amortAmt;
        ENDIF
        "Retirement Expenses" = retirementCosts - retirementObs;
        "Proceeds from Sale of Intangibles" = saleValue - retirementCosts;
    ELSE
        "Loss/(Gain) on Sale of Intangibles" = netValue + amortAmt;
    ENDIF
    "Retirement Expenses" = retirementCosts - retirementObs;
    "Proceeds from Sale of Intangibles" = saleValue - retirementCosts;
ENDIF

periodOffset = periodOffset +1;
numRemainingPers = numRemainingPers -1;
ENDIF

ENDIF

ENDIF

ENDIF

EOF

FIX ("BegBalance", "No Year")
"Cash Flow Incidence" (  
  IF (cashflowChanged == 1 AND "Asset Status" > 0)  
    "Cash Flow Incidence" = cashFlowIncidence;  
ENDIF  
IF (fundingChanged == 1 AND "Asset Status" > 0)  
  "Funding Incidence" = fundingIncidence;  
ENDIF  
)  
ENDIFX  
ENDIFX  
FIX([Hidden_Scenario], [Hidden_Version], [Department])  
  @ANCESTORS([LineItem]);  
  @ANCESTORS([AssetClassInt]);  
ENDFIX

CalcDepr

Description
Calculates depreciation.

Formula

SET CREATENONMISSINGBLK ON;  
SET UPDATECALC OFF;  
SET AGGMISSG ON;  
  VAR periodOffset = 0;  
  VAR deprMethod = 0;  
  VAR deprRate = 0;  
  VAR deprConvention = 0;  
  VAR numDeprPeriods = 0;  
  VAR totDeprPeriods = 0;  
  VAR persIn1stYear = 12;  
  VAR priorAccumDepr = 0;  
  VAR periodicPriorAccumDepr = 0;  
  VAR basicCost = 0;  
  VAR salvageVal = 0;  
  VAR deprAmt = 0;  
  VAR deprAmtLast = 0;  
  VAR persInSection = 0;  
  VAR life = 0;  
  VAR lifeIndex = 0;  
  VAR isAnnual = 0;  
  VAR inServiceDate = 0;  
  VAR delayedStartDate = 0;  
  VAR prematureEndDate = 0;  
  VAR maintenanceCost = 0;  
  VAR insuranceCost = 0;  
  VAR repairsCost = 0;  
  VAR retirementObs = 0;  
  VAR retirementCosts = 0;  
  VAR cashOutflowDate = 0;  
  VAR fundingDate = 0;  
  VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR fundingAmt = 0;
VAR setCashImpact = 0;
VAR fundingImpact = 0;
VAR retireOption = 0;
VAR saleValue = 0;
VAR yearVal;
VAR monthVal;
VAR dayVal;
VAR delayStart;
VAR split1stAmt;
VAR paramsSet = 0;
VAR cashflowChanged = 0;
VAR fundingChanged = 0;
VAR preExistingPers = 0;
VAR setStartDepr = 0;

FIX([AssetClass], [Hidden_Scenario], [Hidden_Version], [Department])

FIX ("BegBalance", "No Year")
"Basic Cost" (
  IF ("Asset Status" > 0)
    IF ("In Service Date" < "Purchase Date")
      "In Service Date" = "Purchase Date";
    ENDIF
    "Basic Cost" = "Asset Units" * "Asset Rate" + ("Asset Units" * "Asset Rate" * "Taxes %") + "Freight" + "Additional Charges" + "Retirement Obligation" + "Installation";
    "Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
    "Salvage" = "Salvage Input" * "Asset Units";
  ENDIF
)
ENDFIX

FIX (@LEVMBRS("Period", 0), @LEVMBRS("Year", 0))
"Depreciation"(
  IF ("No Year"->"BegBalance"->"Asset Status" >= 0)
    IF (@ISMBR("BegBalance") AND paramsSet == 0)
      paramsSet = 1;
      /* Initialized all the variables required to calculate depreciation */
      /* eliminate days from date */
      delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
      prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
      purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
      inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
      cashOutflowDate = purchaseDate;
      fundingDate = purchaseDate;
  ENDIF
cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";

IF (cashFlowIncidence <> "No Year"->"Cash Flow Incidence")
cashflowChanged = 1;
ELSE
  cashflowChanged = 0;
ENDIF

IF (cashFlowIncidence == -1 AND cashflowChanged == 1)
cashStaggeredPers = 4;
ELSE
  /* Extract year and month from date to adjust based in incidence values in
global assumptions */
  yearVal = @INT(cashOutflowDate / 10000) * 10000;
  monthVal = cashOutflowDate - yearVal;
  monthVal = monthVal + cashFlowIncidence;

  IF (monthVal <= 0)
    yearVal = yearVal - 10000;
    monthVal = 1200 + monthVal;
  ELSEIF (monthVal > 1200)
    yearVal = yearVal + 10000;
    monthVal = monthVal - 1200;
  ENDIF

  cashOutflowDate = yearVal + monthVal;
  cashStaggeredPers = 1;
ENDIF

fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";

IF (fundingIncidence <> "No Year"->"Funding Incidence")
fundingChanged = 1;
ELSE
  fundingChanged = 0;
ENDIF

IF (fundingIncidence == -1 AND fundingChanged == 1)
fundingStaggeredPers = 4;
ELSE
  /* Extract year and month from date to adjust based in incidence values in
global assumptions */
  yearVal = @INT(fundingDate / 10000) * 10000;
  monthVal = fundingDate - yearVal;
  monthVal = monthVal + fundingIncidence;

  IF (monthVal <= 0)
    yearVal = yearVal - 10000;
    monthVal = 1200 + monthVal;
  ELSEIF (monthVal > 1200)
    yearVal = yearVal + 10000;
    monthVal = monthVal - 1200;
  ENDIF

  fundingDate = yearVal + monthVal;
  fundingStaggeredPers = 1;
/* Initialize for depreciation calc in next section */

basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

deprMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->
"Depreciation Method";
depConv = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->
"Depreciation Convention";
insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->
"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->
"Global"->"Maintenance %";
repairsCosts = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->
"Global"->"Repairs %";

fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->
"Global"->"Funding %";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
  yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
  monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
  IF (monthVal < 0)
    IF (yearVal > 0)
      yearVal = yearVal - 1;
    ENDIF
  ENDIF
  monthVal = 1200 + monthVal;
  preExistingPers = @ROUND(yearVal * 12 + monthVal / 100, 0);
ELSE
  preExistingPers = 0;
ENDIF

/* setup for depreciation */
umDeprPeriods = 0;
periodOffset = 0;
IF (deprMethod > 0)
persIn1stYear = "NumPeriods"; /* Not adjusted - "Cal TP-Index" + 1; */
priorAccumDepr = 0;
periodicPriorAccumDepr = 0;
deprAmnt = 0;
/* Add a periodic vs annual property instead of additional deprMethods */
/* Annual Methods SumYearDigits =2 DecliningBalance Year = 3*/
IF (deprMethod == 2 OR deprMethod == 3)
isAnnual = 1;
  life = "No Year"->"Useful Life (in Years)";
persInSection = "NumPeriods";
ELSE /* Periodic Methods */
    isAnnual = 0;
    life = "No Year"->"Useful Life (in Years)" * "NumPeriods";
    persInSection = 1;
ENDIF

setCashImpact = 0;
setFundingImpact = 0;
yearVal = @INT(inServiceDate / 10000) * 10000;

/* DecliningBalance methods */
IF (deprMethod == 3 OR deprMethod == 4)
    /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
    deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

/* Reset depr method to SLN convention to prorate 1st period for preExisting
assets */
IF (preExistingPers > 0)
    deprMethod = 1;
    deprConvention = 1;
ENDIF

ENDIF

IF (@ISMBR("No Year"))
    paramsSet = 0;
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
    /* clear out any previously calculated values */
    "Depreciation" = #MISSING;
    "Accumulated Depreciation" = #MISSING;
    "Property, Plant and Equipment Gross" = #MISSING;
    "Loss/(Gain) on Sale of Property, Plant and Equipment" = #MISSING;
    "Proceeds from Sale of Property, Plant and Equipment" = #MISSING;
    IF (cashFlowIncidence <> -1 OR cashflowChanged == 1)
        "Cash Flow Allocator" = #MISSING;
    ENDIF
    IF (fundingIncidence <> -1 OR fundingChanged == 1)
        "Funding Allocator" = #MISSING;
    ENDIF
    "Cash Outflow from Capital Additions" = #MISSING;
    "Cash Inflow from Funding" = #MISSING;
    "Long Term Debt" = #MISSING;
    "Insurance" = #MISSING;
    "Maintenance" = #MISSING;
    "Repairs" = #MISSING;
    "Retirement Expenses" = #MISSING;
    "Capital Expenditure" = #MISSING;
    IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
"Capital Expenditure" = basicCost - retirementObs;
ENDIF

/* Check if we should start setting cash flow impact values */
IF ("TP-Date" == cashOutflowDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    setCashImpact = cashStaggeredPers;
cashAllocPct = 1 / cashStaggeredPers;
ENDIF

/* Check if we should start setting funding values */
IF ("TP-Date" == fundingDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    setFundingImpact = fundingStaggeredPers;
fundingAllocPct = 1 / fundingStaggeredPers;
ENDIF

IF (setCashImpact > 0)
    "Cash Flow Allocator" = cashAllocPct;
    setCashImpact = setCashImpact - 1;
ENDIF

"Cash Outflow from Capital Additions" = basicCost * "Cash Flow Allocator";

IF (setFundingImpact > 0)
    "Funding Allocator" = fundingAllocPct;
    setFundingImpact = setFundingImpact - 1;
ENDIF

"Cash Inflow from Funding" = fundingAmt * "Funding Allocator";
"Long Term Debt" = fundingAmt * "Funding Allocator";

/* Check if we should start depreciation */
IF ((numDeprPeriods == 0) AND (("TP-Date" == inServiceDate) OR (setStartDepr == 1) OR (deprConvention == 4 AND "Fiscal TP-Index" == @INT("NumPeriods" / 2)+1) AND "TP-Date" > yearVal))
    setStartDepr = 0;
    periodOffset = 0;
    persIn1stYear = "NumPeriods";
    numDeprPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in Years)"
    totDeprPeriods = numDeprPeriods;
    dayVal = "No Year"->"BegBalance"->"In Service Date" - inServiceDate;
    monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);
    delayStart = 0;
    IF (deprConvention == 2) /* Prorate Actual Date */
        IF (dayVal == 1) /* Treat same as Begin Period */
            split1stAmt = 0;
        ELSE
            numDeprPeriods = numDeprPeriods + 1;
            split1stAmt = 1;
        ENDIF
    ELSEIF (deprConvention == 3) /* Mid Period */
        numDeprPeriods = numDeprPeriods + 1;
        split1stAmt = 1;
    ELSE
        IF (dayVal <= 0) /* Before Begin Period */
            split1stAmt = 0;
        ELSE
            split1stAmt = 1;
        ENDIF
    ENDIF
ELSEIF (deprConvention == 3) /* Mid Period */
    numDeprPeriods = numDeprPeriods + 1;
    split1stAmt = 1;
ELSEIF (deprConvention == 4) /* MidYear */
    split1stAmt = 0;
    delayStart = @INT("NumPeriods" / 2) - "Fiscal TP-Index" +1;
ELSE /* Prorate Begin Period */
    split1stAmt = 0;
ENDIF

IF (deprMethod == 3 OR deprMethod == 4)
    /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
    deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ELSEIF (deprMethod == 1)
    deprRate = (basicCost - salvageVal) / totDeprPeriods;
ENDIF

insuranceCost = insuranceCost / "NumPeriods";
maintenanceCost = maintenanceCost / "NumPeriods";
repairsCost = repairsCost / "NumPeriods";

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
    numDeprPeriods = numDeprPeriods - preExistingPers;
    IF (numDeprPeriods > 0)
        deprAmt = (basicCost - salvageVal) / totDeprPeriods;
        periodicPriorAccumDepr = deprAmt * preExistingPers;
    ENDIF
ENDIF

ENDIF

/* Depreciation calculation section */
IF (deprMethod > 0 AND periodOffset < numDeprPeriods AND delayStart < 1)
    lifeIndex = @INT(periodOffset / persInSection);

    IF (deprMethod == 1) /* Straight Line */
        deprAmt = (basicCost - salvageVal) / totDeprPeriods;
    ELSEIF (deprMethod == 3 or deprMethod == 4) /* Declining Balance */
        IF (lifeIndex == 0)
            /* cost * rate * month / 12; for 1st period */
            deprAmt = basicCost * deprRate * persIn1stYear / "NumPeriods" / persInSection;
        ELSE /* (cost - total depreciation from prior periods) * rate; for all middle periods */
            deprAmt = (basicCost - priorAccumDepr) * deprRate / persInSection;
        ENDIF
    ELSEIF (deprMethod == 2) /* Sum of Years Digits */
        deprRate = (life - lifeIndex) * 2 / (life * (life +1));
        deprAmt = (basicCost - salvageVal) * deprRate / persInSection;
    ENDIF
ELSEIF (split1stAmt == 1)
    IF (deprConvention == 2)
        /* assume that there are 30 days in each month */
        deprAmt = deprAmt * @MAX(30 - dayVal, 1) / 30;
    ELSEIF (deprConvention == 4)
        ;
    ELSE
deprAmt = deprAmt - deprAmt / 2;
ENDIF
split1stAmt = 0;
ENDIF

/* Adjust for rounding errors */
IF (periodOffset + 1 == numDeprPeriods)
    deprAmt = (basicCost - salvageVal) - periodicPriorAccumDepr;
ENDIF

periodicPriorAccumDepr = periodicPriorAccumDepr + deprAmt;

/* Use accumulated depr as first value for Mid-Year conversion */
IF (deprConvention == 4 AND "TP-Date" == inServiceDate AND monthVal > 600)
    deprAmt = periodicPriorAccumDepr;
ENDIF

IF (isAnnual == 1)
    IF (@INT((periodOffset + 1) / persInSection) == (lifeIndex + 1))
        priorAccumDepr = periodicPriorAccumDepr;
    ENDIF
ELSE
    priorAccumDepr = periodicPriorAccumDepr;
ENDIF

/* Only assign to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
    "Property, Plant and Equipment Gross" = basicCost;
    "Depreciation" = deprAmt;
    "Accumulated Depreciation" = periodicPriorAccumDepr;
    "Insurance" = insuranceCost;
    "Maintenance" = maintenanceCost;
    "Repairs" = repairsCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
    IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR
        "No Year"->"BegBalance"->"Reason Ended" == 3)
        netValue = basicCost - priorAccumDepr + retirementCosts;
    ELSE
        "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue -
        saleValue + deprAmt;
    ENDIF
    ELSE
        "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue +
        deprAmt;
    ENDIF
    "Retirement Expenses" = retirementCosts - retirementObs;
    "Proceeds from Sale of Property, Plant and Equipment" = saleValue -
    retirementCosts;
ENDIF

periodOffset = periodOffset +1;
ENDIF
delayStart = delayStart -1;
ENDIF

ENDIF
)
ENDFIX

FIX ("BegBalance", "No Year")
"Cash Flow Incidence" (  
IF (cashflowChanged == 1 AND "Asset Status" > 0)  
"Cash Flow Incidence" = cashFlowIncidence;
ENDIF
IF (fundingChanged == 1 AND "Asset Status" > 0)  
"Funding Incidence" = fundingIncidence;
ENDIF
)
ENDFIX

ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [Department])
CALC DIM ("Period", "Asset Class");
@ANCESTORS([LineItem]);
ENDFIX

CalcExistAmort

Description
Calculates amortization for an existing asset.

Formula

SET CREATENONMISSINGBLK ON;

VAR periodOffset = 0;
VAR amortMethod = 0;
VAR numAmortPeriods = 0;
VAR priorAccumAmort = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR amortAmt = 0;
VAR retirementCosts = 0;
VAR retirementObs = 0;
VAR impairmentDate1 = 0;
VAR impairmentDate2 = 0;
VAR impairmentFairVal1 = 0;
VAR impairmentFairVal2 = 0;
VAR purchaseDate = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR capitalizePct = 0;
VAR impairmentOpt = 1;
VAR numRemainingPers;
VAR intangibleNet;

114   Capital Expense Planning Structure
VAR netValue;
VAR saleValue;
VAR yearVal;
VAR monthVal;
VAR paramsSet = 0;
VAR preExistingPers = 0;
VAR setStartAmort = 0;

FIX([Hidden_Scenario], [Hidden_Version], [Department], [AssetClassInt])

FIX ("BegBalance", "No Year")
"Basic Cost" (  
  IF ("Asset Status" > 0)
    IF ("In Service Date" < "Purchase Date")
      "In Service Date" = "Purchase Date";
      ENDIF
    "Basic Cost" = "Acquisition Costs" + "Additional Charges";
    "Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
    "Salvage" = "Salvage Input" * "Asset Units";
    ENDIF
  )
ENDFIX

FIX (@LEVMBRS("Period", 0) @LEVMBRS("Year", 0))
"Amortization"(
  /* Only calc valid asset line items */
  IF ("No Year"->"BegBalance"->"Asset Status" >= 0)
    IF (@ISMBR("BegBalance") AND paramsSet == 0)
      /* Initialized all the variables required to calculate depreciation */
      paramsSet = 1;
      
      /* eliminate days from date */
      delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
      prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
      purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
      inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
      
      /* Initialize for amortization calc in next section */
      basicCost = "No Year"->"Basic Cost";
      salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
      impairmentOpt = "No Year"->"Impairment Option";
      capitalizePct = "No Year"->"Partial Capitalize %";
      saleValue = "No Year"->"Sale Value";
      retirementCosts = "No Year"->"Retirement Costs";
      retirementObs = "No Year"->"Retirement Obligation";
      
      amortMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Amortization Method";
      insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
      maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";

Predefined Business Rules  115
IF ("No Year"->"Impairment Date1" <> #MISSING)
    impairmentDate1 = @INT("No Year"->"Impairment Date1" / 100) * 100;
ELSE
    impairmentDate1 = #MISSING;
ENDIF
IF ("No Year"->"Impairment Date2" <> #MISSING)
    impairmentDate2 = @INT("No Year"->"Impairment Date2" / 100) * 100;
ELSE
    impairmentDate2 = #MISSING;
ENDIF
impairmentFairVal1 = "No Year"->"Impairment Fair Value1";
impairmentFairVal2 = "No Year"->"Impairment Fair Value2";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
    yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
    monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
    IF (monthVal < 0)
        IF (yearVal > 0)
            yearVal = yearVal - 1;
            ENDIF
            monthVal = 1200 + monthVal;
        ENDIF
    preExistingPers = @ROUND(yearVal * 12 + monthVal / 100, 0);
    setStartAmort = 1;
ELSE
    preExistingPers = 0;
    setStartAmort = 0;
ENDIF
numAmortPeriods = 0;
periodOffset = 0;
IF (amortMethod == 1)
    priorAccumAmort = 0;
    amortAmt = 0;
    yearVal = @INT(inServiceDate / 10000) * 10000;
    monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);
ENDIF
ENDIF

IF (@ISMBR("No Year"))
    paramsSet = 0;
ENDIF
IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
    /* clear out any previously calculated values */
    "Amortization" = #MISSING;
    "Accumulated Amortization" = #MISSING;
    "Intangible Assets Finite, Gross" = #MISSING;
    "Loss/(Gain) on Sale of Intangibles" = #MISSING;
"Proceeds from Sale of Intangibles" = #MISSING;
"Cash Flow Allocator" = #MISSING;
"Funding Allocator" = #MISSING;
"Cash Outflow from Capital Additions" = #MISSING;
"Cash Inflow from Funding" = #MISSING;
"Long Term Debt" = #MISSING;
"Insurance" = #MISSING;
"Maintenance" = #MISSING;
"Impairment of Assets" = #MISSING;
"Retirement Expenses" = #MISSING;
"Capital Reserve" = #MISSING;
"Capital Expenditure" = #MISSING;
"Retirement Expenses" = #MISSING;

/* Commented out for now need to verify */
IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
"Capital Expenditure" = basicCost - retirementObs;
ENDIF
/*

/* Check if we should start amortization */
IF (("TP-Date" == inServiceDate) OR (setStartAmort == 1))
setStartAmort = 0;
periodOffset = 0;
numAmortPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in Years)";
insuranceCost = insuranceCost / "NumPeriods";
maintenanceCost = maintenanceCost / "NumPeriods";
intangibleNet = basicCost;
amortAmt = (basicCost - salvageVal) / numAmortPeriods;

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
numAmortPeriods = numAmortPeriods - preExistingPers;
IF (numAmortPeriods > 0)
priorAccumAmort = amortAmt * preExistingPers;
ENDIF
ENDIF
numRemainingPers = numAmortPeriods;
ENDIF

/* Amortization calculation section */
IF (amortMethod == 1 AND periodOffset < numAmortPeriods)

/* If capitalized book in Capital Reserve instead of Impairment */
IF ("TP-Date" == impairmentDate1)
IF (impairmentOpt == 1)
"Impairment of Assets" = intangibleNet - impairmentFairVal1;
ELSEIF (impairmentOpt == 2)
"Capital Reserve" = intangibleNet - impairmentFairVal1;
ELSEIF (impairmentOpt == 3)
"Capital Reserve" = (intangibleNet - impairmentFairVal1) * capitalizePct;
"Impairment of Assets" = intangibleNet - impairmentFairVal1 - "Capital
Reserve"
ENDIF
basicCost = basicCost - (intangibleNet - impairmentFairVal1);
amortAmt = impairmentFairVal1 / numRemainingPers;
ELSEIF ("TP-Date" == impairmentDate2)
  IF (impairmentOpt == 1)
    "Impairment of Assets" = intangibleNet - impairmentFairVal2;
  ELSEIF (impairmentOpt == 2)
    "Capital Reserve" = intangibleNet - impairmentFairVal2;
  ELSEIF (impairmentOpt == 3)
    "Capital Reserve" = (intangibleNet - impairmentFairVal2) * capitalizePct;
ELSEIF ("TP-Date" == prematureEndDate)
  "Impairment of Assets" = intangibleNet - impairmentFairVal2 - "Capital Reserve";
ENDIF
basicCost = basicCost - (intangibleNet - impairmentFairVal2);
amortAmt = impairmentFairVal2 / numRemainingPers;
ENDIF

IF (periodOffset + 1 == numAmortPeriods)
amortAmt = (basicCost - salvageVal) - priorAccumAmort;
ENDIF

priorAccumAmort = priorAccumAmort + amortAmt;
intangibleNet = basicCost - priorAccumAmort;

/* Only assign values to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
  "Intangible Assets Finite, Gross" = basicCost;
  "Amortization" = amortAmt;
  "Accumulated Amortization" = priorAccumAmort;
  "Insurance" = insuranceCost;
  "Maintenance" = maintenanceCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
  IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR "No Year"->"BegBalance"->"Reason Ended" == 3)
    netValue = basicCost - priorAccumAmort + retirementCosts;
    IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
      "Loss/(Gain) on Sale of Intangibles" = netValue - saleValue + amortAmt;
      ELSE
        "Loss/(Gain) on Sale of Intangibles" = netValue + amortAmt;
      ENDIF
      "Retirement Expenses" = retirementCosts - retirementObs;
      "Proceeds from Sale of Intangibles" = saleValue - retirementCosts;
  ENDIF
ENDIF

periodOffset = periodOffset +1;
numRemainingPers = numRemainingPers -1;
ENDIF
ENDIF
ENDIF
);
ENDFIX

ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [Department])
   @IANCESTORS([LineItem]);
   @ANCESTORS([AssetClassInt]);
ENDFIX

CalcExistDepr

Description
Calculates depreciation for an existing asset.

Formula

SET CREATENONMISSINGBLK ON;
SET UPDATECALC OFF;
SET AGGMISSG ON;

VAR periodOffset = 0;
VAR deprMethod = 0;
VAR deprRate = 0;
VAR deprConvention = 0;
VAR numDeprPeriods = 0;
VAR totDeprPeriods = 0;
VAR persIn1stYear = 12;
VAR priorAccumDepr = 0;
VAR periodicPriorAccumDepr = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR deprAmt = 0;
VAR deprAmtLast = 0;
VAR persInSection = 0;
VAR life = 0;
VAR lifeIndex = 0;
VAR isAnnual = 0;
VAR purchaseDate = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR repairsCost = 0;
VAR retirementObs = 0;
VAR retirementCosts = 0;
VAR retireOption = 0;
VAR saleValue = 0;
VAR netValue;
VAR yearVal;
VAR monthVal;
VAR dayVal;
VAR delayStart;
VAR split1stAmn;
VAR paramsSet = 0;
VAR preExistingPers = 0;
VAR setStartDepr = 0;

FIX([AssetClass], [Hidden_Scenario], [Hidden_Version], [Department])

FIX ("BegBalance", "No Year")
"Basic Cost" (  
IF ("Asset Status" > 0)
IF ("In Service Date" < "Purchase Date")
"In Service Date" = "Purchase Date";
ENDIF
"Basic Cost" = "Asset Units" * "Asset Rate" + ("Asset Units" * "Asset Rate" * "Taxes %") + "Freight" + "Additional Charges" + "Retirement Obligation" + "Installation";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Salvage" = "Salvage Input" * "Asset Units";
ENDIF
)
ENDFIX

FIX (@LEVMBRS("Period", 0), @LEVMBRS("Year", 0))
"Depreciation" (  
IF ("No Year"->"BegBalance"->"Asset Status" >= 0)
IF (@ISMBR("BegBalance") AND paramsSet == 0)
paramsSet = 1;
/* Initialized all the variables required to calculate depreciation */
/* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;

/* Initialize for depreciation calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

depMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Method";
depConvention = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Convention";
insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";
repairsCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Repairs %";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
  yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
  monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
  IF (monthVal < 0)
    IF (yearVal > 0)
      yearVal = yearVal - 1;
    ENDIF
    monthVal = 1200 + monthVal;
  ENDIF
  preExistingPers = yearVal * 12 + monthVal / 100;
  setStartDepr = 1;
ELSE
  preExistingPers = 0;
  setStartDepr = 0;
ENDIF

/* setup for depreciation */
numDeprPeriods = 0;
periodOffset = 0;

IF (deprMethod > 0)
  priorAccumDepr = 0;
  periodicPriorAccumDepr = 0;
  deprAmt = 0;
  /* Add a periodic vs annual property instead of additional deprMethods */
  /* Annual Methods SumYearDigits =2 DecliningBalance Year = 3*/
  IF (deprMethod == 2 OR deprMethod == 3)
    isAnnual = 1;
    life = "No Year"->"Useful Life (in Years)";
    persInSection = "NumPeriods";
  ELSE /* Periodic Methods */
    isAnnual = 0;
    life = "No Year"->"Useful Life (in Years)" * "NumPeriods";
    persInSection = 1;
  ENDIF
  yearVal = @INT(inServiceDate / 10000) * 10000;

/* DecliningBalance methods */
IF (deprMethod == 3 OR deprMethod == 4)
  /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
  deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

/* Reset depr method to SLN convention to prorate 1st period for preExisting assets */
IF (preExistingPers > 0)
  deprMethod = 1;
  deprConvention = 1;
ENDIF

ENDIF
IF (@ISMBR("No Year"))
    paramsSet = 0;
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
    /* clear out any previously calculated values */
    "Depreciation" = #MISSING;
    "Accumulated Depreciation" = #MISSING;
    "Property, Plant and Equipment Gross" = #MISSING;
    "Loss/(Gain) on Sale of Property, Plant and Equipment" = #MISSING;
    "Proceeds from Sale of Property, Plant and Equipment" = #MISSING;
    "Cash Flow Allocator" = #MISSING;
    "Funding Allocator" = #MISSING;
    "Cash Outflow from Capital Additions" = #MISSING;
    "Cash Inflow from Funding" = #MISSING;
    "Long Term Debt" = #MISSING;
    "Insurance" = #MISSING;
    "Maintenance" = #MISSING;
    "Repairs" = #MISSING;
    "Retirement Expenses" = #MISSING;
    "Capital Expenditure" = #MISSING;

    /* Commented out for now need to verify */
    IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
        "Capital Expenditure" = basicCost - retirementObs;
    ENDIF
    /* Check if we should start depreciation */
    IF (((numDeprPeriods == 0) AND ("TP-Date" == inServiceDate) OR (setStartDepr == 1)) OR 
        (deprConvention == 4 AND "Fiscal TP-Index" == @INT("NumPeriods" / 2)+1) AND "TP-Date" > yearVal))
        setStartDepr = 0;
        periodOffset = 0;
        persIn1stYear = "NumPeriods";
        numDeprPeriods = "NumPeriods" * "No Year"-"BegBalance"-"Useful Life (in Years)";
        totDeprPeriods = numDeprPeriods;
        dayVal = "No Year"-"BegBalance"-"In Service Date" - inServiceDate;
        monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000); * 10000)
        delayStart = 0;
        IF (deprConvention == 2) /* Prorate Actual Date */
            IF (dayVal == 1) /* Treat same as Begin Period */
                split1stAmt = 0;
            ELSE
                numDeprPeriods = numDeprPeriods + 1;
                split1stAmt = 1;
            ENDIF
        ELSEIF (deprConvention == 3) /* Mid Period */
            numDeprPeriods = numDeprPeriods + 1;
            split1stAmt = 1;
        ENDIF
    ELSEIF (deprConvention == 3) /* Mid Period */
        numDeprPeriods = numDeprPeriods + 1;
        split1stAmt = 1;
ELSEIF (deprConvention == 4) /* MidYear */
split1stAmt = 0;
delayStart = @INT("NumPeriods" / 2) - "Fiscal TP-Index" +1;
ELSE /* Prorate Begin Period */
split1stAmt = 0;
ENDIF

IF (deprMethod == 3 OR deprMethod == 4)
    /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
depRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

insuranceCost = insuranceCost / "NumPeriods";
maintenanceCost = maintenanceCost / "NumPeriods";
repairsCost = repairsCost / "NumPeriods";

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
    numDeprPeriods = numDeprPeriods - preExistingPers;
    IF (numDeprPeriods > 0)
        deprAmt = (basicCost - salvageVal) / totDeprPeriods;
        periodicPriorAccumDepr = deprAmt * preExistingPers;
    ENDIF
ENDIF

ENDIF

/* Depreciation calcuation section */
IF (deprMethod > 0 AND periodOffset < numDeprPeriods AND delayStart < 1)
    lifeIndex = @INT(periodOffset / persInSection);
    IF (deprMethod == 1) /* Straight Line */
        deprAmt = (basicCost - salvageVal) / totDeprPeriods;
    ELSEIF (deprMethod == 3 or deprMethod == 4) /* Declining Balance */
        IF (lifeIndex == 0)
            /* cost * rate * month / 12; for 1st period */
            deprAmt = basicCost * deprRate * persIn1stYear / "NumPeriods" / persInSection;
        ELSE /* (cost - total depreciation from prior periods) * rate; for all middle periods */
            deprAmt = (basicCost - priorAccumDepr) * deprRate / persInSection;
        ENDIF
    ELSEIF (deprMethod == 2) /* Sum of Years Digits */
        deprRate = (life - lifeIndex) * 2 / (life * (life +1));
        deprAmt = (basicCost - salvageVal) * deprRate / persInSection;
    ENDIF
ELSEIF (deprMethod == 2) /* Sum of Years Digits */
    deprRate = (life - lifeIndex) * 2 / (life * (life +1));
    deprAmt = (basicCost - salvageVal) * deprRate / persInSection;
ENDIF

IF (split1stAmt == 1)
    IF (deprConvention == 2)
        /* assume that there are 30 days in each month */
        deprAmt = deprAmt * @MAX(30 - dayVal, 1) / 30;
    ELSEIF (deprConvention == 4)
    ;
    ELSE
        deprAmt = deprAmt - deprAmt / 2;
    ENDIF
ENDIF
split1stAmt = 0;
ENDIF

/* Adjust for rounding errors */
IF (periodOffset + 1 == numDeprPeriods)
    deprAmt = (basicCost - salvageVal) - periodicPriorAccumDepr;
ENDIF

periodicPriorAccumDepr = periodicPriorAccumDepr + deprAmt;

/* Use accumulated depr as first value for Mid-Year conversion */
IF (deprConvention == 4 AND "TP-Date" == inServiceDate AND monthVal > 600)
    deprAmt = periodicPriorAccumDepr;
ENDIF

IF (isAnnual == 1)
    IF (@INT((periodOffset + 1) / persInSection) == (lifeIndex + 1))
        priorAccumDepr = periodicPriorAccumDepr;
    ENDIF
ELSE
    priorAccumDepr = periodicPriorAccumDepr;
ENDIF

/* Only assign to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
    "Property, Plant and Equipment Gross" = basicCost;
    "Depreciation" = deprAmt;
    "Accumulated Depreciation" = periodicPriorAccumDepr;
    "Insurance" = insuranceCost;
    "Maintenance" = maintenanceCost;
    "Repairs" = repairsCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
    IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR "No Year"->"BegBalance"->"Reason Ended" == 3)
        netValue = basicCost - priorAccumDepr + retirementCosts;
    IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
        "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue - saleValue + deprAmt;
    ELSE
        "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue + deprAmt;
    ENDIF
    "Retirement Expenses" = retirementCosts - retirementObs;
    "Proceeds from Sale of Property, Plant and Equipment" = saleValue - retirementCosts;
ENDIF
ELSE
    periodOffset = periodOffset +1;
ENDIF
endStart = endStart -1;
ImpairIntangible

Description

Impairs an intangible asset.

Formula

SET CREATENONMISSINGBLK ON;

VAR periodOffset = 0;
VAR amortMethod = 0;
VAR numAmortPeriods = 0;
VAR priorAccumAmort = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR amortAmt = 0;
VAR retirementCosts = 0;
VAR retirementObs = 0;
VAR impairmentDate1 = 0;
VAR impairmentDate2 = 0;
VAR impairmentFairVal1 = 0;
VAR impairmentFairVal2 = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR cashOutflowDate = 0;
VAR fundingDate = 0;
VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR fundingAmt = 0;
VAR setCashImpact = 0;
VAR setFundingImpact = 0;
VAR capitalizePct = 0;
VAR impairmentOpt = 1;
VAR numRemainingPers;
VAR intangibleNet;
VAR netValue;
VAR saleValue;
VAR yearVal;
VAR monthVal;
VAR paramsSet = 0;
VAR isNew = 0;
VAR cashflowChanged = 0;
VAR fundingChanged = 0;
VAR preExistingPers = 0;
VAR setStartAmort = 0;

FIX([LineItem], [Hidden_Scenario], [Hidden_Version], [Department], [AssetClassInt])

FIX("No Year", "BegBalance")
"Asset Description" ( 
  IF ("Asset Description" <> #MISSING)
    IF ("Impairment Date1" == #MISSING)
      "Impairment Date1" = [ImpairmentDate];
      "Impairment Fair Value1" = [FairValue];
    ELSE
      "Impairment Date2" = [ImpairmentDate];
      "Impairment Fair Value2" = [FairValue];
    ENDIF
    IF ("Impairment Date2" <> #MISSING AND "Impairment Date2" <= "Impairment Date1")
      "Impairment Date1" = [ImpairmentDate];
      "Impairment Fair Value1" = [FairValue];
      "Impairment Date2" = #MISSING;
      "Impairment Fair Value2" = #MISSING;
    ENDIF
    IF ("Impairment Date1" <> #MISSING)
      impairmentDate1 = @INT("Impairment Date1" / 100) * 100;
    ELSE
      impairmentDate1 = #MISSING;
    ENDIF
    IF ("Impairment Date2" <> #MISSING)
      impairmentDate2 = @INT("Impairment Date2" / 100) * 100;
    ELSE
      impairmentDate2 = #MISSING;
    ENDIF
    "Impairment Option" = [ImpairmentOpt];
    "Partial Capitalize %" = [CapitalizePct];
    impairmentFairVal1 = "Impairment Fair Value1";
    impairmentFairVal2 = "Impairment Fair Value2";
    IF ("In Service Date" < "Purchase Date")
      "In Service Date" = "Purchase Date";
    ENDIF
    "Basic Cost" = "Acquisition Costs" + "Additional Charges";
    "Useful Life (in Years)
    "Salvage" = "Salvage Input" * "Asset Units";
  )

126 Capital Expense Planning Structure
/* Amortization Section */
FIX (@LEVMBRS("Period", 0) @LEVMBRS("Year", 0))
"Amortization"

/* Only calc valid asset line items */
IF ("No Year"->"BegBalance"->"Asset Status" >= 0)
    IF (@ISMBR("BegBalance") AND paramsSet == 0)
        /* Initialized all the variables required to calculate depreciation */
        paramsSet = 1;
        /* Check if we are a descendant of a new Asset */
        IF (@ISDESC("Total New"))
            isNew = 1;
        ELSE
            isNew = 0;
        ENDIF
    ENDIF
    /* eliminate days from date */
    delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
    prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
    purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
    inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
    cashOutflowDate = purchaseDate;
    fundingDate = purchaseDate;
    cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";
    IF (cashFlowIncidence <> "No Year"->"Cash Flow Incidence")
        cashflowChanged = 1;
    ELSE
        cashflowChanged = 0;
    ENDIF
    IF (cashFlowIncidence == -1 AND cashflowChanged == 1)
        cashStaggeredPers = 4;
    ELSE
        /* Extract year and month from date to adjust based in incidence values in
global assumptions */
        yearVal = @INT(cashOutflowDate / 10000) * 10000;
        monthVal = cashOutflowDate - yearVal;
        monthVal = monthVal + cashFlowIncidence;
        IF (monthVal <= 0)
            yearVal = yearVal - 10000;
            monthVal = 1200 + monthVal;
        ELSEIF (monthVal > 1200)
            yearVal = yearVal + 10000;
            monthVal = monthVal - 1200;
        ENDIF
    cashOutflowDate = yearVal + monthVal;
    cashStaggeredPers = 1;
ENDIF
ENDIF

fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";

IF (fundingIncidence <> "No Year"->"Funding Incidence")
fundingChanged = 1;
ELSE
fundingChanged = 0;
ENDIF

IF (fundingIncidence == -1 AND fundingChanged == 1)
fundingStaggeredPers = 4;
ELSE
yearVal = @INT(fundingDate / 10000) * 10000;
monthVal = fundingDate - yearVal;
monthVal = monthVal + fundingIncidence;

IF (monthVal <= 0)
yearVal = yearVal - 10000;
monthVal = 1200 + monthVal;
ELSEIF (monthVal > 1200)
yearVal = yearVal + 10000;
monthVal = monthVal - 1200;
ENDIF

fundingDate = yearVal + monthVal;
fundingStaggeredPers = 1;
ENDIF

/* Initialize for amortization calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
impairmentOpt = "No Year"->"Impairment Option";
capitalizePct = "No Year"->"Partial Capitalize %";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

amortMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Amortization Method";

insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";

fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding %";

IF ("No Year"->"Impairment Date1" <> #MISSING)
impairmentDate1 = @INT("No Year"->"Impairment Date1" / 100) * 100;
ELSE
impairmentDate1 = #MISSING;
ENDIF

IF ("No Year"->"Impairment Date2" <> #MISSING)
impairmentDate2 = @INT("No Year"->"Impairment Date2" / 100) * 100;
ELSE
    impairmentDate2 = #MISSING;
ENDIF

impairmentFairVal1 = "No Year"->"Impairment Fair Value1";
impairmentFairVal2 = "No Year"->"Impairment Fair Value2";

/*@ check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
    yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
    monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate
    - @INT(inServiceDate / 10000) * 10000);
    IF (monthVal < 0)
        IF (yearVal > 0)
            yearVal = yearVal - 1;
        ENDIF
        monthVal = 1200 + monthVal;
    ENDIF
    preExistingPers = @ROUND(yearVal * 12 + monthVal / 100, 0);
ELSE
    preExistingPers = 0;
ENDIF

numAmortPeriods = 0;
periodOffset = 0;

IF (amortMethod == 1)
    priorAccumAmort = 0;
    amortAmt = 0;
    setCashImpact = 0;
    setFundingImpact = 0;
    yearVal = @INT(inServiceDate / 10000) * 10000;
    monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000); 
    IF (monthVal < 0)
        IF (yearVal > 0)
            yearVal = yearVal - 1;
        ENDIF
        monthVal = 1200 + monthVal;
    ENDIF
    IF (@ISMBR("No Year"))
        paramsSet = 0;
    ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
    /* clear out any previously calculated values */
    "Amortization" = #MISSING;
    "Accumulated Amortization" = #MISSING;
    "Intangible Assets Finite, Gross" = #MISSING;
    "Loss/(Gain) on Sale of Intangibles" = #MISSING;
    "Proceeds from Sale of Intangibles" = #MISSING;

    IF (cashFlowIncidence <> -1 OR cashflowChanged == 1)
        "Cash Flow Allocator" = #MISSING;
    ENDIF
    IF (fundingIncidence <> -1 OR fundingChanged == 1)

"Funding Allocator" = #MISSING;
ENDIF
"Cash Outflow from Capital Additions" = #MISSING;
"Cash Inflow from Funding" = #MISSING;
"Long Term Debt" = #MISSING;
"Insurance" = #MISSING;
"Maintenance" = #MISSING;
"Impairment of Assets" = #MISSING;
"Capital Reserve" = #MISSING;
"Capital Expenditure" = #MISSING;
"Retirement Expenses" = #MISSING;

/* Only calculate cash impact and funding for new assets */
IF (isNew == 1)
IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
"Capital Expenditure" = basicCost - retirementObs;
ENDIF

IF ("TP-Date" == cashOutflowDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
setCashImpact = cashStaggeredPers;
cashAllocPct = 1 / cashStaggeredPers;
ENDIF

IF ("TP-Date" == fundingDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
setFundingImpact = fundingStaggeredPers;
fundingAllocPct = 1 / fundingStaggeredPers;
ENDIF

IF (setCashImpact > 0)
"Cash Flow Allocator" = cashAllocPct;
setCashImpact = setCashImpact - 1;
ENDIF
"Cash Outflow from Capital Additions" = basicCost * "Cash Flow Allocator";

IF (setFundingImpact > 0)
"Funding Allocator" = fundingAllocPct;
setFundingImpact = setFundingImpact - 1;
ENDIF
"Cash Inflow from Funding" = fundingAmt * "Funding Allocator";
"Long Term Debt" = fundingAmt * "Funding Allocator";

ENDIF

/* Check if we should start amortization */
IF ("TP-Date" == inServiceDate OR (setStartAmort == 1))
setStartAmort = 0;
periodOffset = 0;
numAmortPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in Years)";
insuranceCost = insuranceCost / "NumPeriods";
maintenanceCost = maintenanceCost / "NumPeriods";
intangibleNet = basicCost;
amortAmt = (basicCost - salvageVal) / numAmortPeriods;

/* Adjust for pre-existing assets */
IF (preExistingPers > 0)
    numAmortPeriods = numAmortPeriods - preExistingPers;
    IF (numAmortPeriods > 0)
        priorAccumAmort = amortAmt * preExistingPers;
    ENDIF
ENDIF

numRemainingPers = numAmortPeriods;
ENDIF

/* Amortization calculation section */
IF (amortMethod == 1 AND periodOffset < numAmortPeriods)
    /* If capitalized book in Capital Reserve instead of Impairment */
    IF ("TP-Date" == impairmentDate1)
        IF (impairmentOpt == 1)
            "Impairment of Assets" = intangibleNet - impairmentFairVal1;
        ELSEIF (impairmentOpt == 2)
            "Capital Reserve" = intangibleNet - impairmentFairVal1;
        ELSEIF (impairmentOpt == 3)
            "Capital Reserve" = (intangibleNet - impairmentFairVal1) * capitalizePct;
        ENDIF
        "Impairment of Assets" = intangibleNet - impairmentFairVal1 - "Capital Reserve";
    ENDIF
    basicCost = basicCost - (intangibleNet - impairmentFairVal1);
    amortAmt = impairmentFairVal1 / numRemainingPers;
ELSEIF ("TP-Date" == impairmentDate2)
    IF (impairmentOpt == 1)
        "Impairment of Assets" = intangibleNet - impairmentFairVal2;
    ELSEIF (impairmentOpt == 2)
        "Capital Reserve" = intangibleNet - impairmentFairVal2;
    ELSEIF (impairmentOpt == 3)
        "Capital Reserve" = (intangibleNet - impairmentFairVal2) * capitalizePct;
    ENDIF
    "Impairment of Assets" = intangibleNet - impairmentFairVal2 - "Capital Reserve";
ELSEIF (periodOffset + 1 == numAmortPeriods)
    amortAmt = (basicCost - salvageVal) - priorAccumAmort;
ENDIF

priorAccumAmort = priorAccumAmort + amortAmt;
intangibleNet = basicCost - priorAccumAmort;

/* Only assign values to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
    "Intangible Assets Finite, Gross" = basicCost;
"Amortization" = amortAmt;
"Accumulated Amortization" = priorAccumAmort;
"Insurance" = insuranceCost;
"Maintenance" = maintenanceCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
  IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR
    "No Year"->"BegBalance"->"Reason Ended" == 3)
    netValue = basicCost - priorAccumAmort + retirementCosts;
    IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
      "Loss/(Gain) on Sale of Intangibles" = netValue - saleValue +
      amortAmt;
    ELSE
      "Loss/(Gain) on Sale of Intangibles" = netValue + amortAmt;
    ENDIF
    "Retirement Expenses" = retirementCosts - retirementObs;
    "Proceeds from Sale of Intangibles" = saleValue - retirementCosts;
  ENDIF
ENDIF

periodOffset = periodOffset +1;
numRemainingPers = numRemainingPers -1;
ENDIF
ENDIF
ENDIF
);
ENDFIX

FIX ("BegBalance", "No Year")
"Cash Flow Incidence" (  
  IF (cashflowChanged == 1 AND "Asset Status" > 0)
    "Cash Flow Incidence" = cashFlowIncidence;
  ENDIF
  IF (fundingChanged == 1 AND "Asset Status" > 0)
    "Funding Incidence" = fundingIncidence;
  ENDIF
)
ENDFIX
ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [Department])  
@IANCESTORS([LineItem]);  
@ANCESTORS([AssetClassInt]);
ENDFIX

### Improve Asset

**Description**

Adds an improvement to an asset.

**Formula**
SET CREATENONMISSINGBLK ON;

VAR periodOffset = 0;
VAR deprMethod = 0;
VAR deprRate = 0;
VAR deprConvention = 0;
VAR numDeprPeriods = 0;
VAR totDeprPeriods = 0;
VAR persInstYear = 12;
VAR priorAccumDepr = 0;
VAR periodicPriorAccumDepr = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR deprAmt = 0;
VAR persInSection = 0;
VAR life = 0;
VAR lifeIndex = 0;
VAR isAnnual = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR retirementCosts = 0;
VAR retirementObs = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR repairsCost = 0;
VAR cashOutflowDate = 0;
VAR fundingDate = 0;
VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR fundingAmt = 0;
VAR setCashImpact = 0;
VAR setFundingImpact = 0;
VAR paramsSet = 0;
VAR netValue;
VAR saleValue;
VAR yearVal;
VAR monthVal;
VAR dayVal;
VAR delayStart;
VAR split1stAmt;
VAR numAsset = 1;
VAR preExistingPers = 0;
VAR setStartDepr = 0;

FIX(@SIBLINGS([LineItem]), [Hidden_Scenario], [Hidden_Version], [Department], [AssetClass])

/* Setup properties for new Asset */
FIX("No Year", "BegBalance")
"Asset Description" {
IF (numAsset > 0 AND @MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING )
numAsset = numAsset - 1;
"Asset Status" = 0;  /* Indicate that we have a new asset */
"Asset Description" = [AssetDesc];
"Asset Units" = [AssetUnits];
"Asset Rate" = [AssetRate];
"Installation" = [Installation];
"Freight" = [Freight];
"Salvage Input" = [SalvageValue];
"Salvage" = [SalvageValue] * "Asset Units";
"Taxes %" = [TaxesPct];
"Additional Charges" = [AdditionalCharges];
"Retirement Obligation" = [@RETIM];
"Physical Location" = [PhyLocation];
"Basic Cost" = "Asset Units" * "Asset Rate" + ("Asset Units" * "Asset Rate" * "Taxes %") + "Freight" + "Additional Charges" + "Retirement Obligation" + "Installation";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Purchase Date" = [PurchaseDate];
"In Service Date" = [InserviceDate];
IF ("In Service Date" < "Purchase Date")
  "In Service Date" = "Purchase Date";
ENDIF
ENDFIX

ENDFIX

/* Calculate depreciation section */
FIX (@LEVMBRS("Period", 0), @LEVMBRS("Year", 0))
"Depreciation"(

/* Only process newly added asset line items */
IF ("No Year"->"BegBalance"->"Asset Status" == 0)
IF (@ISMBR("BegBalance") AND paramsSet == 0)
paramsSet = 1;

/* Initialized all the variables required to calculate depreciation */
/* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
cashOutflowDate = purchaseDate;
fundingDate = purchaseDate;

cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";

IF (cashFlowIncidence == -1)
  cashStaggeredPers = 4;
ELSE
  /* Extract year and month from date to adjust based in incidence values in global assumptions */
  yearVal = @INT(cashOutflowDate / 10000) * 10000;
monthVal = cashOutflowDate - yearVal;
monthVal = monthVal + cashFlowIncidence;

IF (monthVal <= 0)
    yearVal = yearVal - 10000;
    monthVal = 1200 + monthVal;
ELSEIF (monthVal > 1200)
    yearVal = yearVal + 10000;
    monthVal = monthVal - 1200;
ENDIF

cashOutflowDate = yearVal + monthVal;
cashStaggeredPers = 1;
ENDIF

fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";

IF (fundingIncidence == -1)
    fundingStaggeredPers = 4;
ELSE
    yearVal = @INT(fundingDate / 10000) * 10000;
    monthVal = fundingDate - yearVal;
    monthVal = monthVal + fundingIncidence;

    IF (monthVal <= 0)
        yearVal = yearVal - 10000;
        monthVal = 1200 + monthVal;
    ELSEIF (monthVal > 1200)
        yearVal = yearVal + 10000;
        monthVal = monthVal - 1200;
    ENDIF

    fundingDate = yearVal + monthVal;
    fundingStaggeredPers = 1;
ENDIF

/* Initialize for depreciation calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

deprMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Method";
deprConvention = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Convention";
insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";
repairsCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Repairs %";

fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding %";
/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
  yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
  monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
  IF (monthVal < 0)
    IF (yearVal > 0)
      yearVal = yearVal - 1;
    ENDF
    monthVal = 1200 + monthVal;
  ENDF
  preExistingPers = yearVal * 12 + monthVal / 100;
  setStartDepr = 1;
ELSE
  preExistingPers = 0;
  setStartDepr = 0;
ENDIF

/* setup for depreciation */
numDeprPeriods = 0;
periodOffset = 0;

IF (deprMethod > 0)
  priorAccumDepr = 0;
  periodicPriorAccumDepr = 0;
  deprAmt = 0;

  /* Add a periodic vs annual property instead of additional deprMethods */
  /* Annual Methods SumYearDigits = 2, DecliningBalance Year = 3*/
  IF (deprMethod == 2 OR deprMethod == 3)
    isAnnual = 1;
    life = "No Year"->"Useful Life (in Years)";
    persInSection = "NumPeriods";
  ELSE /* Periodic Methods */
    isAnnual = 0;
    life = "No Year"->"Useful Life (in Years)" * "NumPeriods";
    persInSection = 1;
  ENDF

  yearVal = @INT(inServiceDate / 10000) * 10000;

  /* DecliningBalance methods */
  IF (deprMethod == 3 OR deprMethod == 4)
    /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
    deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
  ENDF

  /* Reset depr method to SLN convention to prorate 1st period for preExisting assets */
  IF (preExistingPers > 0)
    deprMethod = 1;
    deprConvention = 1;
  ENDF
ENDIF

ENDIF
ENDIF

/* Set Asset Status to active when we hit the end */
IF (@ISMBR("No Year") AND @ISMBR("BegBalance"))
  paramsSet = 0;
  IF ("Asset Status" == 0)
    "Asset Status" = 1;
ENDIF

/* Start depreciation calculations */
IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
  /* clear out any previously calculated values */
  "Depreciation" = #MISSING;
  "Accumulated Depreciation" = #MISSING;
  "Property, Plant and Equipment Gross" = #MISSING;
  "Loss/(Gain) on Sale of Property, Plant and Equipment" = #MISSING;
  "Proceeds from Sale of Property, Plant and Equipment" = #MISSING;

  "Cash Flow Allocator" = #MISSING;
  "Funding Allocator" = #MISSING;
  "Cash Outflow from Capital Additions" = #MISSING;
  "Cash Inflow from Funding" = #MISSING;
  "Long Term Debt" = #MISSING;
  "Insurance" = #MISSING;
  "Maintenance" = #MISSING;
  "Repairs" = #MISSING;
  "Retirement Expenses" = #MISSING;
  "Capital Expenditure" = #MISSING;

  IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    "Capital Expenditure" = basicCost - retirementObs;
ENDIF

/* Check if we should start setting cash flow impact values */
IF ("TP-Date" == cashOutflowDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
  setCashImpact = cashStaggeredPers;
  cashAllocPct = 1 / cashStaggeredPers;
ENDIF

/* Check if we should start setting funding values */
IF ("TP-Date" == fundingDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
  setFundingImpact = fundingStaggeredPers;
  fundingAllocPct = 1 / fundingStaggeredPers;
ENDIF

IF (setCashImpact > 0)
  "Cash Flow Allocator" = cashAllocPct;
  setCashImpact = setCashImpact - 1;
ENDIF
"Cash Outflow from Capital Additions" = basicCost * "Cash Flow Allocator";

IF (setFundingImpact > 0)
"Funding Allocator" = fundingAllocPct;
setFundingImpact = setFundingImpact - 1;
ENDIF
"Cash Inflow from Funding" = fundingAmt * "Funding Allocator";
"Long Term Debt" = fundingAmt * "Funding Allocator";

/* Check if we should start depreciation */
IF ((numDeprPeriods == 0) AND ("TP-Date" == inServiceDate) OR (setStartDepr == 1)
OR
(deprConvention == 4 AND "Fiscal TP-Index" == @INT("NumPeriods" / 2)+1) AND "TP-
Date" > yearVal))
setStartDepr = 0;
periodOffset = 0;
persIn1stYear = "NumPeriods"; /* not adjusted - "Cal TP-Index" + 1; */
numDeprPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in
Years)";
totDeprPeriods = numDeprPeriods;
dayVal = "No Year"->"BegBalance"->"In Service Date" - inServiceDate;
mouthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);
delayStart = 0;
IF (deprConvention == 2) /* Prorate Actual Date */
  IF (dayVal == 1) /* Treat same as Begin Period */
    split1stAmt = 0;
  ELSE
    numDeprPeriods = numDeprPeriods + 1;
    split1stAmt = 1;
  ENDIF
ELSEIF (deprConvention == 3) /* Mid Period */
  numDeprPeriods = numDeprPeriods + 1;
  split1stAmt = 1;
ELSEIF (deprConvention == 4) /* MidYear */
  split1stAmt = 0;
  delayStart = @INT("NumPeriods" / 2) - "Fiscal TP-Index" +1;
ELSE /* Prorate Begin Period */
  split1stAmt = 0;
ENDIF

/* Declining balance methods */
IF (deprMethod == 3 OR deprMethod == 4)
  /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
  deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

insuranceCost = insuranceCost / "NumPeriods";
maintenanceCost = maintenanceCost / "NumPeriods";
repairsCost = repairsCost / "NumPeriods";

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
  numDeprPeriods = numDeprPeriods - preExistingPers;
  IF (numDeprPeriods > 0)
    deprAmt = (basicCost - salvageVal) / totDeprPeriods;
    periodicPriorAccumDepr = deprAmt * preExistingPers;
  ENDIF
ENDIF

ENDIF

/* Calculate Depreciation amounts */
IF (deprMethod > 0 AND periodOffset < numDeprPeriods AND delayStart < 1)

  lifeIndex = @INT(periodOffset / persInSection);

  IF (deprMethod == 1) /* Straight Line */
      deprAmt = (basicCost - salvageVal) / totDeprPeriods;
  ELSEIF (deprMethod == 3 or deprMethod == 4) /* Declining Balance */
      IF (lifeIndex == 0)
          /* cost * rate * month / 12; for 1st period */
          deprAmt = basicCost * deprRate * persIn1stYear / 
                      "NumPeriods" / persInSection;
      ELSE /* (cost - total depreciation from prior periods) * rate; for all 
            middle periods */
          deprAmt = (basicCost - priorAccumDepr) * deprRate / persInSection;
      ENDIF
  ELSEIF (deprMethod == 2) /* Sum of Years Digits */
      deprRate = (life - lifeIndex) * 2 / (life * (life +1));
      deprAmt = (basicCost - salvageVal) * deprRate / persInSection;
  ENDIF

  IF (split1stAmt == 1)
      IF (deprConvention == 2)
          /* assume that there are 30 days in each month */
          deprAmt = deprAmt * @MAX(30 - dayVal, 1) / 30;
      ELSEIF (deprConvention == 4);
      ELSE
          deprAmt = deprAmt - deprAmt / 2;
      ENDIF
      split1stAmt = 0;
  ENDIF

  /* Adjust for rounding errors */
  IF (periodOffset + 1 == numDeprPeriods)
      deprAmt = (basicCost - salvageVal) - periodicPriorAccumDepr;
  ENDIF

  periodicPriorAccumDepr = periodicPriorAccumDepr + deprAmt;

  /* Use accumulated depr as first value for Mid-Year converntion */
  IF (deprConvention == 4 AND "TP-Date" == inServiceDate AND monthVal > 600)
      deprAmt = periodicPriorAccumDepr;
  ENDIF

  IF (isAnnual == 1)
      IF (@INT((periodOffset + 1) / persInSection) == (lifeIndex + 1))
          priorAccumDepr = periodicPriorAccumDepr;
      ENDIF
  ELSE
      priorAccumDepr = periodicPriorAccumDepr;
  ENDIF
/* Only assign values to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))

"Property, Plant and Equipment Gross" = basicCost;
"Depreciation" = deprAmt;
"Accumulated Depreciation" = periodicPriorAccumDepr;
"Insurance" = insuranceCost;
"Maintenance" = maintenanceCost;
"Repairs" = repairsCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR "No Year"->"BegBalance"->"Reason Ended" == 3)
netValue = basicCost - priorAccumDepr + retirementCosts;
IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
"Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue - saleValue + deprAmt;
ELSE
"Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue + deprAmt;
ENDIF
"Retirement Expenses" = retirementCosts - retirementObs;
"Proceeds from Sale of Property, Plant and Equipment" = saleValue - retirementCosts;
ENDIF
periodOffset = periodOffset +1;
ELSE
"Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue +
deprAmt;
ENDIF
branchEnd = branchEnd -1;
ENDIF
ENDIF

);
ENDFIX

ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [Department])
CALC DIM ("Period");
@ANCESTORS([LineItem]);
ANCESTORS([AssetClass]);
ENDFIX

---

**Remove Asset**

**Description**

Removes an asset.

**Formula**

SET UPDATECALC OFF;
SET AGGMISSG ON;

---

140  Capital Expense Planning Structure
Retire Asset

Description

Retires an asset.

Formula

SET CREATENONMISSINGBLK ON;
SET UPDATECALC OFF;
SET AGGMISSG ON;

VAR periodOffset = 0;
VAR deprMethod = 0;
VAR deprRate = 0;
VAR deprConvention = 0;
VAR numDeprPeriods = 0;
VAR totDeprPeriods = 0;
VAR persIn1stYear = 12;
VAR priorAccumDepr = 0;
VAR periodicPriorAccumDepr = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR deprAmt = 0;
VAR deprAmtLast = 0;
VAR persInSection = 0;
VAR life = 0;
VAR lifeIndex = 0;
VAR isAnnual = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR repairsCost = 0;
VAR retirementObserve = 0;
VAR retirementCosts = 0;
VAR cashOutflowDate = 0;
VAR fundingDate = 0;
VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR fundingAmt = 0;
VAR setCashImpact = 0;
VAR setFundingImpact = 0;
VAR retireOption = 0;
VAR saleValue = 0;
VAR netValue;
VAR yearVal;
VAR monthVal;
VAR dayVal;
VAR delayStart;
VAR split1stAmt;
VAR paramsSet = 0;
VAR isNew = 0;
VAR cashflowChanged = 0;
VAR fundingChanged = 0;
VAR preExistingPers = 0;
VAR setStartDepr = 0;

FIX([LineItem], [AssetClass], [Hidden_Scenario], [Hidden_Version], [Department])

FIX("No Year", "BegBalance")
"Asset Description" (  
IF ("Asset Status" >= 0)  
  "Premature End Date" = [RetireDate];  
  "Retirement Options" = [RetireOption];  
  IF ("Retirement Options" == 1)  
    "Reason ended" = 3;  
  ELSE  
    "Reason ended" = 2;  
ENDIF  
"Sale Value" = [SaleValue];  
"Retirement Costs" = [RetirementCosts];  
  "Basic Cost" = "Asset Units" * "Asset Rate" + ("Asset Units" * "Asset Rate" * "Taxes %") + "Freight" + "Additional Charges" + "Retirement Obligation" + "Installation";  
  "Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";  
  "Salvage" = "Salvage Input" * "Asset Units";  
IF ("In Service Date" < "Purchase Date")  
  "In Service Date" = "Purchase Date";
ENDIF
)
ENDFIX

/* Depreciation section */
FIX (@LEVMBRS("Period", 0), @LEVMBRS("Year", 0))  
"Depreciation"(  
IF ("No Year"->"BegBalance"->"Asset Status" >= 0)
IF (@ISMBR("BegBalance") AND paramsSet == 0)
paramsSet = 1;
/* Check if we are a descendant of a new Asset */
IF (@ISDESC("Total New"))
isNew = 1;
ELSE
    isNew = 0;
ENDIF

/* Initialized all the variables required to calculate depreciation */
/* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
cashOutflowDate = purchaseDate;
fundingDate = purchaseDate;

cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->
                    "Cash Flow Incidence";
IF (cashFlowIncidence <> "No Year"->"Cash Flow Incidence")
    cashflowChanged = 1;
ELSE
    cashflowChanged = 0;
ENDIF

IF (cashFlowIncidence == -1 AND cashflowChanged == 1)
    cashStaggeredPers = 4;
ELSE
    /* Extract year and month from date to adjust based in incidence values in
global assumptions */
    yearVal = @INT(cashOutflowDate / 10000) * 10000;
    monthVal = cashOutflowDate - yearVal;
    monthVal = monthVal + cashFlowIncidence;

    IF (monthVal <= 0)
        yearVal = yearVal - 10000;
        monthVal = 1200 + monthVal;
    ELSEIF (monthVal > 1200)
        yearVal = yearVal + 10000;
        monthVal = monthVal - 1200;
    ENDIF

    cashOutflowDate = yearVal + monthVal;
    cashStaggeredPers = 1;
ENDIF

fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->
                   "Funding Incidence";
IF (fundingIncidence <> "No Year"->"Funding Incidence")
    fundingChanged = 1;
ELSE
    fundingChanged = 0;
ENDIF

IF (fundingIncidence == -1 AND fundingChanged == 1)
    fundingStaggeredPers = 4;
ELSE
    yearVal = @INT(fundingDate / 10000) * 10000;
    monthVal = fundingDate - yearVal;
monthVal = monthVal + fundingIncidence;

IF (monthVal <= 0)
    yearVal = yearVal - 10000;
    monthVal = 1200 + monthVal;
ELSEIF (monthVal > 1200)
    yearVal = yearVal + 10000;
    monthVal = monthVal - 1200;
ENDIF

fundingDate = yearVal + monthVal;
fundingStaggeredPers = 1;
ENDIF

/* Initialize for depreciation calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

deprMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Method";
deprConvention = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Convention";
insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";
reparCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Repairs %";

fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding %";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
    yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
    monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
    IF (monthVal < 0)
        IF (yearVal > 0)
            yearVal = yearVal - 1;
        ENDIF
    mothVal = 1200 + monthVal;
ENDIF
preExistingPers = yearVal * 12 + monthVal / 100;
setStartDepr = 1;
ELSE
    preExistingPers = 0;
    setStartDepr = 0;
ENDIF

/* setup for depreciation */
umDeprPeriods = 0;
periodOffset = 0;

144  Capital Expense Planning Structure
IF (deprMethod > 0)
    priorAccumDepr = 0;
    periodicPriorAccumDepr = 0;
    deprAmt = 0;
    /* Add a periodic vs. annual property instead of additional deprMethods */
    /* Annual Methods SumYearDigits =2 DecliningBalance Year = 3*/
    IF (deprMethod == 2 OR deprMethod == 3)
        isAnnual = 1;
        life = "No Year"->"Useful Life (in Years)";
        persInSection = "NumPeriods";
    ELSE  /* Periodic Methods */
        isAnnual = 0;
        life = "No Year"->"Useful Life (in Years)" * "NumPeriods";
        persInSection = 1;
    ENDIF
ENDIF

setCashImpact = 0;
setFundingImpact = 0;
yearVal = @INT(inServiceDate / 10000) * 10000;

/* DecliningBalance methods */
IF (deprMethod == 3 OR deprMethod == 4)
    /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
    deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

/* Reset depr method to SLN convention to prorate 1st period for preExisting
   assets */
IF (preExistingPers > 0)
    deprMethod = 1;
    deprConvention = 1;
ENDIF

ENDIF

IF (@ISMBR("No Year"))
    paramsSet = 0;
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
    /* clear out any previously calculated values */
    "Depreciation" = #MISSING;
    "Accumulated Depreciation" = #MISSING;
    "Property, Plant and Equipment Gross" = #MISSING;
    "Loss/(Gain) on Sale of Property, Plant and Equipment" = #MISSING;
    "Proceeds from Sale of Property, Plant and Equipment" = #MISSING;
    IF (cashFlowIncidence <> -1 OR cashflowChanged == 1)
        "Cash Flow Allocator" = #MISSING;
    ENDIF
    IF (fundingIncidence <> -1 OR fundingChanged == 1)
        "Funding Allocator" = #MISSING;
    ENDIF
    "Cash Outflow from Capital Additions" = #MISSING;
ENDIF
/* Check if we should start setting cash flow impact values */
IF (isNew == 1)
  IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate >
#MISSING AND "TP-Date" > delayedStartDate)))
    "Capital Expenditure" = basicCost - retirementObs;
  ENDIF
  IF ("TP-Date" == cashOutflowDate AND (delayedStartDate == #MISSING OR
(delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    setCashImpact = cashStaggeredPers;
    cashAllocPct = 1 / cashStaggeredPers;
  ENDIF
  /* Check if we should start setting funding values */
  IF ("TP-Date" == fundingDate AND (delayedStartDate == #MISSING OR (delayedStartDate
> #MISSING AND "TP-Date" > delayedStartDate)))
    setFundingImpact = fundingStaggeredPers;
    fundingAllocPct = 1 / fundingStaggeredPers;
  ENDIF
  IF (setCashImpact > 0)
    "Cash Flow Allocator" = cashAllocPct;
    setCashImpact = setCashImpact - 1;
  ENDIF
  "Cash Outflow from Capital Additions" = basicCost * "Cash Flow Allocator";
  IF (setFundingImpact > 0)
    "Funding Allocator" = fundingAllocPct;
    setFundingImpact = setFundingImpact - 1;
  ENDIF
  "Cash Inflow from Funding" = fundingAmt * "Funding Allocator";
  "Long Term Debt" = fundingAmt * "Funding Allocator";
ENDIF
/* Check if we should start depreciation */
IF ((numDeprPeriods == 0) AND ("TP-Date" == inServiceDate) OR (setStartDepr == 1)
OR (deprConvention == 4 AND "Fiscal TP-Index" == @INT("NumPeriods" / 2)+1) AND "TP-
Date" > yearVal))
  setStartDepr = 0;
  periodOffset = 0;
  persIn1stYear = "NumPeriods";
  numDeprPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in
Years)";
  totDeprPeriods = numDeprPeriods;
dayVal = "No Year"->"BegBalance"->"In Service Date" - inServiceDate;
monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);

delayStart = 0;
IF (deprConvention == 2) /* Prorate Actual Date */
   IF (dayVal == 1) /* Treat same as Begin Period */
      split1stAmt = 0;
   ELSE
      numDeprPeriods = numDeprPeriods + 1;
      split1stAmt = 1;
   ENDIF
ELSEIF (deprConvention == 3) /* Mid Period */
   numDeprPeriods = numDeprPeriods + 1;
   split1stAmt = 1;
ELSEIF (deprConvention == 4) /* MidYear */
   split1stAmt = 0;
   delayStart = @INT("NumPeriods" / 2) - "Fiscal TP-Index" + 1;
ELSE /* Prorate Begin Period */
   split1stAmt = 0;
ENDIF

IF (deprMethod == 3 OR deprMethod == 4)
   /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
   deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

insuranceCost = insuranceCost / "NumPeriods";
maintenanceCost = maintenanceCost / "NumPeriods";
repairsCost = repairsCost / "NumPeriods";

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
   numDeprPeriods = numDeprPeriods - preExistingPers;
   IF (numDeprPeriods > 0)
      deprAmt = (basicCost - salvageVal) / totDeprPeriods;
      periodicPriorAccumDepr = deprAmt * preExistingPers;
   ENDIF
ENDIF

ENDIF

/* Depreciation calcuation section */
IF (deprMethod > 0 AND periodOffset < numDeprPeriods AND delayStart < 1)
   lifeIndex = @INT(periodOffset / persInSection);
   IF (deprMethod == 1) /* Straight Line */
      deprAmt = (basicCost - salvageVal) / totDeprPeriods;
   ELSEIF (deprMethod == 3 or deprMethod == 4) /* Declining Balance */
      IF (lifeIndex == 0)
         /* cost * rate * month / 12; for 1st period */
         deprAmt = basicCost * deprRate * persIn1stYear / "NumPeriods" / persInSection;
      ELSE /* (cost - total depreciation from prior periods) * rate; for all middle periods */
         deprAmt = (basicCost - priorAccumDepr) * deprRate / persInSection;
      ENDIF
   ENDIF
ENDIF
ENDIF
ELSEIF (deprMethod == 2) /* Sum of Years Digits */
    deprRate = (life - lifeIndex) * 2 / (life * (life +1));
    deprAmt = (basicCost - salvageVal) * deprRate / persInSection;
ENDIF

IF (split1stAmt == 1)
    IF (deprConvention == 2)
        /* assume that there are 30 days in each month */
        deprAmt = deprAmt * @MAX(30 - dayVal, 1) / 30;
    ELSEIF (deprConvention == 4)
        ;
    ELSE
        deprAmt = deprAmt - deprAmt / 2;
    ENDIF
    split1stAmt = 0;
ENDIF

/* Adjust for rounding errors */
IF (periodOffset + 1 == numDeprPeriods)
    deprAmt = (basicCost - salvageVal) - periodicPriorAccumDepr;
ENDIF

periodicPriorAccumDepr = periodicPriorAccumDepr + deprAmt;

/* Use accumulated depr as first value for Mid-Year conversion */
IF (deprConvention == 4 AND "TP-Date" == inServiceDate AND monthVal > 600)
    deprAmt = periodicPriorAccumDepr;
ENDIF

IF (isAnnual == 1)
    IF (@INT((periodOffset + 1) / persInSection) == (lifeIndex + 1))
        priorAccumDepr = periodicPriorAccumDepr;
    ENDIF
ELSE
    priorAccumDepr = periodicPriorAccumDepr;
ENDIF

/* Only assign to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
    "Property, Plant and Equipment Gross" = basicCost;
    "Depreciation" = deprAmt;
    "Accumulated Depreciation" = periodicPriorAccumDepr;
    "Insurance" = insuranceCost;
    "Maintenance" = maintenanceCost;
    "Repairs" = repairsCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
    IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR
        "No Year"->"BegBalance"->"Reason Ended" == 3)
        netValue = basicCost - priorAccumDepr + retirementCosts;
    IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
        "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue -
saleValue + deprAmt;
ELSE
   "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue +
deprAmt;
ENDIF
   "Retirement Expenses" = retirementCosts - retirementObs;
   "Proceeds from Sale of Property, Plant and Equipment" = saleValue -
retirementCosts;
ENDIF
   periodOffset = periodOffset +1;
ENDIF
   delayStart = delayStart -1;
ENDIF

ENDIF

); ENDFIX

FIX("BegBalance", "No Year")
"Cash Flow Incidence" ( 
   IF (cashflowChanged == 1 AND "Asset Status" > 0)
      "Cash Flow Incidence" = cashFlowIncidence;
   ENDIF
   IF (fundingChanged == 1 AND "Asset Status" > 0)
      "Funding Incidence" = fundingIncidence;
   ENDIF
)
ENDFIX

ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [Department])
   CALC DIM("Period");
   @ANCESTORS([LineItem]);
   @ANCESTORS([AssetClass]);
ENDFIX

---

**Retire Intangible**

**Description**

Retires an intangible asset.

**Formula**

```r
SET CREATENONMISSINGBLK ON;

VAR periodOffset = 0;
VAR amortMethod = 0;
VAR numAmortPeriods = 0;
VAR priorAccumAmort = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR amortAmt = 0;
VAR retirementCosts = 0;
VAR retirementObs = 0;
```
VAR impairmentDate1 = 0;
VAR impairmentDate2 = 0;
VAR impairmentFairVal1 = 0;
VAR impairmentFairVal2 = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR cashOutflowDate = 0;
VAR fundingDate = 0;
VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR fundingAmt = 0;
VAR setCashImpact = 0;
VAR setFundingImpact = 0;
VAR capitalizePct = 0;
VAR impairmentOpt = 1;
VAR numRemainingPers = 0;
VAR intangibleNet = 0;
VAR netValue = 0;
VAR saleValue = 0;
VAR yearVal = 0;
VAR monthVal = 0;
VAR paramsSet = 0;
VAR isNew = 0;
VAR cashflowChanged = 0;
VAR fundingChanged = 0;
VAR preExistingPers = 0;
VAR setStartAmort = 0;

FIX([LineItem], [Hidden_Scenario], [Hidden_Version], [Department], [AssetClassInt])

FIX("No Year", "BegBalance")
" Asset Description" (  
IF ("Asset Status" >= 0)  
"Premature End Date" = [RetireDate];  
"Retirement Options" = [RetireOption];  
IF ("Retirement Options" == 1)  
"Reason ended" = 3;  
ELSE  
"Reason ended" = 2;  
ENDIF  
"Sale Value" = [SaleValue];  
"Retirement Costs" = [RetirementCosts];  
IF ("In Service Date" < "Purchase Date")  
"In Service Date" = "Purchase Date";  
ENDIF  
"Basic Cost" = "Acquisition Costs" + "Additional Charges";  
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Salvage" = "Salvage Input" * "Asset Units";
ENDIF
);
ENDFIX

/* Amortization section */
FIX (@LEVMBRS("Period", 0) @LEVMBRS("Year", 0))
"Amortization"

/* Only calc valid asset line items */
IF (*No Year"->"BegBalance"->"Asset Status" >= 0)
IF (@ISMBR("BegBalance") AND paramsSet == 0)
/* Initialized all the variables required to calculate depreciation */
paramsSet = 1;
/* Check if we are a descendant of a new Asset */
IF (@ISDESC("Total New"))
isNew = 1;
ELSE
isNew = 0;
ENDIF

/* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
cashOutflowDate = purchaseDate;
fundingDate = purchaseDate;

cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->
"Cash Flow Incidence";

IF (cashFlowIncidence <> "No Year"->"Cash Flow Incidence")
cashflowChanged = 1;
ELSE
cashflowChanged = 0;
ENDIF

IF (cashFlowIncidence == -1 AND cashflowChanged == 1)
cashStaggeredPers = 4;
ELSE
/* Extract year and month from date to adjust based in incidence values in
global assumptions */
yearVal = @INT(cashOutflowDate / 10000) * 10000;
monthVal = cashOutflowDate - yearVal;
monthVal = monthVal + cashFlowIncidence;

IF (monthVal <= 0)
yearVal = yearVal - 10000;
monthVal = 12000 + monthVal;
ELSEIF (monthVal > 1200)
yearVal = yearVal + 10000;
monthVal = monthVal - 1200;
ENDIF
cashOutflowDate = yearVal + monthVal;
cashStaggeredPers = 1;
ENDIF

fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";

IF (fundingIncidence <> "No Year"->"Funding Incidence")
fundingChanged = 1;
ELSE
fundingChanged = 0;
ENDIF

IF (fundingIncidence == -1 AND fundingChanged == 1)
fundingStaggeredPers = 4;
ELSE
yearVal = @INT(fundingDate / 10000) * 10000;
monthVal = fundingDate - yearVal;
monthVal = monthVal + fundingIncidence;

IF (monthVal <= 0)
yearVal = yearVal - 10000;
monthVal = 1200 + monthVal;
ELSEIF (monthVal > 1200)
yearVal = yearVal + 10000;
monthVal = monthVal - 1200;
ENDIF

fundingDate = yearVal + monthVal;
fundingStaggeredPers = 1;
ENDIF

/* Initialize for amortization calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
impairmentOpt = "No Year"->"Impairment Option";
capitalizePct = "No Year"->"Partial Capitalize %";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

amortMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Amortization Method";
insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";

fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding %";

IF ("No Year"->"Impairment Date1" <> #MISSING)
impairmentDate1 = @INT("No Year"->"Impairment Date1" / 100) * 100;
ELSE
impairmentDate1 = #MISSING;
ENDIF
IF ("No Year"->"Impairment Date2" <> #MISSING)
  impairmentDate2 = @INT("No Year"->"Impairment Date2" / 100) * 100;
ELSE
  impairmentDate2 = #MISSING;
ENDIF

impairmentFairVal1 = "No Year"->"Impairment Fair Value1";
impairmentFairVal2 = "No Year"->"Impairment Fair Value2";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
  yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
  monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
  IF (monthVal < 0)
    IF (yearVal > 0)
      yearVal = yearVal - 1;
    ENDIF
    monthVal = 1200 + monthVal;
  ENDIF
  preExistingPers = @ROUND(yearVal * 12 + monthVal / 100, 0);
 ELSE
  preExistingPers = 0;
  setStartAmort = 0;
 ENDIF

numAmortPeriods = 0;
periodOffset = 0;

IF (amortMethod == 1)
  priorAccumAmort = 0;
  amortAmt = 0;
  setCashImpact = 0;
  setFundingImpact = 0;
  yearVal = @INT(inServiceDate / 10000) * 10000;
  monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);
ENDIF

ENDIF

IF (@ISMBR("No Year"))
  paramsSet = 0;
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
  /* clear out any previously calculated values */
  "Amortization" = #MISSING;
  "Accumulated Amortization" = #MISSING;
  "Intangible Assets Finite, Gross" = #MISSING;
  "Loss/(Gain) on Sale of Intangibles" = #MISSING;
  "Proceeds from Sale of Intangibles" = #MISSING;
  IF (cashFlowIncidence <> -1 OR cashflowChanged == 1)
    "Cash Flow Allocator" = #MISSING;
ENDIF
ENDIF
IF (fundingIncidence <> -1 OR fundingChanged == 1)
   "Funding Allocator" = #MISSING;
ENDIF
"Cash Outflow from Capital Additions" = #MISSING;
"Cash Inflow from Funding" = #MISSING;
"Long Term Debt" = #MISSING;
"Insurance" = #MISSING;
"Maintenance" = #MISSING;
"Impairment of Assets" = #MISSING;
"Capital Reserve" = #MISSING;
"Capital Expenditure" = #MISSING;
"Retirement Expenses" = #MISSING;

IF (isNew == 1)
   IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
      "Capital Expenditure" = basicCost - retirementObs;
   ENDIF
   IF ("TP-Date" == cashOutflowDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
      setCashImpact = cashStaggeredPers;
      cashAllocPct = 1 / cashStaggeredPers;
   ENDIF
   IF ("TP-Date" == fundingDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
      setFundingImpact = fundingStaggeredPers;
      fundingAllocPct = 1 / fundingStaggeredPers;
   ENDIF
   IF (setCashImpact > 0)
      "Cash Flow Allocator" = cashAllocPct;
      setCashImpact = setCashImpact - 1;
   ENDIF
   "Cash Outflow from Capital Additions" = basicCost * "Cash Flow Allocator";
   IF (setFundingImpact > 0)
      "Funding Allocator" = fundingAllocPct;
      setFundingImpact = setFundingImpact - 1;
   ENDIF
   "Cash Inflow from Funding" = fundingAmt * "Funding Allocator";
   "Long Term Debt" = fundingAmt * "Funding Allocator";
ENDIF

/* Check if we should start amortization */
IF ("TP-Date" == inServiceDate OR (setStartAmort == 1))
   setStartAmort = 0;
   periodOffset = 0;
   numAmortPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in Years)";
   insuranceCost = insuranceCost / "NumPeriods";
   maintenanceCost = maintenanceCost / "NumPeriods";
intangibleNet = basicCost;
amortAmt = (basicCost - salvageVal) / numAmortPeriods;

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
    numAmortPeriods = numAmortPeriods - preExistingPers;
    IF (numAmortPeriods > 0)
        priorAccumAmort = amortAmt * preExistingPers;
    ENDIF
ENDIF

numRemainingPers = numAmortPeriods;
ENDIF

/* Amortization calculation section */
IF (amortMethod == 1 AND periodOffset < numAmortPeriods)

/* If capitalized book in Capital Reserve instead of Impairment */
IF ("TP-Date" == impairmentDate1)
    IF (impairmentOpt == 1)
        "Impairment of Assets" = intangibleNet - impairmentFairVal1;
    ELSEIF (impairmentOpt == 2)
        "Capital Reserve" = intangibleNet - impairmentFairVal1;
    ELSEIF (impairmentOpt == 3)
        "Capital Reserve" = (intangibleNet - impairmentFairVal1) * capitalizePct;
        "Impairment of Assets" = intangibleNet - impairmentFairVal1 - "Capital Reserve";
    ENDIF
    basicCost = basicCost - (intangibleNet - impairmentFairVal1);
    amortAmt = impairmentFairVal1 / numRemainingPers;
ELSEIF ("TP-Date" == impairmentDate2)
    IF (impairmentOpt == 1)
        "Impairment of Assets" = intangibleNet - impairmentFairVal2;
    ELSEIF (impairmentOpt == 2)
        "Capital Reserve" = intangibleNet - impairmentFairVal2;
    ELSEIF (impairmentOpt == 3)
        "Capital Reserve" = (intangibleNet - impairmentFairVal2) * capitalizePct;
        "Impairment of Assets" = intangibleNet - impairmentFairVal2 - "Capital Reserve";
    ENDIF
    basicCost = basicCost - (intangibleNet - impairmentFairVal2);
    amortAmt = impairmentFairVal2 / numRemainingPers;
ENDIF

IF (periodOffset + 1 == numAmortPeriods)
    amortAmt = (basicCost - salvageVal) - priorAccumAmort;
ENDIF

priorAccumAmort = priorAccumAmort + amortAmt;
intangibleNet = basicCost - priorAccumAmort;

/* Only assign values to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
"Intangible Assets Finite, Gross" = basicCost;
"Amortization" = amortAmt;
"Accumulated Amortization" = priorAccumAmort;
"Insurance" = insuranceCost;
"Maintenance" = maintenanceCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
  IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR
    "No Year"->"BegBalance"->"Reason Ended" == 3)
    netValue = basicCost - priorAccumAmort + retirementCosts;
  IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
    "Loss/(Gain) on Sale of Intangibles" = netValue - saleValue +
    amortAmt;
  ELSE
    "Loss/(Gain) on Sale of Intangibles" = netValue + amortAmt;
  ENDIF
  "Retirement Expenses" = retirementCosts - retirementObs;
  "Proceeds from Sale of Intangibles" = saleValue - retirementCosts;
ENDIF
ENDIF

periodOffset = periodOffset +1;
numRemainingPers = numRemainingPers -1;
ENDIF
ENDIF
ENDIF
ENDFIX

FIX ("BegBalance", "No Year")
"Cash Flow Incidence" (  
  IF (cashflowChanged == 1 AND "Asset Status" > 0)
    "Cash Flow Incidence" = cashFlowIncidence;
  ENDIF
  IF (fundingChanged == 1 AND "Asset Status" > 0)
    "Funding Incidence" = fundingIncidence;
  ENDIF
)
ENDFIX

ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [Department])
@IANCESTORS([LineItem]);
@ANCESTORS([AssetClassInt]);
ENDFIX

**RollupAssetEntities**

**Description**

Rolls up assets by Entities.
Formula

SET AGGMISSG ON;

FIX ([Scenario], [Version])
    CALC DIM ("Entity");
ENDFIX

**RollupAssets**

**Description**
Rolls up assets.

**Formula**

SET AGGMISSG ON;

FIX ([Scenario], [Version], [Department])
    CALC DIM ("Account", "Period", "Asset Class", "Line Item");
ENDFIX

**Transfer Asset**

**Description**
Transfers a new asset.

**Formula**

SET CREATENONMISSINGBLK ON;
SET UPDATECALC OFF;
SET AGGMISSG ON;

VAR periodOffset = 0;
VAR deprMethod = 0;
VAR deprRate = 0;
VAR deprConvention = 0;
VAR numDeprPeriods = 0;
VAR totDeprPeriods = 0;
VAR persIn1stYear = 12;
VAR priorAccumDepr = 0;
VAR periodicPriorAccumDepr = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR deprAmt = 0;
VAR deprAmtLast = 0;
VAR persInSection = 0;
VAR life = 0;
VAR lifeIndex = 0;
VAR isAnnual = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR repairsCost = 0;
VAR retirementObs = 0;
VAR cashOutflowDate = 0;
VAR fundingDate = 0;
VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR fundingAmt = 0;
VAR setCashImpact = 0;
VAR setFundingImpact = 0;
VAR retireOption = 0;
VAR saleValue = 0;
VAR xferAsset = 0;
VAR paramsSet = 0;
VAR netValue;
VAR yearVal;
VAR monthVal;
VAR dayVal;
VAR delayStart;
VAR split1stAmt;
VAR cashflowChanged = 0;
VAR fundingChanged = 0;
VAR preExistingPers = 0;
VAR setStartDepr = 0;

/* Transfer section: Locate either an asset with same Asset ID or a new one for transfer */
FIX(@CHILDREN("Total New"), [Hidden_Scenario], [Hidden_Version], [DepartmentTo], [AssetClass], "No Year", "BegBalance")
"Asset Description" ( 
IF (NOT @ISMBR([DepartmentFrom]))

   IF (@MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING) OR ("Asset ID" == [DepartmentFrom]->[SrcLineItem]->"Asset ID" AND [DepartmentFrom]->[SrcLineItem]->"Asset ID" <> #MISSING)
      "Asset Status" = -1; /* mark line item for deletion */
ELSE
   xferAsset = 1;
   "Asset Status" = 0;
   "Asset ID" = [DepartmentFrom]->[SrcLineItem]->"Asset ID";
   "Asset Description" = [DepartmentFrom]->[SrcLineItem]->"Asset Description";
   "CAR No." = [DepartmentFrom]->[SrcLineItem]->"CAR No.";
"Justification" = [DepartmentFrom] -> [SrcLineItem] -> "Justification";
"Physical Location" = [DepartmentFrom] -> [SrcLineItem] -> "Physical Location";
"UOM" = [DepartmentFrom] -> [SrcLineItem] -> "UOM";
"Priority" = [DepartmentFrom] -> [SrcLineItem] -> "Priority";

"Asset Units" = [DepartmentFrom] -> [SrcLineItem] -> "Asset Units";
"Asset Rate" = [DepartmentFrom] -> [SrcLineItem] -> "Asset Rate";
"Installation" = [DepartmentFrom] -> [SrcLineItem] -> "Installation";
"Freight" = [DepartmentFrom] -> [SrcLineItem] -> "Freight";
"Salvage Input" = [DepartmentFrom] -> [SrcLineItem] -> "Salvage Input";
"Taxes %" = [DepartmentFrom] -> [SrcLineItem] -> "Taxes %"
"Additional Charges" = [DepartmentFrom] -> [SrcLineItem] -> "Additional Charges";
"Retirement Obligation" = [DepartmentFrom] -> [SrcLineItem] -> "Retirement Obligation";
"Retirement Options" = [DepartmentFrom] -> [SrcLineItem] -> "Retirement Options";
"Partial Capitalize %" = [DepartmentFrom] -> [SrcLineItem] -> "Partial Capitalize %";
"Basic Cost" = "Asset Units" * "Asset Rate" + ("Asset Units" * "Asset Rate" * "Taxes %") + "Freight" + "Additional Charges" + "Retirement Obligation" + "Installation";
"Useful Life (in Years)" = "No Scenario" -> "No Version" -> "No Entity" -> "Global" -> "Useful Life (in Years)";
"Salvage" = "Salvage Input" * "Asset Units";

"Cash Flow Incidence" = "No Year" -> "No Scenario" -> "No Version" -> "No Entity" -> "Global" -> "Cash Flow Incidence";
"Funding Incidence" = "No Year" -> "No Scenario" -> "No Version" -> "No Entity" -> "Global" -> "Funding Incidence";
"Purchase Date" = [DepartmentFrom] -> [SrcLineItem] -> "Purchase Date";
"In Service Date" = [DepartmentFrom] -> [SrcLineItem] -> "In Service Date";

IF ("In Service Date" < "Purchase Date"
    "In Service Date" = "Purchase Date";
ENDIF

"Delayed Start Date" = [TransferDate];
"Reason Delayed" = 1;

ENDIF

ELSEIF (xferAsset == 0 AND @MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING)

xferAsset = 1;
"Asset Status" = 0;
"Asset ID" = [DepartmentFrom] -> [SrcLineItem] -> "Asset ID";
"Asset Description" = [DepartmentFrom] -> [SrcLineItem] -> "Asset Description";
"CAR No." = [DepartmentFrom] -> [SrcLineItem] -> "CAR No.";
"Justification" = [DepartmentFrom] -> [SrcLineItem] -> "Justification";
"Physical Location" = [DepartmentFrom] -> [SrcLineItem] -> "Physical Location";
"UOM" = [DepartmentFrom] -> [SrcLineItem] -> "UOM";
"Priority" = [DepartmentFrom] -> [SrcLineItem] -> "Priority";

"Asset Units" = [DepartmentFrom] -> [SrcLineItem] -> "Asset Units";
"Asset Rate" = [DepartmentFrom] -> [SrcLineItem] -> "Asset Rate";
"Installation" = [DepartmentFrom] -> [SrcLineItem] -> "Installation";
"Freight" = [DepartmentFrom] -> [SrcLineItem] -> "Freight";
"Salvage Input" = [DepartmentFrom]->[SrcLineItem]->"Salvage Input";
"Taxes %" = [DepartmentFrom]->[SrcLineItem]->"Taxes %";
"Additional Charges" = [DepartmentFrom]->[SrcLineItem]->"Additional Charges";
"Retirement Obligation" = [DepartmentFrom]->[SrcLineItem]->"Retirement Options";
"Partial Capitalize %" = [DepartmentFrom]->[SrcLineItem]->"Partial Capitalize %";
"Basic Cost" = "Asset Units" * "Asset Rate" + ("Asset Units" * "Asset Rate" * "Taxes %") + "Freight" + "Additional Charges" + "Retirement Obligation" + "Installation";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Salvage" = "Salvage Input" * "Asset Units";
"Cash Flow Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";
"Funding Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";
"Purchase Date" = [DepartmentFrom]->[SrcLineItem]->"Purchase Date";
"In Service Date" = [DepartmentFrom]->[SrcLineItem]->"In Service Date";
IF ("In Service Date" < "Purchase Date")
   "In Service Date" = "Purchase Date";
ENDIF
"Delayed Start Date" = [TransferDate];
"Reason Delayed" = 1;
ENDIF
ENDIF
ENDIF
ENDFIX
FIX([[Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [AssetClass], [SrcLineItem], "No Year", "BegBalance"])
"Premature End Date" (IF (xferAsset == 1)
   "Asset Status" = 0; /* set status to new to trigger recalc below */
   "Premature End Date" = [TransferDate];
   "Reason Ended" = 1;
   "Sale Value" = #MISSING;
) ENDIF
ENDFIX
/* Calculate depreciation after transfer */
FIX(@DESCENDANTS("Total New"), [AssetClass], [Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [DepartmentTo])
FIX (@LEVMBRS("Period", 0), @LEVMBRS("Year", 0))
"Depreciation"(IF ("No Year"->"BegBalance"->"Asset Status" == 0)
IF (@ISMBR("BegBalance") AND paramsSet == 0)
paramsSet = 1;
IF ("No Year"->"In Service Date" < "No Year"->"Purchase Date")
    "No Year"->"In Service Date" = "No Year"->"Purchase Date";
ENDIF

/* Initialized all the variables required to calculate depreciation */
/* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
cashOutflowDate = purchaseDate;
fundingDate = purchaseDate;

    cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";

    IF (cashFlowIncidence <> "No Year"->"Cash Flow Incidence")
        cashflowChanged = 1;
    ELSE
        cashflowChanged = 0;
    ENDIF

    IF (cashFlowIncidence == -1 AND cashflowChanged == 1)
        cashStaggeredPers = 4;
    ELSE
        /* Extract year and month from date to adjust based in incidence values in global assumptions */
        yearVal = @INT(cashOutflowDate / 10000) * 10000;
        monthVal = cashOutflowDate - yearVal;
        monthVal = monthVal + cashFlowIncidence;

        IF (monthVal <= 0)
            yearVal = yearVal - 10000;
            monthVal = 12000 + monthVal;
        ELSEIF (monthVal > 12000)
            yearVal = yearVal + 10000;
            monthVal = monthVal - 12000;
        ENDIF

        cashOutflowDate = yearVal + monthVal;
        cashStaggeredPers = 1;
    ENDIF

    fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";

    IF (fundingIncidence <> "No Year"->"Funding Incidence")
        fundingChanged = 1;
    ELSE
        fundingChanged = 0;
    ENDIF

    IF (fundingIncidence == -1 AND fundingChanged == 1)
        fundingStaggeredPers = 4;
    ELSE
        yearVal = @INT(fundingDate / 10000) * 10000;
        monthVal = fundingDate - yearVal;
    ENDIF
monthVal = monthVal + fundingIncidence;

IF (monthVal <= 0)
    yearVal = yearVal - 10000;
    monthVal = 1200 + monthVal;
ELSEIF (monthVal > 1200)
    yearVal = yearVal + 10000;
    monthVal = monthVal - 1200;
ENDIF

fundingDate = yearVal + monthVal;
fundingStaggeredPers = 1;
ENDIF

/* Initialize for depreciation calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

depMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Method";
depConvention = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Convention";
insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";
repairsCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Repairs %";

fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding %";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
    yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
    monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
    IF (monthVal < 0)
        IF (yearVal > 0)
            yearVal = yearVal - 1;
        ENDIF
        monthVal = 1200 + monthVal;
    ENDIF
    preExistingPers = yearVal * 12 + monthVal / 100;
    setStartDepr = 1;
ELSE
    preExistingPers = 0;
    setStartDepr = 0;
ENDIF

/* setup for depreciation */
umDeprPeriods = 0;
periodOffset = 0;
IF (deprMethod > 0)
    priorAccumDepr = 0;
    periodicPriorAccumDepr = 0;
    deprAmt = 0;
/* Add a periodic vs annual property instead of additional deprMethods */
/* Annual Methods SumYearDigits =2 DecliningBalance Year = 3*/
IF (deprMethod == 2 OR deprMethod == 3)
    isAnnual = 1;
    life = "No Year"->"Useful Life (in Years)";
    persInSection = "NumPeriods";
ELSE /* Periodic Methods */
    isAnnual = 0;
    life = "No Year"->"Useful Life (in Years)" * "NumPeriods";
    persInSection = 1;
ENDIF

setCashImpact = 0;
setFundingImpact = 0;
yearVal = @INT(inServiceDate / 10000) * 10000;

/* DecliningBalance methods */
IF (deprMethod == 3 OR deprMethod == 4)
    /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
    deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

/* Reset depr method to SLN convention to prorate 1st period for preExisting assets */
IF (preExistingPers > 0)
    deprMethod = 1;
    deprConvention = 1;
ENDIF

ENDIF

IF (@ISMBR("No Year") AND @ISMBR("BegBalance"))
    paramsSet = 0;
    IF ("Asset Status" == 0)
        "Asset Status" = 1;
    ENDIF
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
    /* clear out any previously calculated values */
    "Depreciation" = #MISSING;
    "Accumulated Depreciation" = #MISSING;
    "Property, Plant and Equipment Gross" = #MISSING;
    "Loss/(Gain) on Sale of Property, Plant and Equipment" = #MISSING;
    "Proceeds from Sale of Property, Plant and Equipment" = #MISSING;
    IF (cashFlowIncidence <> -1 OR cashflowChanged == 1)
        "Cash Flow Allocator" = #MISSING;
    ENDIF
    IF (fundingIncidence <> -1 OR fundingChanged == 1)
        /* Add other funding related conditions */
    ENDIF
ENDIF
"Funding Allocator" = #MISSING;
ENDIF
"Cash Outflow from Capital Additions" = #MISSING;
"Cash Inflow from Funding" = #MISSING;
"Long Term Debt" = #MISSING;
"Insurance" = #MISSING;
"Maintenance" = #MISSING;
"Repairs" = #MISSING;
"Retirement Expenses" = #MISSING;
"Capital Expenditure" = #MISSING;

IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
"Capital Expenditure" = basicCost - retirementObs;
ENDIF

/* Check if we should start setting cash flow impact values */
IF ("TP-Date" == cashOutflowDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
setCashImpact = cashStaggeredPers;
cashAllocPct = 1 / cashStaggeredPers;
ENDIF

/* Check if we should start setting funding values */
IF ("TP-Date" == fundingDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
setFundingImpact = fundingStaggeredPers;
fundingAllocPct = 1 / fundingStaggeredPers;
ENDIF

IF (setCashImpact > 0)
"Cash Flow Allocator" = cashAllocPct;
setCashImpact = setCashImpact - 1;
ENDIF
"Cash Outflow from Capital Additions" = basicCost * "Cash Flow Allocator";

IF (setFundingImpact > 0)
"Funding Allocator" = fundingAllocPct;
setFundingImpact = setFundingImpact - 1;
ENDIF
"Cash Inflow from Funding" = fundingAmt * "Funding Allocator";
"Long Term Debt" = fundingAmt * "Funding Allocator";

/* Check if we should start depreciation */
IF ((numDeprPeriods == 0) AND (("TP-Date" == inServiceDate) OR (setStartDepr == 1) OR (deprConvention == 4 AND "Fiscal TP-Index" == @INT("NumPeriods" / 2)+1) AND "TP-Date" > yearVal))
setStartDepr = 0;
periodOffset = 0;
persIn1stYear = "NumPeriods";
numDeprPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in Years)";
totDeprPeriods = numDeprPeriods;
dayVal = "No Year"->"BegBalance"->"In Service Date" - inServiceDate;
monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);

delayStart = 0;
IF (deprConvention == 2) /* Prorate Actual Date */
  IF (dayVal == 1) /* Treat same as Begin Period */
    split1stAmt = 0;
  ELSE
    numDeprPeriods = numDeprPeriods + 1;
    split1stAmt = 1;
  ENDIF
ELSEIF (deprConvention == 3) /* Mid Period */
  numDeprPeriods = numDeprPeriods + 1;
  split1stAmt = 1;
ELSEIF (deprConvention == 4) /* MidYear */
  split1stAmt = 0;
  delayStart = @INT("NumPeriods" / 2) - "Fiscal TP-Index" +1;
ELSE /* Prorate Begin Period */
  split1stAmt = 0;
ENDIF

IF (deprMethod == 3 OR deprMethod == 4)
  /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
  deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

insuranceCost = insuranceCost / "NumPeriods";
maintenanceCost = maintenanceCost / "NumPeriods";
repairsCost = repairsCost / "NumPeriods";

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
  numDeprPeriods = numDeprPeriods - preExistingPers;
  IF (numDeprPeriods > 0)
    deprAmt = (basicCost - salvageVal) / totDeprPeriods;
    periodicPriorAccumDepr = deprAmt * preExistingPers;
  ENDIF
ENDIF

/* Depreciation calculation section */
IF (deprMethod > 0 AND periodOffset < numDeprPeriods AND delayStart < 1)
  lifeIndex = @INT(periodOffset / persInSection);
  IF (deprMethod == 1) /* Straight Line */
    deprAmt = (basicCost - salvageVal) / totDeprPeriods;
  ELSEIF (deprMethod == 3 or deprMethod == 4) /* Declining Balance */
    IF (lifeIndex == 0)
      /* cost * rate * month / 12; for 1st period */
      deprAmt = basicCost * deprRate * persIn1stYear / "NumPeriods" / persInSection;
    ELSE /* (cost - total depreciation from prior periods) * rate; for all middle periods */
      deprAmt = (basicCost - priorAccumDepr) * deprRate / persInSection;
    ENDIF
ENDIF

Predefined Business Rules 165
ELSEIF (deprMethod == 2) /* Sum of Years Digits */
    deprRate = (life - lifeIndex) * 2 / (life * (life +1));
    deprAmt = (basicCost - salvageVal) * deprRate / persInSection;
ENDIF

IF (split1stAmt == 1)
    IF (deprConvention == 2)
        /* assume that there are 30 days in each month */
        deprAmt = deprAmt * @MAX(30 - dayVal, 1) / 30;
    ELSEIF (deprConvention == 4)
    ELSE
        deprAmt = deprAmt - deprAmt / 2;
    ENDIF
    split1stAmt = 0;
ENDIF

/* Adjust for rounding errors */
IF (periodOffset + 1 == numDeprPeriods)
    deprAmt = (basicCost - salvageVal) - periodicPriorAccumDepr;
ENDIF

periodicPriorAccumDepr = periodicPriorAccumDepr + deprAmt;

/* Use accumulated depr as first value for Mid-Year converntion */
IF (deprConvention == 4 AND "TP-Date" == inServiceDate AND monthVal > 600)
    deprAmt = periodicPriorAccumDepr;
ENDIF

IF (isAnnual == 1)
    IF (@INT((periodOffset + 1) / persInSection) == (lifeIndex + 1))
        priorAccumDepr = periodicPriorAccumDepr;
    ENDIF
ELSE
    priorAccumDepr = periodicPriorAccumDepr;
ENDIF

/* Only assign to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR
    preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
    "Property, Plant and Equipment Gross" = basicCost;
    "Depreciation" = deprAmt;
    "Accumulated Depreciation" = periodicPriorAccumDepr;
    "Insurance" = insuranceCost;
    "Maintenance" = maintenanceCost;
    "Repairs" = repairsCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
    IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR
        "No Year"->"BegBalance"->"Reason Ended" == 3)
        netValue = basicCost - priorAccumDepr + retirementCosts;
    IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
        "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue - saleValue + deprAmt;
ENDIF
ELSE
    "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue +
    deprAmt;
ENDIF

"Retirement Expenses" = retirementCosts - retirementObs;
"Proceeds from Sale of Property, Plant and Equipment" = saleValue -
    retirementCosts;
ENDIF

periodOffset = periodOffset +1;
ELSE
    delayStart = delayStart -1;
ENDIF
ELSE
ENDIF}

FIX ("BegBalance", "No Year")
"Cash Flow Incidence" (  
    IF (cashflowChanged == 1 AND "Asset Status" > 0)
        "Cash Flow Incidence" = cashFlowIncidence;
    ENDIF
    IF (fundingChanged == 1 AND "Asset Status" > 0)
        "Funding Incidence" = fundingIncidence;
    ENDIF
)

ENDFIX

ENDFIX

/* Clear out any asset line items marked for delete */
FIX(@CHILDREN("Total New"), [Hidden_Version], [DepartmentTo], [AssetClass])
    [Hidden_Scenario] (  
        IF ("No Year"->"BegBalance"->"Asset Status" == -1)
            @CURRMBR("Line Item") = #MISSING;
        ENDIF
    );
ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [DepartmentTo])
    CALC DIM ("Period");
    @ANCESTORS([SrcLineItem]);
    @ANCESTORS([AssetClass]);
ENDFIX

TransferExistAsset

Description
Transfers an existing asset.

Formula

SET CREATENONMISSINGBLK ON;
SET UPDATECALC OFF;
SET AGGMISSG ON;
VAR periodOffset = 0;
VAR deprMethod = 0;
VAR deprRate = 0;
VAR deprConvention = 0;
VAR numDeprPeriods = 0;
VAR totDeprPeriods = 0;
VAR persIn1stYear = 12;
VAR priorAccumDepr = 0;
VAR periodicPriorAccumDepr = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR deprAmt = 0;
VAR deprAmtLast = 0;
VAR persInSection = 0;
VAR life = 0;
VAR lifeIndex = 0;
VAR isAnnual = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR repairsCost = 0;
VAR retirementObs = 0;
VAR retirementCosts = 0;
VAR purchaseDate = 0;
VAR retireOption = 0;
VAR xferAsset = 0;
VAR paramsSet = 0;
VAR netValue;
VAR yearVal;
VAR monthVal;
VAR dayVal;
VAR delayStart;
VAR split1stAmt;
VAR preExistingPers = 0;
VAR setStartDepr = 0;

/* Transfer section: Locate either an asset with same Asset ID or a new one for transfer */
FIX(@CHILDREN("Base SPs"), [Hidden_Scenario], [Hidden_Version], [DepartmentTo],
    [AssetClass], "No Year", "BegBalance")
"Asset Description" (

IF (NOT @ISMBR([DepartmentFrom]))
IF (@MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING) OR ("Asset ID" ==
[DepartmentFrom]--[SrcLineItem]--"Asset ID" AND [DepartmentFrom]--[SrcLineItem]--"Asset ID" <> #MISSING))

    IF ("Asset ID" == [DepartmentFrom]--[SrcLineItem]--"Asset ID" AND [DepartmentFrom]--[SrcLineItem]--"Asset ID" <> #MISSING)
            /* Clear out any duplicate Assets based on Asset ID if already transferred */
IF (xferAsset == 1)

"Asset Status" = -1; /* mark line item for deletion */

ELSE

xferAsset = 1;
"Asset Status" = 0;
"Asset ID" = [DepartmentFrom]->[SrcLineItem]->"Asset ID";
"Asset Description" = [DepartmentFrom]->[SrcLineItem]->"Asset Description";
"CAR No." = [DepartmentFrom]->[SrcLineItem]->"CAR No."
"Justification" = [DepartmentFrom]->[SrcLineItem]->"Justification";
"Physical Location" = [DepartmentFrom]->[SrcLineItem]->"Physical Location";
"UOM" = [DepartmentFrom]->[SrcLineItem]->"UOM";
"Priority" = [DepartmentFrom]->[SrcLineItem]->"Priority";

"Asset Units" = [DepartmentFrom]->[SrcLineItem]->"Asset Units";
"Asset Rate" = [DepartmentFrom]->[SrcLineItem]->"Asset Rate";
"Installation" = [DepartmentFrom]->[SrcLineItem]->"Installation";
"Freight" = [DepartmentFrom]->[SrcLineItem]->"Freight";
"Salvage Input" = [DepartmentFrom]->[SrcLineItem]->"Salvage Input";
"Taxes %" = [DepartmentFrom]->[SrcLineItem]->"Taxes %";
"Acquisition Costs" = [DepartmentFrom]->[SrcLineItem]->"Acquisition Costs";
"Additional Charges" = [DepartmentFrom]->[SrcLineItem]->"Additional Charges";
"Retirement Obligation" = [DepartmentFrom]->[SrcLineItem]->"Retirement Obligation";
"Retirement Options" = [DepartmentFrom]->[SrcLineItem]->"Retirement Options";
"Partial Capitalize %" = [DepartmentFrom]->[SrcLineItem]->"Partial Capitalize %";
"Basic Cost" = "Asset Units" * "Asset Rate" + ("Asset Units" * "Asset Rate" * "Taxes %") + "Freight" + "Additional Charges" + "Retirement Obligation" + "Installation";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Salvage" = "Salvage Input" * "Asset Units";

"Purchase Date" = [DepartmentFrom]->[SrcLineItem]->"Purchase Date";
"In Service Date" = [DepartmentFrom]->[SrcLineItem]->"In Service Date";

IF ("In Service Date" < "Purchase Date")
   "In Service Date" = "Purchase Date";
ENDIF

"Delayed Start Date" = [TransferDate];
"Reason Delayed" = 1;

ENDIF

ELSEIF (xferAsset == 0 AND @MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING)

xferAsset = 1;
"Asset Status" = 0;
"Asset ID" = [DepartmentFrom]->[SrcLineItem]->"Asset ID";
"Asset Description" = [DepartmentFrom]->[SrcLineItem]->"Asset Description";
"CAR No." = [DepartmentFrom]->[SrcLineItem]->"CAR No.";
"Justification" = [DepartmentFrom]->[SrcLineItem]->"Justification";
"Physical Location" = [DepartmentFrom]->[SrcLineItem]->"Physical Location";
"UOM" = [DepartmentFrom]->[SrcLineItem]->"UOM";
"Priority" = [DepartmentFrom]->[SrcLineItem]->"Priority";

ENDIF
"Asset Units" = [DepartmentFrom]->[SrcLineItem]->"Asset Units";
"Asset Rate" = [DepartmentFrom]->[SrcLineItem]->"Asset Rate";
"Installation" = [DepartmentFrom]->[SrcLineItem]->"Installation";
"Freight" = [DepartmentFrom]->[SrcLineItem]->"Freight";
"Salvage Input" = [DepartmentFrom]->[SrcLineItem]->"Salvage Input";
"Taxes %" = [DepartmentFrom]->[SrcLineItem]->"Taxes %";
"Acquisition Costs" = [DepartmentFrom]->[SrcLineItem]->"Acquisition Costs";
"Additional Charges" = [DepartmentFrom]->[SrcLineItem]->"Additional Charges";
"Retirement Obligation" = [DepartmentFrom]->[SrcLineItem]->"Retirement Obligation";
"Retirement Options" = [DepartmentFrom]->[ SrcLineItem]->"Retirement Options";
"Partial Capitalize %" = [DepartmentFrom]->[SrcLineItem]->"Partial Capitalize %";
"Basic Cost" = "Asset Units" * "Asset Rate" + ("Asset Units" * "Asset Rate" * "Taxes %") + "Freight" + "Additional Charges" + "Retirement Obligation" + "Installation";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Salvage" = "Salvage Input" * "Asset Units";
"Purchase Date" = [DepartmentFrom]->[SrcLineItem]->"Purchase Date";
"In Service Date" = [DepartmentFrom]->[SrcLineItem]->"In Service Date";

IF ("In Service Date" < "Purchase Date")
        "In Service Date" = "Purchase Date";
ENDIF

"Delayed Start Date" = [TransferDate];
"Reason Delayed" = 1;
ENDIF

ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [AssetClass], [SrcLineItem], "No Year", "BegBalance")
"Premature End Date" ( IF (xferAsset == 1)
        "Asset Status" = 0; /* set status to new to trigger recalc below */
        "Premature End Date" = [TransferDate];
        "Reason Ended" = 1;
        "Sale Value" = #MISSING;
    ENDIF
); ENDFIX

/* Calculate depreciation after transfer */

FIX(@DESCENDANTS("Base SPs"), [AssetClass], [Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [DepartmentTo])

FIX (@LEVMBRS("Period", 0), @LEVMBRS("Year", 0))
"Depreciation" ( IF ("No Year"->"BegBalance"->"Asset Status" == 0)
    IF (@ISMBR("BegBalance") AND paramsSet == 0)
        paramsSet = 1;
/* Initialized all the variables required to calculate depreciation */
/* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;

/* Initialize for depreciation calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

depMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Method";
depConvention = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Depreciation Convention";
insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";
repairsCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Repairs %";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
  yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
  monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
  IF (monthVal < 0)
    IF (yearVal > 0)
      yearVal = yearVal - 1;
    ENDIF
  monthVal = 1200 + monthVal;
ENDIF
preExistingPers = yearVal * 12 + monthVal / 100;
setStartDepr = 1;
ELSE
  preExistingPers = 0;
  setStartDepr = 0;
ENDIF

/* setup for depreciation */
numDeprPeriods = 0;
periodOffset = 0;

IF (deprMethod > 0)
persIn1stYear = "NumPeriods" - "Cal TP-Index" + 1;
priorAccumDepr = 0;
periodPriorAccumDepr = 0;
deprAmt = 0;
/* Add a periodic vs annual property instead of additional deprMethods */
/* Annual Methods SumYearDigits =2 DecliningBalance Year = 3*/
IF (deprMethod == 2 OR deprMethod == 3)
isAnnual = 1;
life = "No Year"->"Useful Life (in Years)";
persInSection = "NumPeriods";
ELSE /* Periodic Methods */
isAnnual = 0;
life = "No Year"->"Useful Life (in Years)" * "NumPeriods";
persInSection = 1;
ENDIF

yearVal = @INT(inServiceDate / 10000) * 10000;

/* DecliningBalance methods */
IF (deprMethod == 3 OR deprMethod == 4)
    /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
    deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

/* Reset depr method to SLN convention to prorate 1st period for preExisting assets */
IF (preExistingPers > 0)
    deprMethod = 1;
    deprConvention = 1;
ENDIF

ENDIF

ENDIF

IF (@ISMBR("No Year") AND @ISMBR("BegBalance"))
    paramsSet = 0;
    IF ("Asset Status" == 0)
        "Asset Status" = 1;
    ENDIF
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
    /* clear out any previously calculated values */
    "Depreciation" = #MISSING;
    "Accumulated Depreciation" = #MISSING;
    "Property, Plant and Equipment Gross" = #MISSING;
    "Loss/(Gain) on Sale of Property, Plant and Equipment" = #MISSING;
    "Proceeds from Sale of Property, Plant and Equipment" = #MISSING;
    "Cash Flow Allocator" = #MISSING;
    "Funding Allocator" = #MISSING;
    "Cash Outflow from Capital Additions" = #MISSING;
    "Cash Inflow from Funding" = #MISSING;
    "Long Term Debt" = #MISSING;
    "Insurance" = #MISSING;
    "Maintenance" = #MISSING;
    "Repairs" = #MISSING;
    "Retirement Expenses" = #MISSING;
    "Capital Expenditure" = #MISSING;
    /*
     IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
     */
"Capital Expenditure" = basicCost - retirementObs;

ENDIF

/* Check if we should start depreciation */
IF ((numDeprPeriods == 0) AND (("TP-Date" == inServiceDate) OR (setStartDepr == 1)
OR
(deprConvention == 4 AND "Fiscal TP-Index" == @INT("NumPeriods" / 2)+1 AND "TP-
Date" > yearVal))

setStartDepr = 0;
periodOffset = 0;
persIn1stYear = "NumPeriods" - "Cal TP-Index" + 1;
numDeprPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in
Years)";
totDeprPeriods = numDeprPeriods;

dayVal = "No Year"->"BegBalance"->"In Service Date" - inServiceDate;
monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);

delayStart = 0;
IF (deprConvention == 2) /* Prorate Actual Date */
    IF (dayVal == 1) /* Treat same as Begin Period */
        split1stAmt = 0;
    ELSE
        numDeprPeriods = numDeprPeriods + 1;
        split1stAmt = 1;
    ENDIF
ELSEIF (deprConvention == 3) /* Mid Period */
    numDeprPeriods = numDeprPeriods + 1;
    split1stAmt = 1;
ELSEIF (deprConvention == 4) /* MidYear */
    split1stAmt = 0;
    delayStart = @INT("NumPeriods" / 2) - "Fiscal TP-Index" +1;
ELSE /* Prorate Begin Period */
    split1stAmt = 0;
ENDIF

IF (deprMethod == 3 OR deprMethod == 4)
    /* depreciation rate = 1 - ((salvage / cost) ^ (1 / life)) */
    deprRate = 1 - @POWER(salvageVal / basicCost, 1 / life);
ENDIF

insuranceCost = insuranceCost / "NumPeriods";
maintenanceCost = maintenanceCost / "NumPeriods";
repairsCost = repairsCost / "NumPeriods";

/* Adjust for pre existing assets */
IF (preExistingPers > 0)
    numDeprPeriods = numDeprPeriods - preExistingPers;
    IF (numDeprPeriods > 0)
        deprAmt = (basicCost - salvageVal) / totDeprPeriods;
        periodicPriorAccumDepr = deprAmt * preExistingPers;
    ENDIF
ENDIF

ENDIF
/* Depreciation calculation section */
IF (deprMethod > 0 AND periodOffset < numDeprPeriods AND delayStart < 1)
    lifeIndex = @INT(periodOffset / persInSection);
    IF (deprMethod == 1) /* Straight Line */
        deprAmt = (basicCost - salvageVal) / totDeprPeriods;
    ELSEIF (deprMethod == 3 or deprMethod == 4) /* Declining Balance */
        IF (lifeIndex == 0)
            /* cost * rate * month / 12; for 1st period */
            deprAmt = basicCost * deprRate * persIn1stYear /
                "NumPeriods" / persInSection;
        ELSE /* (cost - total depreciation from prior periods) * rate; for all middle periods */
            deprAmt = (basicCost - priorAccumDepr) * deprRate / persInSection;
        ENDIF
    ELSEIF (deprMethod == 2) /* Sum of Years Digits */
        deprRate = (life - lifeIndex) * 2 / (life * (life +1));
        deprAmt = (basicCost - salvageVal) * deprRate / persInSection;
    ENDIF
    IF (split1stAmt == 1)
        IF (deprConvention == 2)
            /* assume that there are 30 days in each month */
            deprAmt = deprAmt * @MAX(30 - dayVal, 1) / 30;
        ELSEIF (deprConvention == 4);  
        ELSE
            deprAmt = deprAmt - deprAmt / 2;
        ENDIF
        split1stAmt = 0;
    ENDIF
    /* Adjust for rounding errors */
    IF (periodOffset + 1 == numDeprPeriods)
        deprAmt = (basicCost - salvageVal) - periodicPriorAccumDepr;
    ENDIF
    periodicPriorAccumDepr = periodicPriorAccumDepr + deprAmt;
    /* Use accumulated depr as first value for Mid-Year conversion */
    IF (deprConvention == 4 AND "TP-Date" == inServiceDate AND monthVal > 600)
        deprAmt = periodicPriorAccumDepr;
    ENDIF
    IF (isAnnual == 1)
        IF (@INT((periodOffset + 1) / persInSection) == (lifeIndex + 1))
            priorAccumDepr = periodicPriorAccumDepr;
        ENDIF
        ELSE
            priorAccumDepr = periodicPriorAccumDepr;
        ENDIF
    /* Only assign to member if we are in range */
    IF ("TP-Date" => delayedStartDate AND ("TP-Date" => inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
"Property, Plant and Equipment Gross" = basicCost;
"Depreciation" = deprAmt;
"Accumulated Depreciation" = periodicPriorAccumDepr;
"Insurance" = insuranceCost;
"Maintenance" = maintenanceCost;
"Repairs" = repairsCost;

ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
  IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR
      "No Year"->"BegBalance"->"Reason Ended" == 3)
    netValue = basicCost - priorAccumDepr + retirementCosts;
    IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
      "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue -
      saleValue + deprAmt;
      ELSE
      "Loss/(Gain) on Sale of Property, Plant and Equipment" = netValue +
      deprAmt;
    ENDIF
    "Retirement Expenses" = retirementCosts - retirementObs;
    "Proceeds from Sale of Property, Plant and Equipment" = saleValue -
    retirementCosts;
  ENDIF
  periodOffset = periodOffset +1;
ENDIF
  delayStart = delayStart -1;
ENDIF

ENDFIX

ENDFIX

/* Clear out any asset line items marked for delete */
FIX(@CHILDREN("Base Sps"), [Hidden_Version], [DepartmentTo], [AssetClass])
  [Hidden_Scenario](
    IF ("No Year"->"BegBalance"->"Asset Status" == -1)
      @CURRMBR("Line Item") = #MISSING;
    ENDIF
  );
ENDFIX

ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [DepartmentTo])
  CALC DIM ("Period");
  @ANCESTORS([SrcLineItem]);
  @ANCESTORS([AssetClass]);
ENDFIX

TransferExistIntangible

Description
Transfers an existing intangible asset.

**Formula**

```plaintext
SET CREATE NONMISSINGBLK ON;
SET UPDATECALC OFF;
SET AGGMISSG ON;

VAR periodOffset = 0;
VAR amortMethod = 0;
VAR numAmortPeriods = 0;
VAR priorAccumAmort = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR amortAmt = 0;
VAR retireOption = 0;
VAR retirementCosts = 0;
VAR retirementObs = 0;
VAR impairmentDate1 = 0;
VAR impairmentDate2 = 0;
VAR impairmentFairVal1 = 0;
VAR impairmentFairVal2 = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR purchaseDate = 0;
VAR capitalizePct = 0;
VAR impairmentOpt = 1;
VAR numRemainingPers;
VAR intangibleNet;
VAR netValue;
VAR saleValue;
VAR yearVal;
VAR monthVal;
VAR paramsSet = 0;
VAR xferAsset = 0;
VAR preExistingPers = 0;
VAR setStartAmort = 0;

/* Transfer section: Locate either an asset with same Asset ID or a new one for transfer */
FIX(@CHILDREN("Base SPs"), [Hidden_Scenario], [Hidden_Version], [DepartmentTo],
[AssetClassInt], "No Year", "BegBalance")
"Asset Description"

IF (NOT @ISMBR([DepartmentFrom]))

IF (@MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING) OR ("Asset ID" ==
[DepartmentFrom]->[SrcLineItem]->"Asset ID" AND [DepartmentFrom]->[SrcLineItem]->"Asset ID" <> #MISSING))

   IF ("Asset ID" == [DepartmentFrom]->[SrcLineItem]->"Asset ID" AND [DepartmentFrom]->
[SrcLineItem]->"Asset ID" <> #MISSING)
     /* Clear out any duplicate Assets based on Asset ID if already transferred */
     IF (xferAsset == 1)
```

176  Capital Expense Planning Structure
"Asset Status" = -1; /* mark line item for deletion */

ELSE

xferAsset = 1;
"Asset Status" = 0;
"Asset ID" = [DepartmentFrom]->[SrcLineItem]->"Asset ID";
"Asset Description" = [DepartmentFrom]->[SrcLineItem]->"Asset Description";
"CAR No." = [DepartmentFrom]->[SrcLineItem]->"CAR No.";
"Justification" = [DepartmentFrom]->[SrcLineItem]->"Justification";
"Physical Location" = [DepartmentFrom]->[SrcLineItem]->"Physical Location";
"UOM" = [DepartmentFrom]->[SrcLineItem]->"UOM";
"Priority" = [DepartmentFrom]->[SrcLineItem]->"Priority";

"Asset Units" = [DepartmentFrom]->[SrcLineItem]->"Asset Units";
"Asset Rate" = [DepartmentFrom]->[SrcLineItem]->"Asset Rate";
"Installation" = [DepartmentFrom]->[SrcLineItem]->"Installation";
"Freight" = [DepartmentFrom]->[SrcLineItem]->"Freight";
"Salvage Input" = [DepartmentFrom]->[SrcLineItem]->"Salvage Input";
"Taxes %" = [DepartmentFrom]->[SrcLineItem]->"Taxes %";
"Acquisition Costs" = [DepartmentFrom]->[SrcLineItem]->"Acquisition Costs";
"Additional Charges" = [DepartmentFrom]->[SrcLineItem]->"Additional Charges";
"Retirement Obligation" = [DepartmentFrom]->[SrcLineItem]->"Retirement Obligation";
"Retirement Options" = [DepartmentFrom]->[SrcLineItem]->"Retirement Options";
"Partial Capitalize %" = [DepartmentFrom]->[SrcLineItem]->"Partial Capitalize %";
"Basic Cost" = "Acquisition Costs" + "Additional Charges";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Salvage" = "Salvage Input" * "Asset Units";

"Purchase Date" = [DepartmentFrom]->[SrcLineItem]->"Purchase Date";
"In Service Date" = [DepartmentFrom]->[SrcLineItem]->"In Service Date";

IF ("In Service Date" < "Purchase Date")
  "In Service Date" = "Purchase Date";
ENDIF

"Delayed Start Date" = [TransferDate];
"Reason Delayed" = 1;

ENDIF

ELSEIF (xferAsset == 0 AND @MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING)

xferAsset = 1;
"Asset Status" = 0;
"Asset ID" = [DepartmentFrom]->[SrcLineItem]->"Asset ID";
"Asset Description" = [DepartmentFrom]->[SrcLineItem]->"Asset Description";
"CAR No." = [DepartmentFrom]->[SrcLineItem]->"CAR No.";
"Justification" = [DepartmentFrom]->[SrcLineItem]->"Justification";
"Physical Location" = [DepartmentFrom]->[SrcLineItem]->"Physical Location";
"UOM" = [DepartmentFrom]->[SrcLineItem]->"UOM";
"Priority" = [DepartmentFrom]->[SrcLineItem]->"Priority";

"Asset Units" = [DepartmentFrom]->[SrcLineItem]->"Asset Units";
"Asset Rate" = [DepartmentFrom]->[SrcLineItem]->"Asset Rate";
"Installation" = [DepartmentFrom]->[SrcLineItem]->"Installation";
"Freight" = [DepartmentFrom]->[SrcLineItem]->"Freight";
"Salvage Input" = [DepartmentFrom]->[SrcLineItem]->"Salvage Input";
"Taxes %" = [DepartmentFrom]->[SrcLineItem]->"Taxes %";
"Acquisition Costs" = [DepartmentFrom]->[SrcLineItem]->"Acquisition Costs";
"Additional Charges" = [DepartmentFrom]->[SrcLineItem]->"Additional Charges";
"Retirement Obligation" = [DepartmentFrom]->[SrcLineItem]->"Retirement Obligation";
"Retirement Options" = [DepartmentFrom]->[SrcLineItem]->"Retirement Options";
"Partial Capitalize %" = [DepartmentFrom]->[SrcLineItem]->"Partial Capitalize %";
"Basic Cost" = "Acquisition Costs" + "Additional Charges";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Salvage" = "Salvage Input" * "Asset Units";
"Purchase Date" = [DepartmentFrom]->[SrcLineItem]->"Purchase Date";
"In Service Date" = [DepartmentFrom]->[SrcLineItem]->"In Service Date";

IF ("In Service Date" < "Purchase Date")
  "In Service Date" = "Purchase Date";
ENDIF

"Delayed Start Date" = [TransferDate];
"Reason Delayed" = 1;
ENDIF

FIX([Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [AssetClassInt],
[SrcLineItem], "No Year", "BegBalance")

"Premature End Date" (  
  IF (xferAsset == 1)
    "Asset Status" = 0;  /* set status to new to trigger recalc below */
    "Premature End Date" = [TransferDate];
    "Reason Ended" = 1;
    "Sale Value" = #MISSING;
  ENDIF
  
  ENDIF
)

FIX([Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [AssetClassInt],
[SrcLineItem], "No Year", "BegBalance")

"Premature End Date" (  
  IF (xferAsset == 1)
    "Asset Status" = 0;  /* set status to new to trigger recalc below */
    "Premature End Date" = [TransferDate];
    "Reason Ended" = 1;
    "Sale Value" = #MISSING;
  ENDIF
  
  ENDIF
)

FIX(DESCENDANTS("Base SPs"), [Hidden_Scenario], [Hidden_Version], [DepartmentFrom],
[DepartmentTo], [AssetClassInt])

FIX(LEVMBRS("Period", 0) LEVMBRS("Year", 0))

"Amortization"(

/* Only calc valid asset line items */
IF ("No Year"->"BegBalance"->"Asset Status" >= 0)

IF (ISMBR("BegBalance") AND paramsSet == 0)
  /* Initialized all the variables required to calculate depreciation */
  paramsSet = 1;

  /* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;

/* Initialize for amortization calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
impairmentOpt = "No Year"->"Impairment Option";
capitalizePct = "No Year"->"Partial Capitalize %";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

amortMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Amortization Method";

insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Maintenance %";

IF ("No Year"->"Impairment Date1" <> #MISSING)
  impairmentDate1 = @INT("No Year"->"Impairment Date1" / 100) * 100;
ELSE
  impairmentDate1 = #MISSING;
ENDIF
IF ("No Year"->"Impairment Date2" <> #MISSING)
  impairmentDate2 = @INT("No Year"->"Impairment Date2" / 100) * 100;
ELSE
  impairmentDate2 = #MISSING;
ENDIF

impairmentFairVal1 = "No Year"->"Impairment Fair Value1";
impairmentFairVal2 = "No Year"->"Impairment Fair Value2";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
  yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
  monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
  IF (monthVal < 0)
    IF (yearVal > 0)
      yearVal = yearVal - 1;
    ENDIF
    monthVal = 1200 + monthVal;
  ENDIF
  preExistingPers = @ROUND(yearVal * 12 + monthVal / 100, 0);
  setStartAmort = 1;
ELSE
  preExistingPers = 0;
  setStartAmort = 0;
ENDIF
numAmortPeriods = 0;
periodOffset = 0;

IF (amortMethod == 1)
    priorAccumAmort = 0;
    amortAmt = 0;
    yearVal = @INT(inServiceDate / 10000) * 10000;
    monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);
ENDIF

ENDIF

IF (@ISMBR("No Year") AND @ISMBR("BegBalance"))
    paramsSet = 0;
    IF ("Asset Status" == 0)
        "Asset Status" = 1;
    ENDIF
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)

    /* clear out any previously calculated values */
    "Amortization" = #MISSING;
    "Accumulated Amortization" = #MISSING;
    "Intangible Assets Finite, Gross" = #MISSING;
    "Loss/(Gain) on Sale of Intangibles" = #MISSING;
    "Proceeds from Sale of Intangibles" = #MISSING;
    "Cash Flow Allocator" = #MISSING;
    "Funding Allocator" = #MISSING;
    "Cash Outflow from Capital Additions" = #MISSING;
    "Cash Inflow from Funding" = #MISSING;
    "Long Term Debt" = #MISSING;
    "Insurance" = #MISSING;
    "Maintenance" = #MISSING;
    "Impairment of Assets" = #MISSING;
    "Capital Reserve" = #MISSING;
    "Capital Expenditure" = #MISSING;
    "Retirement Expenses" = #MISSING;

    /*
     * IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate
     * > #MISSING AND "TP-Date" > delayedStartDate))
     * "Capital Expenditure" = basicCost - retirementObs;
     * ENDIF
     */

    /* Check if we should start amortization */
    IF ("TP-Date" == inServiceDate OR (setStartAmort == 1))
        setStartAmort = 0;
        periodOffset = 0;
        numAmortPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in
     * Years)";
        insuranceCost = insuranceCost / "NumPeriods";
        maintenanceCost = maintenanceCost / "NumPeriods";
        intangibleNet = basicCost;
        amortAmt = (basicCost - salvageVal) / numAmortPeriods;
    ENDIF
/* Adjust for pre existing assets */
IF (preExistingPers > 0)
    numAmortPeriods = numAmortPeriods - preExistingPers;
    IF (numAmortPeriods > 0)
        priorAccumAmort = amortAmt * preExistingPers;
    ENDIF
ENDIF

numRemainingPers = numAmortPeriods;

ENDIF

/* Amortization calculation section */
IF (amortMethod == 1 AND periodOffset < numAmortPeriods)
    IF ("TP-Date" == impairmentDate1)
        IF (impairmentOpt == 1)
            "Impairment of Assets" = intangibleNet - impairmentFairVal1;
        ELSEIF (impairmentOpt == 2)
            "Capital Reserve" = intangibleNet - impairmentFairVal1;
        ELSEIF (impairmentOpt == 3)
            "Capital Reserve" = (intangibleNet - impairmentFairVal1) * capitalizePct;
        "Impairment of Assets" = intangibleNet - impairmentFairVal1 - "Capital Reserve";
    ENDIF
    basicCost = basicCost - (intangibleNet - impairmentFairVal1); 
    amortAmt = impairmentFairVal1 / numRemainingPers;
    ELSEIF ("TP-Date" == impairmentDate2)
        IF (impairmentOpt == 1)
            "Impairment of Assets" = intangibleNet - impairmentFairVal2;
        ELSEIF (impairmentOpt == 2)
            "Capital Reserve" = intangibleNet - impairmentFairVal2;
        ELSEIF (impairmentOpt == 3)
            "Capital Reserve" = (intangibleNet - impairmentFairVal2) * capitalizePct;
        "Impairment of Assets" = intangibleNet - impairmentFairVal2 - "Capital Reserve";
    ENDIF
    basicCost = basicCost - (intangibleNet - impairmentFairVal2); 
    amortAmt = impairmentFairVal2 / numRemainingPers;
ENDIF

IF (periodOffset + 1 == numAmortPeriods)
    amortAmt = (basicCost - salvageVal) - priorAccumAmort;
ENDIF

priorAccumAmort = priorAccumAmort + amortAmt;
intangibleNet = basicCost - priorAccumAmort;

/* Only assign values to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))
"Insurance" = insuranceCost;
"Maintenance" = maintenanceCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
    IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR
        "No Year"->"BegBalance"->"Reason Ended" == 3)
        netValue = basicCost - priorAccumAmort + retirementCosts;
        IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
            "Loss/(Gain) on Sale of Intangibles" = netValue - saleValue +
            amortAmt;
        ELSE
            "Loss/(Gain) on Sale of Intangibles" = netValue + amortAmt;
        ENDIF
        "Retirement Expenses" = retirementCosts - retirementObs;
        "Proceeds from Sale of Intangibles" = saleValue - retirementCosts;
    ENDIF
ENDIF

periodOffset = periodOffset +1;
numRemainingPers = numRemainingPers -1;
ENDIF
ENDIF
ENDIF
);
ENDFIX
ENDFIX

/* Clear out any asset line items marked for delete */
FIX(@CHILDREN("Base Sps"), [Hidden_Version], [DepartmentTo], [AssetClassInt])
[Hidden_Scenario](
    IF ("No Year"->"BegBalance"->"Asset Status" == -1)
        @CURRMBR("Line Item") = #MISSING;
    ENDIF
);
ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [DepartmentTo])
CALC DIM ("Period");
@ANCESTORS([SrcLineItem]);
@ANCESTORS([AssetClassInt]);
ENDFIX

**Transfer Intangible**

**Description**

Transfers an intangible asset.

**Formula**

SET CREATENONMISSINGBLK ON;
SET UPDATECALC OFF;
SET AGGMISSG ON;
VAR periodOffset = 0;
VAR amortMethod = 0;
VAR numAmortPeriods = 0;
VAR priorAccumAmort = 0;
VAR basicCost = 0;
VAR salvageVal = 0;
VAR amortAmt = 0;
VAR retirementCosts = 0;
VAR retirementObs = 0;
VAR impairmentDate1 = 0;
VAR impairmentDate2 = 0;
VAR impairmentFairVal1 = 0;
VAR impairmentFairVal2 = 0;
VAR inServiceDate = 0;
VAR delayedStartDate = 0;
VAR prematureEndDate = 0;
VAR maintenanceCost = 0;
VAR insuranceCost = 0;
VAR cashOutflowDate = 0;
VAR fundingDate = 0;
VAR purchaseDate = 0;
VAR cashFlowIncidence = 0;
VAR fundingIncidence = 0;
VAR cashStaggeredPers = 1;
VAR fundingStaggeredPers = 1;
VAR cashAllocPct = 1;
VAR fundingAllocPct = 1;
VAR fundingAmt = 0;
VAR setCashImpact = 0;
VAR setFundingImpact = 0;
VAR capitalizePct = 0;
VAR impairmentOpt = 1;
VAR numRemainingPers;
VAR intangibleNet;
VAR netValue;
VAR saleValue;
VAR yearVal;
VAR monthVal;
VAR xferAsset = 0;
VAR paramsSet = 0;
VAR cashflowChanged = 0;
VAR fundingChanged = 0;
VAR preExistingPers = 0;
VAR setStartAmort = 0;

/* Transfer section: Locate either an asset with same Asset ID or a new one for transfer */
FIX(@CHILDREN("Total New"), [Hidden_Scenario], [Hidden_Version], [DepartmentTo],
[AssetClassInt], "No Year", "BegBalance")
"Asset Description" (  
IF (NOT @ISMBR([DepartmentFrom]))

IF (@MAXS(SKIPMISSING, @CHILDREN("Asset Properties")) == #MISSING) OR (*Asset ID*  
== [DepartmentFrom]->[SrcLineItem]-->"Asset ID" AND [DepartmentFrom]->[SrcLineItem]-
IF ("Asset ID" == [DepartmentFrom]->[SrcLineItem]->"Asset ID" AND [DepartmentFrom]->[SrcLineItem]->"Asset ID" <> #MISSING)
/* Clear out any duplicate Assets based on Asset ID if already transferred */
IF (xferAsset == 1)
"Asset Status" = -1; /* mark line item for deletion */
ELSE
xferAsset = 1;
"Asset Status" = 0;
"Asset ID" = [DepartmentFrom]->[SrcLineItem]->"Asset ID";
"Asset Description" = [DepartmentFrom]->[SrcLineItem]->"Asset Description";
"CAR No." = [DepartmentFrom]->[SrcLineItem]->"CAR No.";
"Justification" = [DepartmentFrom]->[SrcLineItem]->"Justification";
"Physical Location" = [DepartmentFrom]->[SrcLineItem]->"Physical Location";
"UOM" = [DepartmentFrom]->[SrcLineItem]->"UOM";
"Priority" = [DepartmentFrom]->[SrcLineItem]->"Priority";
"Asset Units" = [DepartmentFrom]->[SrcLineItem]->"Asset Units";
"Asset Rate" = [DepartmentFrom]->[SrcLineItem]->"Asset Rate";
"Installation" = [DepartmentFrom]->[SrcLineItem]->"Installation";
"Freight" = [DepartmentFrom]->[SrcLineItem]->"Freight";
"Salvage Input" = [DepartmentFrom]->[SrcLineItem]->"Salvage Input";
"Taxes %" = [DepartmentFrom]->[SrcLineItem]->"Taxes %";
"Acquisition Costs" = [DepartmentFrom]->[SrcLineItem]->"Acquisition Costs";
"Additional Charges" = [DepartmentFrom]->[SrcLineItem]->"Additional Charges";
"Retirement Obligation" = [DepartmentFrom]->[SrcLineItem]->"Retirement Obligation";
"Retirement Options" = [DepartmentFrom]->[SrcLineItem]->"Retirement Options";
"Partial Capitalize %" = [DepartmentFrom]->[SrcLineItem]->"Partial Capitalize %";
"Basic Cost" = "Acquisition Costs" + "Additional Charges";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Salvage" = "Salvage Input" * "Asset Units";
"Cash Flow Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";
"Funding Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";
"Purchase Date" = [DepartmentFrom]->[SrcLineItem]->"Purchase Date";
"In Service Date" = [DepartmentFrom]->[SrcLineItem]->"In Service Date";
IF ("In Service Date" < "Purchase Date")
"In Service Date" = "Purchase Date";
ENDIF
"Delayed Start Date" = [TransferDate];
"Reason Delayed" = 1;
ENDIF
ELSEIF (xferAsset == 0 AND @MAXS(SKIPMISSING, @CHILDREN("Asset Properties"))) == #MISSING)
xferAsset = 1;
"Asset Status" = 0;
"Asset ID" = [DepartmentFrom]->[SrcLineItem]->"Asset ID";
"Asset Description" = [DepartmentFrom]->[SrcLineItem]->"Asset Description";
"CAR No." = [DepartmentFrom]->[SrcLineItem]->"CAR No.";
"Justification" = [DepartmentFrom]->[SrcLineItem]->"Justification";
"Physical Location" = [DepartmentFrom]->[SrcLineItem]->"Physical Location";
"UOM" = [DepartmentFrom]->[SrcLineItem]->"UOM";
"Priority" = [DepartmentFrom]->[SrcLineItem]->"Priority";

"Asset Units" = [DepartmentFrom]->[SrcLineItem]->"Asset Units";
"Asset Rate" = [DepartmentFrom]->[SrcLineItem]->"Asset Rate";
"Installation" = [DepartmentFrom]->[SrcLineItem]->"Installation";
"Freight" = [DepartmentFrom]->[SrcLineItem]->"Freight";
"Salvage Input" = [DepartmentFrom]->[SrcLineItem]->"Salvage Input";
"Taxes %" = [DepartmentFrom]->[SrcLineItem]->"Taxes %";
"Acquisition Costs" = [DepartmentFrom]->[SrcLineItem]->"Acquisition Costs";
"Additional Charges" = [DepartmentFrom]->[SrcLineItem]->"Additional Charges";
"Retirement Obligation" = [DepartmentFrom]->[SrcLineItem]->"Retirement Obligation";
"Retirement Options" = [DepartmentFrom]->[SrcLineItem]->"Retirement Options";
"Partial Capitalize %" = [DepartmentFrom]->[SrcLineItem]->"Partial Capitalize %";
"Basic Cost" = "Acquisition Costs" + "Additional Charges";
"Useful Life (in Years)" = "No Scenario"->"No Version"->"No Entity"->"Global"->"Useful Life (in Years)";
"Salvage" = "Salvage Input" * "Asset Units";

"Cash Flow Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";
"Funding Incidence" = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";

"Purchase Date" = [DepartmentFrom]->[SrcLineItem]->"Purchase Date";
"In Service Date" = [DepartmentFrom]->[SrcLineItem]->"In Service Date";

IF ("In Service Date" < "Purchase Date")
  "In Service Date" = "Purchase Date";
ENDIF

"Delayed Start Date" = [TransferDate];
"Reason Delayed" = 1;
ENDIF
ENDIF
ENDIF
});
ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [AssetClassInt], [SrcLineItem], "No Year", "BegBalance")
"Premature End Date" (  
  IF (xferAsset == 1)
    "Asset Status" = 0;       /* set status to new to trigger recalc below */
    "Premature End Date" = [TransferDate];
    "Reason Ended" = 1;
    "Sale Value" = #MISSING;
  ENDIF
);  
ENDFIX

Predefined Business Rules 185
/* Calculate amortization after transfer */
FIX(@DESCENDANTS("Total New"), [Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [DepartmentTo], [AssetClassInt])

FIX (@LEVMBRs("Period", 0) @LEVMBRs("Year", 0))
"Amortization"

/* Only calc valid asset line items */
IF ("No Year"->"BegBalance"->"Asset Status" >= 0)

IF (@ISMBR("BegBalance") AND paramsSet == 0)
/* Initialized all the variables required to calculate depreciation */
paramsSet = 1;

/* eliminate days from date */
delayedStartDate = @INT("No Year"->"Delayed Start Date" / 100) * 100;
prematureEndDate = @INT("No Year"->"Premature End Date" / 100) * 100;
purchaseDate = @INT("No Year"->"Purchase Date" / 100) * 100;
inServiceDate = @INT("No Year"->"In Service Date" / 100) * 100;
cashOutflowDate = purchaseDate;
fundingDate = purchaseDate;

cashFlowIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Cash Flow Incidence";

IF (cashFlowIncidence <> "No Year"->"Cash Flow Incidence")
cashflowChanged = 1;
ELSE
  cashflowChanged = 0;
ENDIF

IF (cashFlowIncidence == -1 AND cashflowChanged == 1)
cashStaggeredPers = 4;
ELSE
  /* Extract year and month from date to adjust based in incidence values in
  global assumptions */
  yearVal = @INT(cashOutflowDate / 10000) * 10000;
  monthVal = cashOutflowDate - yearVal;
  monthVal = monthVal + cashFlowIncidence;

  IF (monthVal <= 0)
    yearVal = yearVal - 10000;
    monthVal = 1200 + monthVal;
  ELSEIF (monthVal > 1200)
    yearVal = yearVal + 10000;
    monthVal = monthVal - 1200;
  ENDIF

  cashOutflowDate = yearVal + monthVal;
  cashStaggeredPers = 1;
ENDIF

  fundingIncidence = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->"Funding Incidence";
IF (fundingIncidence <> "No Year"->"Funding Incidence")
    fundingChanged = 1;
ELSE
    fundingChanged = 0;
ENDIF

IF (fundingIncidence == -1 AND fundingChanged == 1)
    fundingStaggeredPers = 4;
ELSE
    yearVal = @INT(fundingDate / 10000) * 10000;
    monthVal = fundingDate - yearVal;
    monthVal = monthVal + fundingIncidence;

    IF (monthVal <= 0)
        yearVal = yearVal - 10000;
        monthVal = 1200 + monthVal;
    ELSEIF (monthVal > 1200)
        yearVal = yearVal + 10000;
        monthVal = monthVal - 1200;
    ENDIF

    fundingDate = yearVal + monthVal;
    fundingStaggeredPers = 1;
ENDIF

/* Initialize for amortization calc in next section */
basicCost = "No Year"->"Basic Cost";
salvageVal = "No Year"->"Salvage Input" * "No Year"->"Asset Units";
impairmentOpt = "No Year"->"Impairment Option";
capitalizePct = "No Year"->"Partial Capitalize %";
saleValue = "No Year"->"Sale Value";
retirementCosts = "No Year"->"Retirement Costs";
retirementObs = "No Year"->"Retirement Obligation";

amortMethod = "No Year"->"No Scenario"->"No Version"->"No Entity"->"Global"->
        "Amortization Method";

insuranceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->
        "Global"->"Insurance %";
maintenanceCost = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->
        "Global"->"Maintenance %";

fundingAmt = basicCost * "No Year"->"No Scenario"->"No Version"->"No Entity"->
        "Global"->"Funding %";

IF ("No Year"->"Impairment Date1" <> #MISSING)
    impairmentDate1 = @INT("No Year"->"Impairment Date1" / 100) * 100;
ELSE
    impairmentDate1 = #MISSING;
ENDIF

IF ("No Year"->"Impairment Date2" <> #MISSING)
    impairmentDate2 = @INT("No Year"->"Impairment Date2" / 100) * 100;
ELSE
    impairmentDate2 = #MISSING;
ENDIF

impairmentFairVal1 = "No Year"->"Impairment Fair Value1";
impairmentFairVal2 = "No Year"->"Impairment Fair Value2";

/* check if we have a pre-existing asset */
IF (inServiceDate < "First Date")
    yearVal = (@INT("First Date" / 10000) * 10000 - @INT(inServiceDate / 10000) * 10000) / 10000;
    monthVal = ("First Date" - @INT("First Date" / 10000) * 10000) - (inServiceDate - @INT(inServiceDate / 10000) * 10000);
    IF (monthVal < 0)
        IF (yearVal > 0)
            yearVal = yearVal - 1;
        ENDIF
        monthVal = 1200 + monthVal;
    ENDIF
    preExistingPers = @ROUND(yearVal * 12 + monthVal / 100, 0);
    setStartAmort = 1;
ELSE
    preExistingPers = 0;
    setStartAmort = 0;
ENDIF

numAmortPeriods = 0;
periodOffset = 0;

IF (amortMethod == 1)
    priorAccumAmort = 0;
    amortAmt = 0;
    setCashImpact = 0;
    setFundingImpact = 0;
    yearVal = @INT(inServiceDate / 10000) * 10000;
    monthVal = (inServiceDate - @INT(inServiceDate / 10000) * 10000);
ENDIF

ENDIF

IF (@ISMBR("No Year") AND @ISMBR("BegBalance"))
    paramsSet = 0;
    IF ("Asset Status" == 0)
        "Asset Status" = 1;
    ENDIF
ENDIF

IF (NOT @ISMBR("BegBalance") AND paramsSet == 1)
    /* clear out any previously calculated values */
    "Amortization" = #MISSING;
    "Accumulated Amortization" = #MISSING;
    "Intangible Assets Finite, Gross" = #MISSING;
    "Loss/(Gain) on Sale of Intangibles" = #MISSING;
    "Proceeds from Sale of Intangibles" = #MISSING;
    IF (cashFlowIncidence <> -1 OR cashflowChanged == 1)
        "Cash Flow Allocator" = #MISSING;
    ENDIF
    IF (fundingIncidence <> -1 OR fundingChanged == 1)
        "Funding Allocator" = #MISSING;
    ENDIF
"Cash Outflow from Capital Additions" = #MISSING;
"Cash Inflow from Funding" = #MISSING;
"Long Term Debt" = #MISSING;
"Insurance" = #MISSING;
"Maintenance" = #MISSING;
"Impairment of Assets" = #MISSING;
"Capital Reserve" = #MISSING;
"Capital Expenditure" = #MISSING;
"Retirement Expenses" = #MISSING;

IF ("TP-Date" == purchaseDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    "Capital Expenditure" = basicCost - retirementObs;
ENDIF

IF ("TP-Date" == cashOutflowDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    setCashImpact = cashStaggeredPers;
    cashAllocPct = 1 / cashStaggeredPers;
ENDIF

IF ("TP-Date" == fundingDate AND (delayedStartDate == #MISSING OR (delayedStartDate > #MISSING AND "TP-Date" > delayedStartDate)))
    setFundingImpact = fundingStaggeredPers;
    fundingAllocPct = 1 / fundingStaggeredPers;
ENDIF

IF (setCashImpact > 0)
    "Cash Flow Allocator" = cashAllocPct;
    setCashImpact = setCashImpact - 1;
ENDIF

"Cash Outflow from Capital Additions" = basicCost * "Cash Flow Allocator";

IF (setFundingImpact > 0)
    "Funding Allocator" = fundingAllocPct;
    setFundingImpact = setFundingImpact - 1;
ENDIF

"Cash Inflow from Funding" = fundingAmt * "Funding Allocator";
"Long Term Debt" = fundingAmt * "Funding Allocator";

/* Check if we should start amortization */
IF ("TP-Date" == inServiceDate OR (setStartAmort == 1))
    setStartAmort = 0;
    periodOffset = 0;
    numAmortPeriods = "NumPeriods" * "No Year"->"BegBalance"->"Useful Life (in Years)";
    insuranceCost = insuranceCost / "NumPeriods";
    maintenanceCost = maintenanceCost / "NumPeriods";
    intangibleNet = basicCost;
    amortAmt = (basicCost - salvageVal) / numAmortPeriods;
    if (preExistingPers > 0)
        numAmortPeriods = numAmortPeriods - preExistingPers;
    IF (numAmortPeriods > 0)
        priorAccumAmort = amortAmt * preExistingPers;
ENDIF
numRemainingPers = numAmortPeriods;

ENDIF

ENDIF

/* Amortization calculation section */
IF (amortMethod == 1 AND periodOffset < numAmortPeriods)

    /* If capitalized book in Capital Reserve instead of Impairment */
    IF ("TP-Date" == impairmentDate1)
        IF (impairmentOpt == 1)
            "Impairment of Assets" = intangibleNet - impairmentFairVal1;
        ELSEIF (impairmentOpt == 2)
            "Capital Reserve" = intangibleNet - impairmentFairVal1;
        ELSEIF (impairmentOpt == 3)
            "Capital Reserve" = (intangibleNet - impairmentFairVal1) * capitalizePct;
        ENDIF
        "Impairment of Assets" = intangibleNet - impairmentFairVal1 - "Capital Reserve";
        basicCost = basicCost - (intangibleNet - impairmentFairVal1);
        amortAmt = impairmentFairVal1 / numRemainingPers;
    ELSEIF ("TP-Date" == impairmentDate2)
        IF (impairmentOpt == 1)
            "Impairment of Assets" = intangibleNet - impairmentFairVal2;
        ELSEIF (impairmentOpt == 2)
            "Capital Reserve" = intangibleNet - impairmentFairVal2;
        ELSEIF (impairmentOpt == 3)
            "Capital Reserve" = (intangibleNet - impairmentFairVal2) * capitalizePct;
        ENDIF
        "Impairment of Assets" = intangibleNet - impairmentFairVal2 - "Capital Reserve";
        basicCost = basicCost - (intangibleNet - impairmentFairVal2);
        amortAmt = impairmentFairVal2 / numRemainingPers;
    ENDIF

ENDIF

IF (periodOffset + 1 == numAmortPeriods)
    amortAmt = (basicCost - salvageVal) - priorAccumAmort;
ENDIF

priorAccumAmort = priorAccumAmort + amortAmt;
intangibleNet = basicCost - priorAccumAmort;

/* Only assign values to member if we are in range */
IF ("TP-Date" >= delayedStartDate AND ("TP-Date" >= inServiceDate OR preExistingPers > 0) AND (prematureEndDate == #MISSING OR "TP-Date" < prematureEndDate))

    "Intangible Assets Finite, Gross" = basicCost;
    "Amortization" = amortAmt;
    "Accumulated Amortization" = priorAccumAmort;
    "Insurance" = insuranceCost;
    "Maintenance" = maintenanceCost;
ENDIF

/* Set the loss/gain if we had a sale or writeoff */
IF ("TP-Date" == prematureEndDate)
  IF ("No Year"->"BegBalance"->"Reason Ended" == 2 OR
      "No Year"->"BegBalance"->"Reason Ended" == 3)
    netValue = basicCost - priorAccumAmort + retirementCosts;
    IF ("No Year"->"BegBalance"->"Reason Ended" == 3)
      "Loss/(Gain) on Sale of Intangibles" = netValue - saleValue +
      amortAmt;
    ELSE
      "Loss/(Gain) on Sale of Intangibles" = netValue + amortAmt;
    ENDIF
    "Retirement Expenses" = retirementCosts - retirementObs;
    "Proceeds from Sale of Intangibles" = saleValue - retirementCosts;
  ENDIF
ENDIF

periodOffset = periodOffset +1;
numRemainingPers = numRemainingPers -1;
ENDIF ENDIF ENDIF

FIX ("BegBalance", "No Year")
"Cash Flow Incidence" (  IF (cashflowChanged == 1 AND "Asset Status" > 0)
    "Cash Flow Incidence" = cashFlowIncidence;
  ENDIF
  IF (fundingChanged == 1 AND "Asset Status" > 0)
    "Funding Incidence" = fundingIncidence;
  ENDIF
)
ENDFIX

ENDFIX

/* Clear out any asset line items marked for delete */
FIX(@CHILDREN("Total New"), [Hidden_Version], [DepartmentTo], [AssetClassInt])
  [Hidden_Scenario]{
    IF ("No Year"->"BegBalance"->"Asset Status" == -1)
      @CURRMBR("Line Item") = #MISSING;
    ENDIF
  }
);
ENDFIX

FIX([Hidden_Scenario], [Hidden_Version], [DepartmentFrom], [DepartmentTo])
  CALC DIM ("Period");
  @ANCESTORS([SrcLineItem]);
  @ANCESTORS([AssetClassInt]);
ENDFIX
Amortization  The gradual recognition of certain expenses associated with intangible assets such as trademarks and copyrights, typically over a period of several years. Expenses are initially added to the value of the asset, and are transferred from the balance sheet to the income statement using a fixed schedule, usually a constant amount per month (or other accounting period).

Cash Flow  Cash received or expended by making capital expenditures (such as the purchase of new machinery), investments, or acquisitions.

Declining Balance-Year Depreciation (DB Year)  A common depreciation-calculation system that applies the depreciation rate against the non-depreciated balance. Instead of spreading the cost of the asset evenly over its life, this system expenses the asset at a constant rate, which results in declining depreciation charges each successive period. For example, if an asset that costs $1,000 is depreciated at 25% each year, the deduction is $250.00 in the first year, $187.50 in the second year, and so on.

Depreciation  A non-cash expense that reduces the value of an asset as a result of wear and tear, age, or obsolescence. Most assets lose their value over time, and must be replaced after the end of their useful life is reached.

Existing Specified Asset  Existing assets that are already available and in use within the entity. Planners and cost center managers can plan actions such as transfers, retirement, and improvements on existing assets, and add existing assets. For existing specified assets, data is added at the individual asset level. Typically used for high-value individual assets.

Existing Unspecified Asset  Existing assets that are not added at each asset level. The asset information is for reporting purpose only. For existing unspecified assets, data is added at the asset class level. Typically used for bulk assets where there is no need to plan for further actions on individual assets.

Funding %  Percentage of the capital purchases funded by an external source.

Funding Incidence  Assumption by which the pattern of cash inflow is defined.

Impairing Asset  If the sum of all estimated future cash flows is less than the carrying value of the asset, the asset is considered impaired and would have to be written down to its fair value. Basically, an asset with a market value that is worth less than its book value.

Intangible Assets  Intangible assets lack physical substance, such as patents, copyrights, and brand values (trademarks and trade names). These assets are amortized to expense over 5 to 40 years.

Straight Line Depreciation (SLN)  A method of computing depreciation by dividing the difference between an asset's cost and its expected salvage value by the number of years it is expected to be used. Basically, spreading out the cost of an asset equally over its lifetime.

Sum-of-the-Year Digits Depreciation (SYD)  Method of allocating the cost of an Asset over its Useful Life. It requires a fraction to be computed each year, which is applied against the depreciable amount. The numerator is the number of years left to be depreciated. The denominator is the sum of the years' digits of the depreciable life.
**Tangible Assets**  Assets that are purchased for continued and long-term use, such as land, buildings, machinery, furniture, and tools are called tangible. They are written off against profits over their anticipated life by charging depreciation expenses (with the exception of land). Accumulated depreciation is shown in the face of the balance sheet or in the notes. This is also called capital assets in management accounting, especially when intangibles are considered.

**Useful Life**  Operational assets are purchased with the expectation that they will provide future benefits, usually for few or several years, depending on their type. The capital expenditure should be allocated to the periods benefited by their use. This measure is known as useful life and it is represented in Years in the product.
Index

Numbers
01. Global Capital Assumptions data form, 18, 49
02. New Asset Requests data form, 18, 53
02A. New Asset Requests - Addition data form, 34, 49
02B. Total Expense Impact data form, 50
02C. Cash Flow Impact - Line Item Details data form, 50
03. Manage Existing Specified data form, 19, 20, 21, 50
03A. Existing Specified Drill Down data form, 50
03B. Existing Specified Expenses data form, 50
04. Manage Existing Unspecified data form, 21, 50
05. New Intangible Asset Requests data form, 23, 53
05A. New Intangible Requests - Additions data form, 50
06. Manage Existing Intangibles Specified data form, 23, 51
06A. Existing Intangible Specified Drill Down data form, 51
06B. Existing Specified Expenses - Intangibles data form, 51
07. Manage Existing Intangibles Unspecified data form, 51
08. Capital Expenditure Summary data form, 51
08A. Capital Expenditure Summary - Line Item details data form, 51
09. Intangible Expenditure Summary data form, 26, 51
09A. Intangible Account Balance data form, 52
09B. Intangible Asset Balances data form, 52
10. Profit and Loss Impact data form, 26, 52
11. Balance Sheet Impact data form, 26, 52
12. Cash Flow Impact data form, 27, 52
13. Depreciation Summary data form, 27, 52
13A. Depreciation Summary - Line Item details data form, 52
14. Amortization Summary data form, 27, 53
14A. Amortization Summary - Line Item details data form, 53
15. Depreciation What ifs data form, 28, 53
15A. Global Capital Assumptions - Depreciation only data form, 53

A
about Capital Expense Planning, 7
access permissions
setting up, 28
transfers, 29
accessing
Performance Management Architect, 16
Planning, 16
Workspace, 16
accounts
adding, 38
fixed and varying, loading data into, 15
predefined, 53
adding
accounts, 38
asset classes, 31
assets, 18
custom fields, 34
data forms, 37
existing assets, 19
intangible assets, 23, 32
options for retiring new assets, 38
Project dimension, 44
tangible assets, 32
allocated cash flow percentages, calculating, 29
allocations, staggered cash flow, 36
amortization
described, 193
summary, 27
viewing, 23, 27
Amortization Summary - Line Item details data form, 53
Amortization Summary data form, 27, 53
Application Library, working with, 32
Application Views
  creating, 10
  upgrading, 12
applications
  creating Classic applications, 13
  creating Performance Management Architect applications, 9
  creating, overview, 8
  localizing, 47
  selecting, 16
  working with, 17
Asset CAR #, entering, 18
asset classes
  adding, 31
  predefined, 57
asset requests, 18
assets
  adding, 18, 37
  adding existing, 19
  adding intangible, 23
  adding retirement options, 38
classes, adding, 31
considerations for working with, 29
depreciation, 27, 28
entering CAR #, 18
existing specified, described, 193
existing unspecified, described, 193
impairing intangible, 24
impairing, described, 193
improving, 21
in-service date, 18
intangible, described, 193
managing existing, 19
managing intangible, 22
managing tangible, 18
managing unspecified, 21
modifying CAR#, 39
prefix for, 19
removing, 20
requesting intangible, 23
retiring, 20
showing hidden fields, 41
tangible, 194
transferring, 20
viewing balance sheet impact, 26
viewing calculated details, 20
viewing cash flow impact, 27
viewing profit and loss impact, 26
working with, 17
assumptions, enabling for entities, 42

B
Balance Sheet Impact data form, 26
Base Line Item page view, 21
Base SP, described, 19
business model, 8
business rules
  customizing, 48
  loading, 8
  predefined, 72
  updating for multiple entities, 42

C
calculated details, viewing, 20
calendar
  considerations for, 29
described, 7
Capital Acquisition Request #, modifying name, 39
capital purchases, funding %, 193
capital reserve, 24
capitalize%, 24
CAR#
  entering, 18
  modifying, 39
cash flow
  described, 193
  staggered allocations, changing, 36
  viewing, 27
Cash Flow Impact - Line Item Details data form, 50
Cash Flow Impact data form, 27
cash inflow, described, 193
Classic applications
  creating and initializing, 13
  loading information into, 14
Create Asset business rule, using, 48
creating
  Classic applications, 13
  import profiles, 9
Performance Management Architect applications, 9
currency, default, 11
custom fields, adding, 34
customizing Capital Expense Planning, 31

D
data
accessing, 28
loading using DIM Adapter for Planning, 15
loading using Application Link Adapter for Hyperion Planning, 15
loading, overview, 14
data forms
01. Global Capital Assumptions, 18, 49
02. New Asset Requests, 18, 53
02A. New Asset Requests - Addition, 34, 49
02B. Total Expense Impact, 50
02C. Cash Flow Impact - Line Item Details, 50
03. Manage Existing Specified, 19, 20, 21, 50
03A. Existing Specified Drill Down, 50
03B. Existing Specified Expenses, 50
04. Manage Existing Unspecified, 21, 50
05. New Intangible Asset Requests, 23, 53
05A. New Intangible Requests - Additions, 50
06. Manage Existing Intangibles Specified, 23, 24, 51
06A. Existing Intangible Specified Drill Down, 51
06B. Existing Specified Expenses - Intangibles, 51
07. Manage Existing Intangibles Unspecified, 51
08. Capital Expenditure Summary, 51
08A. Capital Expenditure Summary - Line Item details, 51
09. Intangible Expenditure Summary, 26, 51
09A. Intangible Account Balance, 52
09B. Intangible Asset Balances, 52
10. Profit and Loss Impact, 26, 52
11. Balance Sheet Impact, 26, 52
12. Cash Flow Impact, 27, 52
13. Depreciation Summary, 27, 52
13A. Depreciation Summary - Line Item details, 52
14. Amortization Summary, 27, 53
14A. Amortization Summary - Line Item details, 53
15. Depreciation What ifs, 28, 53
15A. Global Capital Assumptions - Depreciation only, 53
access permissions for, 28
adding, 37
considerations when changing, 47
loading predefined, 8
predefined, 49
predefined menus in, 72
updating for projects, 45
updating Point of View dimensions, 42
using business rules, 48
viewing and managing, 16
data source file name, 13
Data Type, changing, 32
declining balance-year depreciation (DB Year), described, 193
default currency, 11
departments, enabling assumptions for, 42
deploying Performance Management Architect applications, 12
depreciation
analyzing, 28
calculations, 29
changing the method, 28
considerations for, 28
described, 193
SLN method, described, 193
summary, 27
SYD method, described, 193
viewing, 18, 22
Depreciation Summary data form, 27
Depreciation What ifs data form, 28, 53
dimensions
adding projects, 44
importing in Performance Management Architect, 10
loading predefined Capital Expense Planning dimensions, 8

e
tentities
enabling assumptions for, 42
updating business rules for, 42
Existing Intangible Specified Drill Down data form, 51
existing specified assets, described, 193
Existing Specified Drill Down data form, 50
Existing Specified Expenses - Intangibles data form, 51
Existing Specified Expenses data form, 50
existing unspecified assets, described, 193
expenditures
  viewing for intangibles, 26
  viewing summaries, 25

F
field labels, modifying, 39
fields
  adding, 34
  showing hidden, 41
financial impact review, 25
fixed accounts, loading data into, 15
flat file
  dimensions and members listed in, 12
  downloading, 9
  importing dimensions, 10
  merging and replacing, 10
formula expressions, customizing, 47
freight, 41
funding %, described, 193
funding incidence, described, 193

G
global assumptions
  described, 17
  establishing, 17
  managing, 29
Global Capital Assumptions - Depreciation only data form, 53
Global Capital Assumptions data form, 18, 49

H
hidden fields, showing, 41
HspCustomMsgs template file, 47

I
Ignore Nulls option when importing, 10
IM prefix, described, 21
impairing assets, described, 193
impairing intangible assets, 24
impairment value, 24
import profiles, creating, 9
importing, 10. See also loading data
creating an import profile, 9
dimension properties, 10
ignoring blank values, 10
improving assets, 21
in-service date, defining, 18
initializing Capital Expense Planning applications, 8
  with Classic application administration, 13
  with Performance Management Architect
    application administration, 9, 13
instance name, 13
intangible assets
  adding, 23
  described, 193
  impairing, 24
  managing, 22
  requesting, 23
  working with, 17
Intangible Expenditure Summary data form, 26
intangible expenditures, viewing, 26

L
labels
  modifying, 39
  predefined, 47
line items
  predefined, 59
  prefix for, 21
loading data
  overview, 14
  using Application Link Adapter for Hyperion
    Planning, 14
  using Data Integration Management Adapter for
    Planning, 14
localizing applications, 47
logging on
  to Capital Expense Planning, 16
  to Workspace, Performance Management Architect, and Planning, 16

M
Manage Existing Intangibles Specified data form, 23, 51
Manage Existing Intangibles Unspecified data form, 51
Manage Existing Specified data form, 19, 20, 21, 50
Manage Existing Unspecified data form, 21, 50
managing
  access permissions, 28
  existing specified assets, 19
  intangible assets, 22
  tangible assets, 18
  unspecified assets, 21
member formulas
  customizing, 47
  loading predefined, 8
predefined, 63
members, loading predefined, 8
menus
  customizing, 47
  in data forms, 72
  loading predefined, 8
predefined, 69
metadata
  loading using Application Link Adapter for Hyperion Planning, 15
  loading using Data Integration Management, 15
  loading, overview, 14
method of depreciation, changing, 28
modifying Capital Expense Planning, 31
multi-currency applications, 29

predefined accounts, 53
predefined business rules, 72
predefined data forms, 49
predefined line items, 59
predefined member formulas, 63
predefined menus, 69
predefined Smart List entries, 67
predefined Smart Lists, 67
prerequisites, 8
profile, creating for importing, 9
profit and loss impact reports, 26
  specifying, 23
Profit and Loss Impact data form, 26
Project dimension, adding, 44
prompt string, modifying, 39
purchases, 18

removing assets, 20
Retirement Obligation field, 41
retirement options, adding, 38
retiring assets, 20
runtime prompts, adding, 34

salvage value
  considerations for, 28
  entering, 21
security filters
  creating, 13
  validating, 13
Shared Services project name, 13
showing hidden fields, 41
SLN depreciation method, described, 193
Smart Lists
  customizing, 47
  loading predefined, 8
predefined, 67
predefined entries, 67
specified assets, described, 193
spreading data with custom time periods, 7
start month, 11
start year, 11
straight line depreciation (SLN) method, described, 193
sum of the year digits (SYD) method, described, 193

T
tangible assets
cash flow impact, 27
described, 194
improving, 21
managing, 18
removing, 20
retiring, 20
specifying existing, 19
transferring, 20
viewing balance sheets, 26
viewing profit and loss impact, 26
working with, 17
taxes, 41
time periods
custom, 7
described, 7
timing adjustments, considerations for, 29
Total Expense Impact data form, 50
transferring
considerations for, 29
described, 20
viewing impact of, 20
with multiple entities, 42

U
unspecified assets, managing, 21
URL for Workspace, 16
useful life
changing, 28
described, 194
users and groups, setting up, 28

V
Valid for Capex option, 11
Valid For option, 11
varying accounts, loading data into, 15
viewing
amortization summaries, 27
balance sheet impact, 26
capital expenditure summary, 25
cash flow impact, 27
depreciation, 18, 27
financial impact, 25
improvements, 21
intangible expense summary, 26
profit and Loss impact, 26

W
Workspace, logging on, 16
write-offs, 20

Y
Year
No Year, 11
Number of Years, 11
Start Year, 11
years, supporting multiple, 7